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Preface

Purpose
This manual describes how to monitor enterprise call center activity with
the real-time and historical reporting features of the GEOTEL Intelligent
CallRouter (ICR).

Audience
This document is intended for the Intelligent CallRouter supervisor. The
supervisor has an understanding of call center management and the
specific types of data that are used to report on call center activity and
resources.

This document assumes that you have some familiarity with Microsoft®

Windows™ applications and common tasks such as moving and resizing
windows and using a mouse.

Organization
Chapter 1, “Overview”

Introduces the Intelligent CallRouter and the ICR call center
enterprise.

Chapter 2, “The Admin Workstation”

Introduces the Admin Workstation (AW) with a special emphasis on
call center reporting and the Monitor ICR reporting application.

Chapter 3, “Creating a Report”

Guides you through the process of creating a simple report using the
predefined report templates of Monitor ICR.

Chapter 4, “Reporting Basics”

Describes how to use the basic features of Monitor ICR.

Chapter 5, “Setting Thresholds and Drill-Downs”

Describes how to set threshold values and drill-down templates in
Monitor ICR reports.
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Chapter 6, “ Scheduling Reports”

Describes how to schedule reports to print automatically by using
the ICR Job Scheduler tool.

Chapter 7, “Available Data”

Describes the most commonly used data available in the ICR
databases.

Chapter 8, “Template Reference”

Documents the predefined report templates that come with Monitor
ICR.

Typographic Conventions
This manual uses the following conventions:

Boldface type is used for emphasis; for example:

Real-time information is not stored in the central database.

Italic type indicates one of the following:

� A newly introduced term; for example:

A skill group is a collection of agents who share similar skills.

� A generic syntax item that you must replace with a specific value;
for example:

IF (condition, true-value, false-value)

� A title of a publication; for example:

For more information, see the Intelligent CallRouter Database
Schema Handbook.

Sans serif type with small caps represents keys on your keyboard; for
example:

Press the SHIFT key to select a range of items.

An arrow (→) indicates an item from a pull-down menu. For example,
the Save command from the File menu is referenced as File→Save.

Text you must type is shown in a sans serif type. For example:

Date and Time
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Other Publications
� Intelligent CallRouter Custom Screen Builder Tutorial

� Intelligent CallRouter Database Schema Handbook

� Intelligent CallRouter Installation Guide

� Intelligent CallRouter Planning Guide

� Intelligent CallRouter Product Description

� Intelligent CallRouter Quick Start Guide

� Intelligent CallRouter Supervisor Guide

� Intelligent CallRouter System Manager Guide

� GEOTEL•Web View Administrator Guide

For information about the GEOTEL•Network ICR product, see the
following documents:

� Network ICR Product Description

� Network ICR User Guide
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1. O
verview

 1. Overview

The GEOTEL Intelligent CallRouter (ICR) improves the level of
customer service offered by geographically distributed call centers. The
Intelligent CallRouter’s main function is to route toll-free calls to the
most appropriate agent or answering resource available. The system also
provides a set of computer telephony integration (CTI), reporting,
monitoring, and scheduling tools that help you to manage a distributed
call center enterprise.

This chapter provides an overview of the Intelligent CallRouter and
describes its role in a multiple call center environment.
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18 Overview

1.1.  What is the Intelligent CallRouter?
The Intelligent CallRouter (ICR) is a software-based call processing
system that provides call-by-call routing to geographically distributed
call centers. The ICR links agents from multiple call centers to create a
virtual call center.

In the virtual call center model, agents from distributed call centers can
be grouped logically according to their areas of expertise. For example, a
financial company might have call centers in several cities across the
country. Each call center has groups of agents organized into skill
groups.

The agents in these skill groups are trained to handle certain types of
calls. Basic calls can be routed to skill groups that are trained to provide
general services. Callers who have more complicated transactions can be
routed to more specialized skill groups.

Figure 1 shows how calls are routed to the best available agents in the
call center enterprise.

Figure 1:  ICR Call Routing

What happens if several callers require the services of a specialized
agent? For example, you might have several callers who need the
assistance of a financial planner. This type of specialized agent may not
always be immediately available at one call center. However, since the
Intelligent CallRouter is aware of the status of the entire enterprise, it
can quickly find financial planners at other call centers and route the
calls accordingly.
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1. O
verview

 1.1.1. Where Does the ICR Fit In?
The Intelligent CallRouter works directly with call centers and the
interexchange carrier (IXC) that supplies the toll-free service. The IXC
is a long-distance telephone company that offers toll-free call routing
services. Figure 2 shows how the Intelligent CallRouter operates
between the IXC network and distributed call centers.

Figure 2:  Intelligent CallRouter Overview

The IXC signaling network controls how calls are routed in the public
switched network. In addition to connecting to the signaling network,
the ICR has data connections to each call center peripheral. A peripheral
may be an Automatic Call Distributor (ACD), Private Branch Exchange
(PBX), or Voice Response Unit (VRU). The data connections to each
peripheral provide the ICR with real-time data on agent group and call
activity.

The ICR has two main functions in the call center enterprise:  routing
calls and collecting management information. The management
information is used to make informed decisions on where to route calls.
It is also used to monitor and report on call center performance. In a
GEOTEL•Enterprise CTI environment, management data can also used
in a variety of integrated desktop and server CTI applications.

Agent
Groups

ACD, PBX,
VRU

Toll-Free Callers

Intelligent
CallRouter

Call Centers

SCP

Agent, Queue,
CTI data

Call Associated
Data

Cal l Associated
Data

Calls

Calls

Public
Switched Network

Signaling Network

Service Control Point
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 1.1.2. Call Routing
A typical ICR-routed call goes through the following stages.
Figure 3 illustrates these stages in detail.

� The Intelligent CallRouter is constantly receiving data from call
centers on agent availability, queue status, and call handling
performance.

ô A caller dials the toll-free number.

í The Local Exchange Carrier (LEC) passes the call to the IXC.

Figure 3:  ICR Call Flow Diagram

÷ The IXC signaling network sends call information from its computer
(the Service Control Point (SCP)) to the ICR in the form of a routing
request.

û The ICR, using the information from the IXC routing request and
the data it has been receiving from call centers, determines the best
agent group based on skills, current agent availability, and queue
status.

ø The ICR returns a routing label (destination) for the call to the IXC.

ù The IXC then connects the call to the ACD where an appropriate
agent is located.
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 1.1.3. Pre-Routing
The Intelligent CallRouter uses Pre-Routing® to ensure that incoming
calls reach the appropriate agent resource the first time. In Pre-Routing,
the ICR executes routing decisions before the call terminates at a call
center.

As shown in Figure 3, every time a caller dials the toll-free number, the
IXC passes a routing request through the signaling network to the
Intelligent CallRouter. The interexchange carrier acts as a routing
client, while the Intelligent CallRouter acts as the routing server.

The IXC routing request includes information about the call such as

� Number dialed.

� Calling Line ID (CLID) or Automatic Number Identification (ANI).

� Caller Entered Digits (CED).

The final routing decision, or the call’s destination, is contained in a
routing label which the ICR returns to the interexchange carrier. The
carrier is then responsible for connecting the call and maintaining the
voice path.

 1.1.4. Post-Routing
Optionally, the ICR can perform the same routing functions used in
Pre-Routing for transfers and internal calls (that is, for calls originating
at a call center or another agent location). The ICR uses Post-Routing®

to make these “secondary” routing decisions. Post-Routing also lets you
implement intelligent transfer applications in which calls are routed
between agents and VRUs. Post-Routing ensures that subsequent call
transactions are routed in a timely manner to an appropriate resource.

In Post-Routing calls, the ICR uses the same routing scripts and call
processing as it does in Pre-Routing calls. The difference is that the
peripheral (ACD, PBX, or VRU) generates the routing request rather
than the IXC. The Intelligent CallRouter processes the routing request,
returns a destination address (routing label), and then directs the
peripheral to send the call to the best resource available.

 1.1.5. Enterprise CTI
As an enterprise call routing system, the ICR collects data from different
systems and telecommunications environments throughout the call
center enterprise. Often these systems are implemented on
heterogeneous hardware and software platforms and distributed across
multiple sites. GEOTEL•Enterprise CTI  gathers enterprise call and
transaction data from these dissimilar systems and makes it available to
agent desktop and CTI server applications.
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 See also: For more information on Enterprise CTI, see the Intelligent CallRouter
Product Description.

 1.1.6. Call Routing Scripts
To determine the best destination for a call, the ICR processes routing
requests through call routing scripts. A routing script is a graphical,
flowchart-like diagram that specifies how to route a call. A script usually
has several branches that can be followed depending on current
conditions at the call centers.

In order to make a routing decision, the script uses the information
contained in the routing request along with real-time information on the
status of resources at each call center. The system manager typically
defines a number of routing scripts to use in the ICR system.

Scripts can be scheduled as required to route calls among call centers
based on the type of service the caller needs, the time of day the call is
being placed, and where suitably qualified agents are available to handle
the call.

 See also: For more information on the routing scripts, see the Intelligent
CallRouter System Manager Guide.

 1.1.7. Reporting and Monitoring
The ICR uses real-time, near real-time, and historical data on agent and
call center status to make its routing decisions. To make the best routing
decision possible, the ICR constantly collects information about agent
activity at each call center, such as:

� Current agent state

� Logon duration

� Number of agents available

� Number of agents talking

� The time agents spend in particular call handling states

The ICR also collects information about calls coming into the call
centers, such as

� Number of calls in progress

� Number of calls handled and finished

� How calls were routed

� How long callers were on hold
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Although this management data is essential to call routing, it is also
important for monitoring and reporting on agent and agent group
performance. The ICR stores the management data in industry-standard
historical and real-time relational databases.

The Intelligent CallRouter provides many ways for you to analyze
trends and gauge service levels using real-time and historical
management data. The main ICR reporting tool, called Monitor ICR,
allows you to generate many types of reports on agent and call activity.
Monitor ICR is described in more detail later in this chapter.

 1.1.8. Network ICR
GEOTEL•Network ICR is the carrier-class version of the Intelligent
CallRouter. It allows a network service provider to offer virtual call
center services to its customers. The Network ICR functions much like a
Service Control Point (SCP) by distributing incoming calls to individual
network service customers based on the number dialed, the call’s point
of origin, and caller-entered digits.

The Network ICR product uses a two-tiered architecture in which one
ICR passes route requests to a second ICR. The first ICR, called the
Network ICR or NICR, typically receives routing requests from a carrier
network. The NICR can either return a label itself or pass the route
request to a second ICR, called the Customer ICR or CICR.

Each CICR can processes all calls for one or more customers. The CICR
receives the route request, runs its own routing scripts to determine the
destination for the call, and returns a routing label to the NICR. The
NICR then returns the label to the original carrier network. This
architecture lets a service provider perform simple routing (within the
NICR) for some customers while providing full ICR functionality (in a
CICR) for other customers.

 See also: For more information about Network ICR, see the Network ICR Product
Description.

1.2.  The Call Center Enterprise
An Intelligent CallRouter treats a customer’s multiple distributed call
centers as a single enterprise. You can think of the call center enterprise
as an entire company or agency that spans many call centers. The
enterprise typically includes all call centers served by an ICR.

You can create different organizational entities within a call center
enterprise. For example, you might organize distributed groups of agents
into a shared resource pool that spans call centers. You might also create
entities that are tied to specific peripherals. The term peripheral refers to
the individual switch (ACD, PBX, or VRU) that distributes incoming
calls at each call center.
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From a reporting perspective, you can view agent and call routing
statistics on an enterprise-wide or peripheral-by-peripheral basis.
Enterprise reporting gives you a view of performance across the entire
call center enterprise. Peripheral reporting focuses your reports on
specific areas of the call center enterprise.

To become more familiar with the ICR call center enterprise, it might
help to review the types of organizational entities you can define.

 See also: Table 1, later in this chapter, provides information on how ICR call
center terms map to the terms used by ACD vendors.

 1.2.1. Services and Skill Groups
A service is a particular type of call processing that the caller requires.
In most cases, a service can be thought of as a certain type of call. For
example, in a software company’s call center, callers who have
questions about installing software might be directed to the Technical
Support service.

A skill group, on the other hand, is a set of agents who handle similar
types of calls or have a common set of skills. A skill group might
contain agents who are able to handle a particular type of call (for
example, calls from customers who speak Spanish). Figure 4 shows the
hierarchy of services and skill groups within a call center enterprise.

Enterprise Skill Group

Peripheral
Skill Groups

Agents

Agents Agents

Peripheral
Services

Enterprise Service

Peripheral
Skill Groups

Agents

Agents Agents

Peripheral
Skill Groups

Agents

Agents Agents

Figure 4:  Service and Skill Group Hierarchy

As shown in Figure 4, you can group services and skill groups to create
enterprise services and enterprise skill groups. These are simply
collections of services and skill groups that span call centers.

A peripheral service is a service that is tied to a specific ACD or PBX.
You might have several Sales peripheral services. Each Sales peripheral
service is tied to, or associated with, a specific peripheral somewhere in
the call center enterprise. The Sales services can be logically grouped

Download from Www.Somanuals.com. All Manuals Search And Download.



The Call Center Enterprise 25

1. O
verview

across peripherals to form an enterprise Sales service. Figure 5 shows
the relationship between enterprise and peripheral services.

Enterprise Services

ACD

ACD

ACD

Dallas Tech. Support
Dallas Info. Services

Boston Tech. Support
Boston Info. Services

Sales Technical Support Information Services

Peripheral Services

Denver Sales

Denver Tech. Support
Denver Info. Services

Boston Sales

Dallas Sales

These peripheral services are logically combined to form the
enterprise service, Sales.

Figure 5:  Enterprise and Peripheral Services

Peripheral services typically include a number of skill groups, each of
which can be set up to handle specific types of calls. For example,
within a Sales peripheral service you might have Spanish and Japanese
skill groups to support Sales calls from callers who speak these
languages.

Peripheral skill groups are skill groups that are tied to a specific ACD or
PBX. Each skill group contains a number of agents. Agents can be
assigned to one or more peripheral skill groups. Like services, skill
groups can be combined on an enterprise basis.
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Figure 6 shows the relationship between enterprise and peripheral skill
groups.

Enterprise Skill Groups

ACD

ACD

ACD

HelpDesk
HelpDesk Pri.
HelpDesk Sec.

Spanish
Spanish Pri.
Spanish Sec.

Peripheral Skill Groups

Denver.HelpDesk
Denver.HelpDesk.Pri
Denver.HelpDesk.Sec
Denver.Spanish
Denver.Spanish.Pri
Denver.Spanish.Sec

These peripheral skill groups are logically combined to form the
enterprise skill group, HelpDesk Pri.

Boston.HelpDesk

Boston.HelpDesk.Pri
Boston.HelpDesk.Sec
Boston.Spanish
Boston.Spanish.Pri
Boston.Spanish.Sec

Dallas.HelpDesk
Dallas.HelpDesk.Pri
Dallas.HelpDesk.Sec
Dallas.Spanish
Dallas.Spanish.Pri
Dallas.Spanish.Sec

Figure 6:  Enterprise and Peripheral Skill Groups

On Lucent DEFINITY ECS ACDs running in EAS mode, and on
Rockwell Galaxy ACDs, each skill group has primary and secondary
subgroups. The ICR emulates this by automatically creating additional
skill groups for these peripheral types. For example, if you configured a
HelpDesk skill group for a Galaxy ACD, the ICR would automatically
create HelpDesk.Pri and HelpDesk.Sec skill groups in addition to the
base HelpDesk skill group.

In routing and reporting, you can reference the .Pri and .Sec skill groups
directly or you can refer to the base skill group. In Figure 6, the base
skill groups are Denver.HelpDesk, Boston.HelpDesk, and
Dallas.HelpDesk. These base skill groups include the .Pri and .Sec
HelpDesk skill groups configured on the ACD. These base skill groups
can be combined to form the enterprise skill group, HelpDesk, which
would include all HelpDesk skill groups across the enterprise.
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 1.2.2. Agents and Agent Teams
Within the call center enterprise, an agent is anyone who can answer
incoming phone calls. A peripheral agent is an agent who is associated
with a particular peripheral (ACD, PBX) in the call center enterprise. A
peripheral agent can be a member of one or more skill groups. (Some
peripheral types limit each agent to one skill group assignment.)
Figure 7 shows how agents are organized in a call center enterprise.

Agent Teams

Agents

Agents Agents

Peripheral
Skill Groups

Enterprise Skill Group

Peripheral
Services

Enterprise Service

Figure 7:  Agent Hierarchy

Peripheral agents are grouped first into peripheral skill groups. You can
group peripheral skill groups into services or enterprise skill groups.
Optionally, you can group peripheral agents into agent teams. Agent
teams are groups of peripheral agents configured on the same peripheral
to meet a business need. You can have an agent team that includes
agents at the call center and agents who work at home. Although these
agents are at different locations, they are associated with a particular
ACD at the call center. Members of an agent team can also be members
of one or more skill groups.

 1.2.3. Trunk and Network Trunk Groups
A trunk group is a collection of trunks (that is, telephone lines). Trunk
groups typically contain trunks that are used for a common purpose. The
ICR routes calls to specific trunk groups; not to specific trunks. Within
Monitor ICR, you can monitor activity for a specific trunk group, but not
for a specific trunk.

A simple trunk group is associated with a single peripheral and typically
reflects the peripheral’s view of the trunks (that is, how the peripheral
organizes its trunks). However, trunks can also be viewed from the
routing client’s perspective. A routing client is an entity that sends
routing requests to the ICR.
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A network trunk group is a group of trunks organized to reflect the
routing client’s view of trunks. A network trunk group can map to one or
more peripheral trunk groups. For example, say you have two VRUs at a
call center site in Dallas. Each VRU has two T1 circuits (see Figure 8).

ACD2

ACD1

NY.Megacom.Trkgrp103
NY.Megacom.Trkgrp104

NY.Megacom.Trkgrp1
NY.Megacom.Trkgrp2

NY
Trunks

Peripheral Trunk
Groups

T1’s

T1’s

Network Trunk
Group

Routing Client
(IXC, PG)

Figure 8:  Network and Peripheral Trunk Groups

The VRU may divide its trunk groups differently than the routing client
(for example, the IXC). In this example, the VRUs view each T1 circuit
as a trunk group (two trunk groups on each VRU). To the routing client,
however, the four T1 circuits might represent a single pool of 96 trunks.
The routing client can deliver calls with the same Dialed Number
Information Service (DNIS) to any of these 96 trunks, so it treats this
pool of trunks as a single entity—a network trunk group.

The use of network trunk groups simplifies the configuration of trunk
groups for some types of ACDs. Rather than deliver calls to specific
trunk groups and peripherals, the routing client need only deliver the call
to a network trunk group. The peripheral can then choose a target that
matches the DNIS and thereby classify the call.

 1.2.4. Service Arrays
Service arrays are closely tied to network trunk groups. Typically,
service arrays are defined in instances where you have similar peripheral
services defined on multiple VRUs and the VRUs all share the same
network trunk group. By grouping the services of multiple VRUs into a
service array, you can send calls to a single target (a service array) and
let the network deliver the call to any one of the peripheral services that
make up the service array.
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Figure 9 shows an example of how service arrays relate to peripheral
services and network trunk groups.

DAL
Trunks

T1’s

Network Trunk
Group

Routing Client
(IXC, PG)

VRU1 VRU4VRU3VRU2

Dal_VRU1.Sales

Service
Array

Dal_VRU1.Help

Dal_VRU2.Sales Dal_VRU3.Sales Dal_VRU4.Sales

Dal_VRU2.Help Dal_VRU3.Help Dal_VRU4.Help

Figure 9:  Service Arrays

When several VRUs each support a peripheral service, as shown in
Figure 9, you can define a service array for those VRUs. You can define
one or more peripheral services on a VRU. Each VRU can have more
than one service array defined.

Service arrays also give you flexibility in reporting on call center
performance by providing a separate view into the performance of
peripheral services on VRUs. For example, in Figure 9 a peripheral
service report would provide data for one VRU. An enterprise service
report would provide data for an arbitrary collection of VRUs and
ACDs. A service array report, however, would provide data on one
group of VRUs that are sharing a network trunk group.

 1.2.5. Routes
A route is a value that is returned by a routing script. The value maps to
a target at a peripheral. This target can be a service, skill group, agent, or
translation route. More simply, a route is the destination of the call after
the ICR has made its routing decisions.
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Routes are associated with a single peripheral and are not organized on
an enterprise-wide basis. Figure 10 shows some examples of routes and
how they map to individual peripheral targets.

Routes

Denver Sales
Denver.Sales.Pri
Agent 325
Denver.Trunks + DNIS

ACD

ACD

ACD

Dallas.Sales
Dallas.Sales.Pri
Agent 81
Dallas.Trunks + DNIS

Boston Sales
Boston.Sales.Sec
Agent 123
Boston.Trunks + DNIS

Figure 10:  Routes

The ICR converts the route value that is returned by the routing script to
a routing label. This routing label is then returned to the routing client.
The routing client uses the routing label to deliver the call to the
appropriate trunk group and DNIS combination.

 See also: The Intelligent CallRouter System Manager Guide contains a more
in-depth discussion of routes and how they are mapped to specific
targets.

 1.2.6. Other Parts of the Enterprise
In addition to viewing data for services, skill groups, agents, trunk
groups, and routes, you can view data for the following call center
entities:

Application Gateways

You can report on data related to the Application Gateways set up in the
system. The GEOTELìGateway feature allows the ICR to interface to
host systems that are running other call center applications.

The Application Gateway is implemented via a node in the ICR Script
Editor. A routing script that contains an Application Gateway node can
query an application running on a host system in order to obtain data to
use in call routing. The ICR can then base subsequent routing decisions
on the results obtained from the query.
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Call Types

A call type is a category of incoming calls. Calls are categorized based
on dialed number (DN), caller-entered digits (CED), and calling line ID
(CLID). Each call type has a schedule that determines which routing
script or scripts are active for that call type at any time. In reports, you
might want to display data such as the number of calls of a certain call
type that used default routing during a specified interval.

Peripherals
A peripheral is the switch (for example, ACD, PBX, or VRU) that
receives the calls routed by the ICR. In the course of managing the call
center enterprise, you might want to view switch-specific hardware and
software status data along with call and agent information. You can view
this type of data for any supported peripheral in the call center
enterprise.

Routing Clients

A routing client is an entity that sends routing requests to the ICR. A
routing client typically corresponds to a subsystem within an
interexchange carrier or to a peripheral (ACD, VRU, PBX) that is
performing Post-Routing. You can report on statistics for the different
routing clients defined in the ICR system. For example, you might want
to report on the maximum delay of route responses to the routing client
for a specified interval.

Schedules

The GEOTEL•Schedule Link option allows the Intelligent CallRouter to
import schedule data from an external workforce management system.
The Intelligent CallRouter can then use the workforce scheduling data to
make call routing decisions.

You can also generate reports on staffing schedule data that has been
imported from a third-party workforce management system. The ICR
Workforce Management System is an optional tool for the AW that
allows you to import schedule data and store it in Schedule_Import
tables in the ICR database. For example, you might create a report that
compares scheduled agent states to actual real-time states monitored by
the ICR (for example, Logged In, Ready, Closed Key). You can also
export data for use in ACD reports.
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1.3.  Peripheral-Specific Terminology
The ICR supports several models of call center peripherals. Specifically,
the ICR supports the following ACDs:

� Alcatel 4400

� Aspect CallCenter

� Ericsson ACP1000

� Lucent DEFINITY ECS

� NEC NEAX 2400

� Nortel DMS-100, SL-100

� Nortel Meridian

� Rockwell Galaxy

� Rockwell Spectrum

� Siemens Hicom 300E (Release 9006)

� Siemens Rolm 9751CBX (Release 9005)

� VRUs from AT&T, Brite, Edify, IBM, InterVoice, Lucent,
Microlog, Periphonics, Tandem, and VoiceTek.

 See also: For more information on VRU support, see the Intelligent CallRouter
Product Description.

Each of these peripherals has its own terminology to describe the call
center. In most cases, the ICR terms map very closely to the
corresponding ACD terms. In some cases, the mapping of ICR to ACD
terms is not as precise. For example, although it might make sense to
associate each VDN on a DEFINITY ECS with an ICR service, you
could also map each hunt group to a service. Tables 1, 2, and 3
summarize the mapping of ICR call center terminology to ACD-specific
terminology.

On Rockwell Galaxy ACDs, and on Lucent DEFINITY ECS ACDs
running in EAS mode, each skill group has primary and secondary
subgroups. The ICR emulates this by automatically creating additional
skill groups for these peripheral types. In reports and scripts, you can
reference the .pri and .sec skill groups directly or you can refer to the
base skill group. The base skill group is an inclusive skill group that
organizes related primary and secondary subgroups.
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Table 1:  Aspect, Lucent, and Nortel—ICR Terminology Mapping

GEOTEL
ICR

Aspect
CallCenter

Lucent DEFINITY
ECS

Nortel DMS-
100/ SL-100 Nortel Meridian

Service Application Vector Directory
Number (VDN)

Primary or
supplementary
ACD DN

ACD Directory
Number
(ACD DN) or ACD
Controlled
Directory Number
(ACD CDN)1

Skill Group Agent group Skill group or hunt
group2

ACD group ACD DN

Agent Agent Agent Agent Agent

Trunk Group Trunk group Trunk group None3 Route

Trunk Instrument4 Trunk None Member of route

Peripheral
Target

Trunk group
and DNIS5

Trunk group and
DNIS6

Primary or
supplementary
ACD DN

Trunk group and
DNIS

                                                     
1 Without Customer Controlled Routing (CCR), one or more services map to an

ACD DN. With CCR, one or more services map to an ACD CDN.
2 If Expert Agent Selection (EAS) is configured, a skill group maps to an ECS

skill group; otherwise, it maps to a hunt group.
3 One network trunk group and one associated trunk group are defined for each

DMS-100 ACD.
4 A CallCenter instrument can be a trunk, a teleset, or a workstation.
5 The CallCenter maps a trunk group and DNIS to a Call Control Table (CCT).
6 The DEFINITY ECS uses the trunk group and DNIS for incoming calls. It

uses the VDN extension for other calls. A DNIS can refer to either a VDN
extension or hunt group extension.
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Table 2:  Rockwell and Siemens—ICR Terminology Mapping

GEOTEL
ICR

Rockwell
Spectrum

Rockwell
Galaxy

Siemens HICOM
300E (9006)

Siemens Rolm
9751 CBX (9005)

Service Application Gate ACD Routing Table
(ART)

Pilot Number
associated with
ART

Skill Group Agent group Primary,
secondary, and
tertiary groups
for a gate.

ACD Group ACD Group

Agent Agent Agent Agent Agent

Trunk
Group

Trunk group Trunk group Trunk group Trunk group

Trunk Trunk Trunk group Trunk Trunk

Peripheral
Target

Trunk group
and DNIS

DNIS Destination ACD
Number (DNIT)

Destination ACD
Number (DNIT)

Table 3:  Alcatel, NEC, and Ericsson—ICR Terminology Mapping

GEOTEL
ICR Alcatel 4400 NEC NEAX 2400 Ericsson ACP1000

Service Pilot CCV number Trunk group/called
number

Skill Group Agent PG Split number Agent group

Agent Agent Agent Agent

Trunk Group None Trunk group Trunk group

Trunk None Trunk Trunk

Peripheral
Target

DNIS Pilot number Trunk group or queue
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The ICR comprises a set of the functions of the supported peripherals.
Because the features of each ACD vary, one type of ACD cannot take
advantage of every capability the ICR offers. Some ACDs have
limitations that prevent them from making full use of specific features of
the ICR. Table 4 summarizes these limitations.

Table 4:  Features Not Supported for Specific Peripherals

Peripheral Type Restrictions

Aspect CallCenter Only one skill group assignment per agent.

Alcatel 4400 No trunk group monitoring.

Ericsson ACP1000 Only one skill group assignment per agent.

Nortel DMS-100/
SL-100

No trunk group monitoring.

Nortel Meridian Limited trunk group monitoring1.

No peripheral service level reporting.

Ring time for a call is included in either queue time or
delay time.

Cannot specifically track agents as Talking Out (this
time is included in Talking Other).

Rockwell Galaxy No Post-Routing or translation routing.

GEOTEL•Enterprise CTI not supported.

GEOTEL•Agent Reporting not supported.

No duplexed PG operation.

No Longest Available Agent (LAA) routing.

Can route only to services; not to specific agents or
skill groups. (The ACD chooses the best group or agent
to provide the service.)

No real-time agent state data (but accumulated times in
each state are reported).

(continued)

                                                     
1 The Meridian ACD supports a subset of trunk group real-time and half-hour

data in the ICR database schema.
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Peripheral Type Restrictions

Rockwell Spectrum No trunk group monitoring.

Duplexed PG operation supported only for TCP/IP
Transaction Link configurations.

Siemens
HICOM 300E (9006)

No trunk group monitoring.

Limited conference call monitoring.

Siemens/Rolm
9751CBX (9005)

No Post-Routing or translation routing.

GEOTEL•Enterprise CTI not supported.

GEOTEL•Agent Reporting not supported.

No Automatic Configuration.

No Longest Available Agent (LAA) routing.

No routing to a specific agent.

No trunk group monitoring.

No termination call detail data.

Limited real-time service and skill group routing.
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 2. The Admin Workstation

The Admin Workstation (AW) is the human interface to the Intelligent
CallRouter. The Admin Workstation is a PC running GEOTEL software
on the Microsoft® Windows NT™ operating system. Admin
Workstations can be located throughout the call center enterprise.

Using the Admin Workstation, you can

� Monitor the performance of agents, skill groups, services, routes,
and trunks.

� Generate historical reports.

� Provide web access to ICR reports and scripts.

� Change the ICR system configuration.

� Define, modify, and view call routing and administrative scripts.

� Monitor the execution of scripts.

This chapter introduces the Admin Workstation (AW) with a special
emphasis on call center reporting.

 See also: For information on ICR system configuration or call routing scripts, see
the Intelligent CallRouter System Manager Guide. For information on
system maintenance tasks, see the Intelligent CallRouter Administrator
Guide.
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2.1.  The GEOTEL Admin Workstation Group
Each Admin Workstation contains the GEOTEL Admin Workstation
group. When open, the GEOTEL Admin Workstation group appears as
follows:

Not all AWs have an identical sets of tools. The tools on each AW may
vary depending on the ICR features you ordered. In general, the
following programs are available:

� Application Wizard. Lets you setup the configuration elements
need to route a call from a routing client to a target at a peripheral.

� AW Select. Lets you start and stop the services needed to run
Admin Workstation applications.

� Bulk Configuration. Lets you efficiently add or modify multiple
rows in certain ICR configuration tables.

� Call Tracer. Lets you send test calls to the ICR and see how they
are processed and the target chosen for the call.

� Check Routes. Lets you validate the configuration of routes
referenced by a script.

� Configure ICR. Lets you set up and maintain your GEOTEL

environment. The configuration includes the hardware within the
system, the services provided by the system, and the agents who
provide them.

� Custom Screen Builder. Lets you create your own report templates
for use in the Monitor ICR reporting application.

� Glossary. Defines terms related to the ICR.

� Initialize Local Database. Lets you copy current information from
the ICR’s central database to the local database on the Distributor
Admin Workstation. (Normally, this is done automatically.)

� Job Scheduler. Lets you schedule reports to be generated and
printed at a later time.
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� Lock Admin. Lets you check or change the status of locks in the
ICR central database.

� Monitor ICR. Lets you view graphs and reports to monitor the
performance of specific agents, skill groups, services, and other
groups within the ICR call center enterprise.

� Print Server. Works with the Job Scheduler to allow you to
automatically print reports at specific times.

� Route Explorer. Displays the associations between dialed numbers,
labels, peripheral targets, services, and routes.

� Router Log Viewer. Displays information about calls processed by
the ICR and any errors encountered in processing them.

� Scheduled Target Manager. Lets you configure and manage
scheduled targets.

� Schema Help. Describes the structure of the ICR databases.

� Script Editor. Lets you create, modify, and schedule routing scripts.
The ICR executes these scripts to determine where to route each
call.

� Send Home. Lets you report issues or submit orders directly to
GEOTEL Customer Support.

� Service Control. Lets you stop and start ICR-related services.

� Setup. Lets you modify ICR setup parameters.

� Translation Route Wizard. Lets you configure and manage
translation routes.

� Workforce Management Integration System. Lets you exchange
data between the ICR and an external workforce management
system. It also lets you define custom or periodic schedules.

These tools are covered in detail in the ICR product documentation.

2.2.  Distributor and Client Admin Workstations
One Admin Workstation at each site maintains a connection directly
with the Intelligent CallRouter central controller. The ICR central
controller contains the call routing logic for the system. It also acts as
historical and real-time data server for the system.

The connection between the ICR central controller and an AW is
referred to as the real-time feed. The real-time feed connection is used to
send real-time monitoring data to a Distributor AW. The Distributor
Admin Workstation receives the real-time data and acts as a data
distributor to all other AWs at the site. Admin Workstations that do not
serve as data distributors are called Client Admin Workstations.
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Each Distributor AW has its own local database that contains a copy of
data from the central database. The ICR’s Update AW background
process automatically keeps the local database synchronized with the
central database.

 2.2.1. Real-Time and Historical Data
The ICR collects real-time and historical data from each call center to
determine where to route each call. The real-time data provides current
information about specific skill groups, services, trunk groups, routes,
and scripts. Real-time data are stored in the Distributor AW’s local
database where it is constantly overwritten by new data. The historical
data are stored in the ICR central database in summary five-minute and
half-hour intervals. The ICR also saves call detail records in the central
database for each call routed.

 2.2.2. Historical Database Server (HDS)
A Distributor AW may optionally serve as an Historical Data Server
(HDS). In this configuration, the ICR Logger (the system’s database
server) automatically forwards historical data to the Distributor AW
where it is stored in a special HDS database. Other AWs at the site can
read historical data from the Distributor AW rather than from the central
database.

 2.2.3. Monitor-Only AW
Some Intelligent CallRouter systems might incorporate a monitor-only
version of the Admin Workstation. This is a scaled-down client AW that
allows you to use the ICR’s reporting tools on desktop PCs running
Windows 95 or Windows NT. The monitor-only AW is used exclusively
for reporting and does not have the tools necessary for changing call
routing and system configuration data, or scheduling reports for printing.

 See also: The monitor-only AW comes with on-line help that explains the
workstation’s features in more detail.
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 2.2.4. Admin Workstation Users
Three kinds of people use the Admin Workstation:

� System Manager. Uses the Admin Workstation to update the ICR
system configuration, create and edit call routing scripts, and
download Admin Workstation configuration information from the
central database.

� Supervisor. Uses the Admin Workstation to monitor call center,
agent, and agent group performance and produce real-time and
historical call center management reports. The tool of most
importance to the Supervisor is Monitor ICR.

� Administrator. Uses the Admin Workstation to maintain the ICR
databases, register new users in Windows NT, and view system
event log files.

 2.2.5. Open Database Architecture
The ICR employs an open database architecture. Monitor ICR is just one
of many tools you can use to access the ICR central and local databases.
Other third-party tools can be used to manage the data in these
databases.

Applications like Microsoft Excel, Microsoft Visual Basic, and
Powersoft InfoMaker allow you to access the databases and create
reports. You are also free to use other standard Windows tools to access
data. For example, you can access data directly from the ICR databases
using Microsoft SQL Server and Open Database Connectivity (ODBC)
tools.

 Note: Although you can read any data you want from the ICR databases,
GEOTEL recommends that you do not directly modify data in the central
database by using third-party tools. Modifying data with third-party
tools can cause disruptions in the system. Use the ICR tools when
modification is necessary.

2.3.  Monitor ICR Reporting
Monitor ICR is the reporting and monitoring tool of the Admin
Workstation. It is an integral part of the AW and is the main subject of
this manual. Monitor ICR features an extensive set of predefined report
templates. The ICR report templates allow you to quickly generate
reports of the call center and agent performance data that are stored in
the ICR databases.

 See also: Chapter 8, “Template Reference,” provides details on each report
template that comes with Monitor ICR.

Monitor ICR
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You can change the predefined templates to suit your particular business
needs by using the optional ICR Custom Screen Builder. The Custom
Screen Builder is a client database access application that is based on
Powersoft InfoMaker. The Custom Screen Builder also allows you to
create new report templates for use in Monitor ICR.

 See also: The Intelligent CallRouter Custom Screen Builder Tutorial provides an
introduction to the ICR Custom Screen Builder tool.

 2.3.1. Enterprise and Peripheral Reporting
The ICR’s reporting structure allows you to view organizational entities
independently or generally over the entire enterprise. For example, in
one report you can see how calls are being handled generally by using an
enterprise service. In a second report, you can see how calls are being
handled by individual agents, agent teams, peripheral services, or skill
groups. Figure 11 shows an example of two Monitor ICR reports:

Figure 11:  Enterprise and Peripheral Reporting

The first report contains data for several enterprise services. One of
these services is called MidTier. Like all enterprise services, the MidTier
enterprise service has several component peripheral services. The
enterprise service report provides data for the component peripheral
services on an enterprise-wide basis.

To see the data broken out by individual peripheral service, you would
generate a peripheral service report. Three components of the MidTier
enterprise service are the subject to the peripheral service report:
Bellevue.MidTier, Boston.MidTier, and Denver.MidTier.
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 2.3.2. Agent Reporting
GEOTEL•Agent Reporting is an optional feature that can be licensed for
peripherals (ACDs, PBXs) in the call center enterprise. With this feature
enabled, you can generate reports of agent-level data through Monitor
ICR. (The Siemens 9751 CBX (9005) and Rockwell Galaxy ACDs do
not support agent reporting.)

The types of reports you can generate vary in scope. For example, you
might want to report on the activity of specific agents within the
enterprise. Optionally, you might report on the activity of agents
associated with a particular skill group or agent team. Table 5
summarizes the types of agent reports you can generate.

 Table 5:  Agent Report Types

Report Type Scope

Peripheral agent Displays information about selected agents throughout
the enterprise regardless of peripheral associations.

Agent by
peripheral

Displays information about each agent currently logged
into one or more selected peripherals.

Agent by skill
group

Displays information about each agent currently logged
into one or more selected skill groups.

Agent by team Displays information about each agent in one or more
selected agent teams.

The data that are displayed in these reports include real-time and
historical data that cover:

� Agent status

� Agent activity

� Agent performance

 See also: Chapter 7 “Available Data,” provides an overview of the data available
for agent-level reporting. Chapter 8, “Template Reference,” provides
details on each agent-level Monitor ICR report template.

Enabling Agent Reporting
A call center enterprise can contain many agents whose states are
changing frequently. Consequently, while monitoring agent states the
ICR might generate and store a large amount of data. To limit the
amount of data generated and stored, the ICR provides two ways to
control the generation of agent data:

� Specify which peripherals in the enterprise provide agent data.

� Define the flow of data from a specific peripheral to a Distributor
AW site. This is called an agent distribution.
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 See also: The Intelligent CallRouter System Manager Guide provides specific
instructions for enabling agent-level reporting. Some general guidelines
are presented here.

À To specify which peripherals provide agent data:

Run Configure ICR. In the Peripheral Configuration window, set the
Agent Reporting option for each peripheral you want to provide
agent-level data. You can set this option on a peripheral-by-peripheral
basis.

À To define an agent distribution:

Run Configure ICR. In the Agent_Distribution_Configuration window,
define which peripherals feed agent data to each Distributor AW site.
You can enable or disable an agent distribution at any time. Disabling an
agent distribution allows you to stop the flow of all agent data to a
Distributor AW when you are not viewing real-time agent reports.

Enabling Agent State Trace

Optionally, you can track every state an agent passes through and
display this data in Monitor ICR reports. You can enable the agent state
trace feature for individual agents.

À To enable agent state trace:

Run Configure ICR. Enable the Agent State Trace option in the Agent
Configuration window.

Tracking every state of an agent puts an added load on the ICR.
Therefore, you should use this feature only for short-term tracking of
specific agents.

 See also: See the Intelligent CallRouter System Manager Guide for more
guidelines on using the agent state trace feature.

2.4.  Monitor ICR Reporting Scenario
In order to quickly detect changes in call volumes and service levels,
you need access to up-to-the-minute data. You also need historical data
in order to analyze trends and gauge resources across the call center
enterprise. Monitor ICR allows you to combine real-time and historical
data in a single report. In addition, you can and have several reports
displayed on the workstation screen at once.

 2.4.1. Viewing Multiple Reports
By viewing multiple reports, you can get a clear picture of current and
past call center performance. For example, say you are viewing a report
that shows service levels for several enterprise services. You notice that
the PremiumSales enterprise service has had a sharp drop in its service

Configure ICR

Configure ICR

Configure ICR
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level over the last half-hour. To further investigate the problem, you
open two additional call analysis reports:

� One report provides real-time data such as calls offered, calls
abandoned, average speed of answer, and service levels for the
PremiumSales enterprise service.

� The other report displays the same data for the PremiumSales
enterprise service, but historically over the last two weeks.

You now have three reports on the screen, each displaying a different set
of data for the PremiumSales enterprise service. Figure 12 shows an
example.

Figure 12:  Sample Report

 2.4.2. Analyzing the Data
As you analyze the historical data, a trend becomes obvious:  between
3:00 and 5:00 P.M. each day, the number of calls offered to the
PremiumSales enterprise service increases dramatically. Since agents
become increasingly busy during this time, calls are being held longer
than necessary, which consequently causes the service level to drop.
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 2.4.3. Correcting the Situation
To correct the situation, you consider two options:

� First, you find out if there is an excess of qualified agents in other
skill groups in the call center enterprise. Are these agents available
to handle PremiumSales calls between 3:00 and 5:00 P.M.? If they
are, you can add these skill groups to the search list of the ICR call
routing script currently in effect for the PremiumSales enterprise
service. The routing script will activate the backup skill groups as
necessary to ensure that service levels remain high.

� As a second option, you may decide to work with the appropriate
site personnel to determine if you can add more agents. For
example, you might have several call centers in the enterprise each
assign an agent to the PremiumSales enterprise service.

 2.4.4. Monitor ICR Reporting Terms
Before you begin using Monitor ICR, it may be helpful to review some
of the terms that are frequently used in this manual:

� Template. You use templates to create reports. A template is a file
that specifies the types of data to be displayed in a report and how
the data will be displayed (for example, in a graph, a chart, etc.). The
types of data and the display format are fixed in the template file.
However, you can specify that you want data for a particular agent,
service, skill group, trunk group, route, etc. You can also specify a
range of dates for which to retrieve data.

A number of predefined templates are provided with Monitor ICR.
You can use the ICR Custom Screen Builder to modify these
templates or to create new ones.

� Historical template. A historical template is a template that is
based on historical data from the ICR central database. You can use
historical templates to create reports that contain half-hour and daily
summaries of agent and call center data.

� Real-time template. A real-time template is a template that is based
on real-time data from the Distributor AW local database tables.
You use real-time templates to create reports that provide a view
into current agent and call center activity.

� Report. A report is the final presentation of data, titles, dates and
times, and graphic elements displayed on the AW screen or printed.
A single report can include components generated by one or more
templates. For example, one report can contain a real-time pie chart
and a historical grid, each generated with a different template. Once
the report is displayed on the screen, it can be saved as a report
definition.
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� Report definition. A report definition is a file that specifies the
templates the report uses to retrieve data. The report definition also
specifies other values that the report includes (for example, dates
and times, particular services, skill groups, etc.). Report definitions
are saved as files with .CMB extensions in the subdirectories of the
icr\aw\custname\custom directory. They can be displayed at any
time in Monitor ICR.

2.5.  Web View
GEOTEL•Web View is the web-based reporting and script monitoring
tool of the ICR. You can install Web View on an Admin Workstation to
make it a web server in your corporate intranet. Other computers with
access to the web can use the GEOTEL•Web View Server to generate
ICR reports and monitor call routing scripts in real-time. Figure 13
shows an example of the type of Web View report that can be displayed
in a web browser:

Figure 13:  Web View Report

The URL for the Web View internal web site address depends on the
name of the Distributor AW machine where the server component is
installed. See your network administrator for more information.
WebView currently supports Microsoft

®
 Internet Explorer version 4.0 or

Netscape Navigator
™

 versions 3.0 or higher. The Web View on-line help
provides instructions on generating web-based reports.

 See also: For details on using and installing Web View, refer to the GEOTEL•Web
View Administrator Guide.
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 3. Creating a Report

The Monitor ICR reporting tool allows you to report on call and agent
activity throughout the call center enterprise. You can use real-time data,
historical data, or a combination of the two in a single report. You can
also display multiple reports on the screen, save reports, and print
reports.

This chapter provides a tutorial that guides you through the process of
generating a report. In this tutorial, you will learn how to:

� Start Monitor ICR.

� Set up the Template Launcher.

� Set thresholds in reports.

� Add drill-downs to reports.

� Save report definitions.

� Display reports automatically at startup.

 See also: If you need details on the features and functions of Monitor ICR, see
Chapter 4, “Reporting Basics.”
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3.1.  The Report Example
The report you will be creating includes a real-time bar graph that
displays call queue status data for selected peripheral services. This data
includes:

� Average Delay in Queue

� Expected Delay in Queue

� Longest Call in Queue

� Average Speed of Answer (ASA)

The data for the real-time bar graph is taken from the
Service_Real_Time table in the Admin Workstation local database.

 See also: For more information on the tables of the central and local databases, see
the Intelligent CallRouter Database Schema Handbook.

The report example also includes a historical grid that displays half-hour
call analysis data for selected peripheral services. This data includes:

� Service Level

� Average Speed of Answer (ASA)

� Average Handle Time (AHT)

� Average Delay in Queue

� Calls Offered

� Calls Handled

� Calls Abandoned in Queue

The historical data is taken from the Service_Half_Hour table in the ICR
central database. The historical grid displays data for a specific range of
dates and times that you specify.
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The completed report looks similar to the following example:

Often when using Monitor ICR, you create reports that contain only one
report component (for example, a real-time graph showing the delay in
queue). In some cases, you might want to display real-time and historical
data in a single report. With Monitor ICR, you can launch several report
templates at the same time to create a report with multiple real-time and
historical components.

Although the report generation process is basically the same whether
you use one or more templates, some Monitor ICR features are specific
to multiple-component reports. Therefore, it’s worthwhile to learn how
to use Monitor ICR by creating a multiple-component report.
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3.2.  Starting Monitor ICR
To start Monitor ICR, click Start, then point to Programs. In the
Programs menu, point to GEOTEL Admin Workstation and click Monitor
ICR. The Monitor ICR main window appears:

The Monitor ICR toolbar provides buttons that allow you to quickly
activate the most common functions (for example, New, Open, and
Save).

 See also: The Monitor ICR buttons are described in more detail in the on-line help
and in Chapter 4, “Reporting Basics.”

 3.2.1. Controller Time
The Controller Time window appears whenever the Monitor ICR
window is displayed:

This window shows the current date and time at the Intelligent
CallRouter central controller. The central controller is the computer that
is routing calls and logging management data to the ICR databases. The
main central controller processes are the CallRouter and the Logger
(Database Server).

Monitor ICR
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3.3.  Setting Up the Template Launcher
To generate the report, open the Template Launcher window.

À To open the Template Launcher:

In the Monitor ICR window, click the New button. The Template
Launcher window appears:

The Template Launcher allows you to choose reporting options from
several tabs.

À Choose the Category and Scope options:

1. Select Service as the data Category. (By default, Service is already
selected.)

2. Select Peripheral as the Scope. (In this tutorial, you are reporting on
peripheral services rather than enterprise services. Peripheral
services are services that are tied to specific ACDs or VRUs.)

The Category and Scope selections you make specify the general
subject of the report.

À Choose a Business Entity:

If your ICR system has more than one business entity, choose one from
this list. Otherwise, accept the default selection. The business entity
specifies which subset of the ICR enterprise you will be reporting on.
For example, a business entity may represent a division within a large
corporation or a single customer within a service bureau.

À Choose the Date and Time options:

1. Click on the Date and Time tab and choose Absolute Dates (the
default). (Dates and times have no effect on the real-time portion of
the report, but you need them for the historical report component.)
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2. In the From field, click on the down-arrow. A calendar appears:

3. Double-click on a day (three or more days ago). A date is entered in
the From field.

4. For this tutorial, do not change the To field. The default setting will
provide data up to the present day.

5. Enter 8:00 in the From time field by highlighting the first two digits
and incrementing the time using the up-arrow.

6. Leave the To time set to the default (11:59 PM). This provides data
up to the current time.

7. Click on the “Show a date and time label…” option to indicate that
you want to show the dates and times as a separate component in the
report. Your dates and times should appear similar to the following:

You can now choose the specific parts of the call center enterprise
that the report will cover.

À Choose the specific Items on which to report:

In the Items tab, click on two or more peripheral services from the
selection list. This specifies that you want data for these specific
peripheral services.

� To select more than one item, hold down the CTRL key as you click
on each item.

� To select a range of items, click the first item in the range, press
SHIFT, and click on the last item in the range.

� To select and deselect all items in the list, click the Select All
button.
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You can now choose the templates to use in the report.

À Choose the Templates:

In the Templates tab, choose the following templates:

� persvc01_queue_delay_status

� persvc12_calls_analysis_half_hour

The Template Launcher is now set up to generate a report. Your screen
should appear similar to the following example:
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3.4.  Launching the Report
To launch the report, click OK. An untitled report window appears:

À To design the report:

1. Click on the Maximize button    in the upper right corner of the
report window. The report window is maximized. You may also
want to maximize the Monitor ICR window.

2. Drag the graph, chart, and text objects and resize them. Try to lay
out the report so that you can see all the data and the graph and chart
titles. In tabular report components, like persvc12, you can use the
scroll bar on the right side of the window to view more data.
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The following example shows the items in the report resized and
repositioned. You may choose to use a different layout:

3. Click inside the title box and enter a title for the report (for example,
“Call Analysis for Bellevue, Denver, and Omaha MidTier
Services”). Resize the Title window, if necessary.

4. When you are satisfied with the appearance of the report, choose
Edit→Shuffle Mode from the Monitor ICR menu to deselect Shuffle
Mode. When you deselect Shuffle Mode, the window borders and
title bars of the individual report components are hidden.
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Your report should appear similar to the following example:

 3.4.1. What the Report Shows
The report you created contains a real-time bar graph that shows the
average delay in queue, expected delay in queue, length of the longest
call in queue, and the average speed of answer for each service. In this
example, the real-time monitoring data is displayed for three peripheral
services. Notice that the real-time data in the bar graph is continually
updated.

The historical section of the report displays several categories of
information related to call analysis for each of the peripheral services.
Some categories in historical reports are displayed as counts, while
others such as Service Level are displayed as a percentage. Depending
on the type of data, the summary rows total, average, or perform another
calculation on the data for each column.

 See also: Chapter 7, “Available Data,” describes the common types of data
displayed in Monitor ICR reports. The Monitor ICR on-line help system
also provides information on how specific data is calculated.
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 3.4.2. The Status Bar
If you click on a bar in the graph, a message appears in the status bar at
the bottom of the Monitor ICR window. The status bar describes what
the bar represents and its current numerical value. For example:

You can use this feature to get a precise reading of a value in the graph
or to differentiate the bars if you have trouble distinguishing their colors.

3.5.  Retrieving the Latest Historical Data
Now that the report is displayed on the screen, you can retrieve the latest
half-hour summary data accumulated by the ICR while you were
creating the report.

À To retrieve the latest historical data:

Click the Retrieve button. The historical grid is updated with new
half-hour summary data that has been collected by the ICR.

3.6.  Printing the Report
With the report displayed, choose File→Print, or click the Print button in
the tool bar. The report is sent to the printer.

3.7.  Saving the Report
At this point, it’s a good idea to save the report. After you save the
report, you can open it again at any time without having to re-launch the
templates.

Within Monitor ICR, reports are saved as report definitions, which are
files that specify the templates to be used to retrieve data. Report
definitions also specify other items that the report includes, such as dates
and times or the particular subjects of the report (for example, specific
peripheral services or skill groups). Report definitions can be opened at
any time in Monitor ICR.
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À To save the report definition:

1. Choose File→Save, or click the Save button. The Save Report
Definition dialog box appears.

Since you created a report on peripheral services, the Save Report
Definition dialog box defaults to the persvc directory. The “persvc”
directory is reserved for storing peripheral services report
definitions. Similarly, other subdirectories of the Admin
Workstation’s \custom directory exist to hold other types of report
definitions (for example, skill group, route, and trunk group reports).

2. Type TUTOR as the file name. The .CMB extension is retained.

3. Click OK. The report definition is saved.

4. At the Monitor ICR menu, choose File→Close. The report file is
closed, but the Monitor ICR window remains displayed.

The next time you open the TUTOR.CMB report, the real-time graph
component of the report displays real-time data. The historical grid
displays data for the range of dates you specified when your originally
created the report. Since you did not change the end date and end time,
the historical grid always displays data up to the present date and time.

You can change report definitions like TUTOR.CMB by using the
Monitor ICR Definition Editor. For example, you might want to change
the start dates and times in the historical component of the report.

 See also: The Definition Editor is described in Chapter 4, “Reporting Basics.”

 Note: The saved report definition (TUTOR.CMB) does not appear in the
Template Launcher list of templates. It is stored as a .CMB report
definition file, not as a template.

Now that you have created and saved a report definition, you can open
the report and make changes and improvements such as setting
thresholds and adding drill-downs. Thresholds allow you to set yellow
and red indicators on important fields of data in a report. Drill-downs
allow you to launch additional reports from within the current report
window.
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3.8.  Opening the Report
You can open the TUTOR.CMB report by selecting the Open command
from the File menu or by clicking the Open button.

À To open the TUTOR.CMB report:

1. In the Monitor ICR window, choose File→Open, or click the Open
button. The Select Report Definition dialog box appears.

2. Scroll down in the Folders list and double-click the persvc folder
(this is the subdirectory in which the TUTOR.CMB report was
saved). The TUTOR.CMB report definition appears in the file list:

3. Choose TUTOR.CMB from the list.

4. Click OK. The report is opened and appears on the screen.

Now you are ready to set thresholds in both the real-time and historical
components of the report.

3.9.  Setting Thresholds
As you examine data in the report, you might decide that you want
certain data categories to stand out, especially if the values are out of an
expected performance range. For example, maybe you’d like the Service
Level column in a report to turn red when the service level drops too
low. You can set thresholds such as these to alert you when certain
values exceed or fall below expected levels.

In the real-time bar graph, the threshold alert notifies you immediately
of an unacceptable condition. In the historical grid, the threshold alert
highlights areas that were out of an expected performance range over a
period of time.

À To set thresholds in the real-time graph:

1. With the TUTOR.CMB report displayed, place the mouse pointer
over the real-time graph and hold down the right mouse button. A
pop-up menu appears:
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2. Choose Thresholds. The mouse pointer changes to a cross hair (+).
(Alternately, you can choose the Thresholds option from the Edit
menu.)

3. Click anywhere inside the real-time graph. The Threshold Editor
dialog box appears:

You can set thresholds for the four attributes displayed in the Queue
Delay Status bar graph (that is, Avg. Delay, Expected Delay,
Longest Call, and Average Speed of Answer (ASA)). These
thresholds can be set for all the peripheral services displayed in the
graph.

4. The default Relation (>=) is appropriate for the Avg. Delay
thresholds you are about to set, so press TAB. (In the real-time
graph, you want to highlight values that equal or exceed (>=) a
certain threshold.)

5. Enter 15 as the yellow threshold and press TAB.

6. Enter 25 as the red threshold and press TAB.

7. Tab down to the Longest Call yellow threshold field. (You do not
have to set a threshold for the Expected Delay attribute. The
Expected Delay is the ICR’s predicted delay for a new call added to
the service queue.)

8. Set the thresholds for Longest Call and Average Speed of Answer
(ASA) as you did for Avg. Delay. Enter the values as shown:

9. Click on Apply. (Don’t close the Threshold Editor yet.)
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The thresholds you just set will have the following effects, possibly
immediately, depending on the values in the graph:

� When the Average Delay in Queue is greater than or equal to 15
seconds, the Avg. Delay bar in the real-time graph will turn yellow,
indicating a first-level warning. The first-level warning (yellow) is
intended to inform you when a count or value is approaching an
unacceptable level.

� When the Average Delay in Queue is greater than or equal to 25
seconds, the bar in the graph will turn red, indicating a more serious
condition. This indicates that for the affected peripheral services, the
Average Delay in Queue has reached an unacceptable level.

� When the Longest Call (Waiting in Queue) is greater than or equal
to 30 seconds but less than 45 seconds, the Longest Call bar in the
graph will turn yellow, indicating that the 30 second delay is
approaching an unacceptable level. If that number equals or goes
over 45 seconds, it means that an unacceptable performance level
has been reached or exceeded. The Longest Call bar will turn red to
indicate this more serious condition.

� The Average Speed of Answer yellow and red thresholds will also
be triggered when performance levels equal or exceed 15 and 20
seconds respectively.

You can now set thresholds in the historical portion of the report.

À To set thresholds in the historical grid:

1. Within the Threshold Editor, click the Next button. The Threshold
Editor displays the data attributes for the historical Calls Analysis
grid.

2. Enter the threshold values as shown in the following example. (Note
that service level threshold values must be set in decimal format.)

3. (Important.) Be sure to change the Relation for service_level to <=.
You want the Service Level threshold to be triggered when the value
equals or falls below a certain value.

4. Click Apply.

You just set the number of Calls Offered thresholds to highlight the
column if the number of calls equals or exceeds (>=) 50 and 60 in any
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half-hour interval. You also set the Service Level thresholds to <= to 80
percent for the yellow warning and <= 75 percent for the red warning.

If the Service Level equals or falls below 80 percent, the Service Level
column in the chart will turn yellow to indicate that the Service Level
approached an unacceptable level. If the Service Level equals or falls
below 75 percent, a red warning will indicate that a serious performance
problem existed.

 Note: Setting thresholds on the service level can alert you to other potential
performance problems. A service level that is dropping indicates that
some type of performance problem exists. To find out what is causing
the service level to drop and to see if the problem still exists, you can
launch an appropriate real-time template or open another report
definition.

À To set the other attributes:

Choose relations and enter values that you feel set proper threshold
levels for the other attributes listed in the Threshold Editor.

When you are ready to close the Threshold Editor, click Apply and then
click Done.

À To preserve the thresholds you set:

Although you applied thresholds to the report, you must save the report
itself in order to keep the threshold settings. Save the report definition by
choosing File→Save from the menu bar, or by clicking the Save button.

3.10.  Adding Drill-Downs
The DrillDown Editor lets you add another level of detail to the report.
For example, if you are looking at information about a peripheral
service, you might want to see more information about the individual
routes associated with the service. Similarly, if you have a report on an
enterprise service you might want to “drill-down” to see data for the
component peripheral services. The DrillDown Editor allows you to get
this kind of detail quickly and easily from within a report window.

À To add drill-downs to a report:

1. Open the TUTOR.CMB report definition.

2. Choose Edit→DrillDown. The report window is maximized.
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3. Click anywhere inside the “Peripheral Services Queue Delay Status”
report window. The DrillDown Editor appears. In this example, the
DrillDown Editor lists the corresponding real-time templates for
Routes:

Monitor ICR has rules that specify the groups of drill-down
templates that can be used in particular types of reports. Chapter 4,
“Reporting Basics,” provides a list of the drill-down rules and
defaults.

4. Click on the “routes02_call_status” template in the DrillDown
Editor. In this tutorial, you are setting a drill-down in order to view
additional call status data for the routes associated with a peripheral
service.

5. Click Apply to assign the drill-down template to the “Peripheral
Services Queue Delay Status” real-time graph. (Don’t close the
DrillDown Editor yet.)

You will be able to invoke the drill-down routes template for each
peripheral service in the graph. In other words, you can display a
separate drill-down report for each peripheral service listed in the graph.
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Now that you have added drill-down capability to the real-time graph,
you can do the same with the historical grid.

À To add drill-downs to the historical grid component:

1. Click on Next. The DrillDown Editor changes to reflect the route
templates that can be added to the historical grid.

2. Click the “routes12_calls_analysis_half_hour” template in the
DrillDown Editor.

3. Click Apply to assign the drill-down template to the Call Analysis
chart.

4. When you are finished, click Done. The DrillDown Editor is closed
and you are returned to the original report window.

You will also be able to invoke a drill-down report for each peripheral
service displayed in the historical grid.

You must save the changes you made to the report in order for the
drill-down capabilities to take effect. If you close the report without
saving it, the drill-down capabilities will be lost.

À To save the drill-down capabilities:

Choose File→Save or click the Save button. You can now invoke the
drill-downs you just set.

À To invoke the drill-downs:

1. With the report displayed, double-click on a bar in the “Peripheral
Services Queue Delay Status” real-time graph. A “Route Status”
drill-down report appears.
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2. Double-click on a bar for another peripheral service to specify that
you want data for that peripheral service. A new “Routes Status”
drill-down report appears.

3. To close a drill-down report, make the window active and choose
File→Close.

For the historical portion of the report, follow this same procedure, but
invoke the drill-down by double-clicking on a specific name in the
Peripheral Service column of the grid:

Once displayed, the drill-down reports can be saved as Monitor ICR
report definitions.

 See also: Chapter 5, “Setting Thresholds and Drill-Downs,” provides more
information on saving drill-downs as report definitions.

You can now learn how to set up Monitor ICR to save your workspace.

3.11.  Saving Your Workspace
You can have Monitor ICR display the screen as you left it each time
you start the application. This feature is useful in displaying your most
important and frequently used reports immediately upon startup.
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For example, say that the first thing you want to see at the start of the
workday is a real-time report on call queue delays for a certain group of
peripheral services. You can easily set up Monitor ICR to display this
report at startup.

 Note: Only saved report definitions (.CMB files) can be displayed at startup.

À To set up Monitor ICR for automatic report display:

1. Open the TUTOR.CMB report.

2. Choose Edit→Shuffle Mode and adjust the report to appear the way
you want it displayed at startup. (For example, you may want to
enlarge the real-time graph in the report.)

3. When you are satisfied with the appearance of the report, choose
Edit→Shuffle Mode again to disable shuffle mode.

4. Choose Options→Save Settings Now. This saves the current screen
settings and component positions.

 Note: Make sure that Options→Save Settings on Exit is not selected when you
exit from Monitor ICR; otherwise, the settings you have saved will be
overwritten.

À To test the startup settings:

Choose File→Exit to end the current Monitor ICR session. Then
double-click on the Monitor ICR icon to restart the application. The
report is displayed automatically.

À To return to default display mode:

1. Start Monitor ICR.

2. Choose File→Close to close the TUTOR.CMB report.

3. Choose Options→Save Settings Now.

4. Ensure that Options→Save Settings on Exit is deselected when you
exit from Monitor ICR.

The report you created in this chapter used some of the major features of
Monitor ICR. However, Monitor ICR has other features that can help
you manage your call center enterprise data.

 See also: Chapter 4, “Reporting Basics,” provides more details on the Monitor
ICR interface and several other reporting and monitoring features.
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 4. Reporting Basics

This chapter describes the basics of creating reports with the Monitor
ICR tool. It provides details on using the toolbar, menu commands,
on-line help, and the Template Launcher. Several common reporting
tasks are covered in this chapter, including:

� Starting Monitor ICR.

� Working with templates and reports.

� Exporting report data.

� Printing reports.

This chapter also describes how to set Admin Workstation preferences
such as the real-time refresh rate and the background color used in
reports.
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4.1.  The GEOTEL Admin Workstation Group
From the Windows NT desktop, open the GEOTEL Admin Workstation
group. The group contains several applications:

The following applications are used in reporting on and monitoring call
center activity:

� Job Scheduler. Lets you schedule reports to be generated and
printed at a later time.

� Monitor ICR. Lets you view graphs and reports to monitor the
performance of the system as a whole or specific services and skill
groups within the system. You can also generate new graphs and
reports using templates provided.

� Print Server. Works with the Job Scheduler to allow you to
automatically print reports at specific times.

 See also: See the Intelligent CallRouter System Manager Guide, Installation
Guide, and Administrator Guide for information on the other ICR
applications.
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4.2.  Starting Monitor ICR
To start Monitor ICR, double-click the Monitor ICR icon in the GEOTEL

Admin Workstation group. The Monitor ICR main window appears:

 See also: For information on starting Monitor ICR from the command prompt, see
“Command Prompt Startup Options,” later in this chapter. For
information on starting Monitor ICR from the Windows NT Explorer
see “File Association,” later in this chapter.

Monitor ICR
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 4.2.1. Toolbar Options
You can use the buttons on the Monitor ICR toolbar to quickly activate
the most common functions. Table 6 summarizes these buttons.

Table 6:  Monitor ICR Toolbar

Button Action

Create a new report.

Open a report that you have previously saved.

Save the current report to a file.

Print the current report.

Invoke the ICR Event Viewer.

Pause the real-time refreshing of the Monitor ICR screen.

Resume the real-time refreshing of the Monitor ICR screen.

Retrieve the latest half-hour historical data from the central
database.

Invoke on-line help.

You can also invoke these actions by using menu commands. A few of
the commands also have keyboard shortcuts.

 See also: The Monitor ICR on-line help provides more information about the
toolbar and keyboard shortcuts.

You can toggle the Options→Show Text option from the Monitor ICR
menu to display the toolbar without text:
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Monitor ICR provides a pop-up menu that allows you to display the
toolbar in several different ways. Click the right mouse button in the
area to the right of the toolbar. A menu appears:

Toggle the Frame Bar option to hide the toolbar. To redisplay the
toolbar, choose Options→Toolbar from the Monitor ICR menu. The
other options in this window (except Show Text) allow you to display
the toolbar in different positions and toggle between displaying large
buttons with text (Show Text) or smaller buttons with no text.

Toolbars can appear “docked” to an edge of the window or floating as in
the following example:

You can drag a floating toolbar anywhere within the window. If you
drag it to an edge of the window, it docks to that edge.

 4.2.2. On-Line Help
The on-line help system provides information on the user interface and
menus of Monitor ICR. For details on the menu options and other
subjects, invoke the Monitor ICR on-line help.
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À Invoke on-line help by using one of these methods:

� In the Monitor ICR window, click the Help button.

� Select Help from the Help menu.

� Press F1.

The Help contents window is shown in the following example:

Each Help system on the Admin Workstation works in the same way. If
you click the Master Help button in any of the ICR help systems,
another help window appears which lets you navigate to other help
systems via a Help Topics window.

 4.2.3. Controller Time
The Controller Time window appears whenever the Monitor ICR
window is displayed. You can position the Controller Time window
anywhere on the screen while you are working in Monitor ICR. It is part
of the Monitor ICR application and is closed and minimized along with
Monitor ICR:

The Controller Time window shows the current date and time at the ICR
Central Controller. The Central Controller is the computer or computers
running the CallRouter and the Database Server. An up-to-date
controller time indicates that the real-time feed process is active and
providing real-time data to the Admin Workstation. You can click on the
radio button (�) to display the time zone for the Central Controller.

By default, the controller time is updated approximately every 10 to 30
seconds, depending on the AW type. You can change these valueson
some AWs by using the Preferences dialog box.
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To change the refresh rate, change the value in the Refresh Rate field in
the Preferences dialog box. This field also affects the rate at which
real-time data is updated in Monitor ICR real-time reports.

 See also: See “Setting Workstation Preferences,” later in this chapter, for more
information on using the Preferences dialog box.

You may also want to see the local time at the Admin Workstation while
you run Monitor ICR. To display the local time, run the Clock task from
the Windows NT Run window.

 4.2.4. Command Prompt Startup Options
You can start Monitor ICR and open existing reports from the DOS
command prompt. For example, in a DOS command prompt window
you can type:

C:\>monitor \icr\customer\aw\custom\persvc\filename.cmb

This command starts Monitor ICR and opens the specified report
definition file. To open a specific report, you must provide the complete
path along with the filename.

If you want to start Monitor ICR without opening a specific report, you
can type the following command:

C:\>monitor

The monitor command can be entered in any DOS command prompt
window or in the Task List window. You can open the Task List
window by pressing CTRL + ESC.

Once Monitor ICR and the specified report are displayed on the screen,
you can open additional reports by issuing the command again. For
example, the following command opens a report from the “trkgrp”
directory:

C:\>monitor \icr\customer\aw\custom\trkgrp\filename.cmb

Each time you enter the monitor command, the specified report is
opened and a new instance of Monitor ICR is started.

 See also: For information on starting Monitor ICR and opening reports from the
Windows NT File Manager or the NT Explorer, see “File Association,”
later in this chapter.

4.3.  Working with the Template Launcher
The Template Launcher allows you to generate a new report using the
predefined templates that come with Monitor ICR. You can also launch
any custom templates that were created with the ICR Custom Screen
Builder. Once you launch the selected templates, you can add features,
lay out the report components, and save the report as a report definition.
Report definitions can later be opened and modified.
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À To invoke the template launcher:

In the Monitor ICR window, click the New button. The Template
Launcher window appears:

In the Template Launcher window, you choose the options that define
how a report will be generated. These options include:

� Category and Scope

� Date and Time

� Items

� Templates

After you select options in each tab, you can click OK to launch the
report.

The Template Launcher window can be closed. To close the Template
Launcher, choose Close from the Template Launcher’s control panel or
click the Close (X) button.
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 4.3.1. Category and Scope
Choose a report Category. You can select only one category on which to
base the report.

You can create reports on the following logical groups, or categories,
within the call center enterprise:

� Agent: An agent is anyone who can answer incoming phone calls. A
peripheral agent is an agent who is associated with a particular
peripheral (ACD, PBX) in the call center enterprise. A peripheral
agent can be a member of one or more skill groups. (Some
peripheral types limit each agent to one skill group assignment.)

� Application Gateway. You can report on several types of data
related to the Application Gateways set up in the system. The
Application Gateway allows the ICR to query host systems that are
running other call center applications. The ICR can then base
routing decisions on the results obtained from the query. For
Application Gateways, you can report on data such as the number of
query requests issued to a host system and the delay involved in
making queries.

� Call Type. You can report on statistics for the call types defined in
the ICR system. A call type is a category of incoming calls. Calls are
categorized based on dialed number (DN), caller-entered digits
(CED), and calling line ID (CLID). In reports, you might want to
display data such as the number of calls of a certain call type that
used default routing during a specified interval.

� Peripheral. You can use the Peripheral category to report on
switch-specific hardware and software status and some types of call
and agent information.

� Route. For routes, you can report on data such as the number of
calls in progress, calls in queue, or calls handled. A route is value
that is returned by a routing script. This value maps to a service and
a specific target at a peripheral (for example, a service, skill group,
agent, or translation route).
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� Routing Client. You can report on statistics for the different routing
clients defined in the ICR system. A routing client is an entity that
sends routing requests to the ICR. Routing clients typically
correspond to a subsystem within the interexchange carrier (IXC) or
to a peripheral (ACD or PBX) that is performing Post-Routing.
Within Monitor ICR, you might want to report on the maximum
delay of route responses to the routing client for a specified interval.

� Schedule. You can generate reports that include staffing schedule
data that has been imported from a third-party workforce
management system. The GEOTEL Workforce Management Import
System allows you to import schedule data and store it in the ICR
database. The exact data that appears in Monitor ICR reports
depends on the specific workforce management system you are
using with the ICR system.

� Service. You can report on many types of data for services, such as
service level, number of calls abandoned, number of calls offered,
and average handle time. A service is a particular type of processing
that the caller requires. For example, in a software company’s call
center, callers having questions about installing software would be
directed to the Technical Support service.

� Skill Group. A skill group is a collection of agents who share a
common set of skills, such as being able to handle Spanish-speaking
callers. For skill groups, you can generate reports that cover agent
activity (for example, the number of agents talking, available, or in
wrap-up for a particular skill group).

� Trunk Group. A trunk group is a collection of trunks that are
associated with a single peripheral. Often, the trunks in a trunk
group are used for a common purpose. In Monitor ICR, you can
report on trunk group (and network trunk group) data, such as the
number of trunks in service, number of trunks idle, and the time
during which all trunks in a trunk group were simultaneously busy
(All Trunks Busy).

Specify the Scope of the report. These options help you to further focus
your report on specific services, skill groups, routing clients, etc.
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The Scope options include:

� Base Only. This option is available only if you select Skill Group as
the Category. Base skill groups are used to organize related
subgroups on some types of ACDs. For example, you might have
skill groups called HelpDesk.pri and HelpDesk.sec to prioritize call
routing. In a report, you can reference the .pri and .sec skill groups
directly or you can refer to the base skill group.

� Enterprise. Select Enterprise to report on enterprise services or
enterprise skill groups. Enterprise services and skill groups are
collections of services and skill groups that span call centers.

� Network. This option is available only if you choose Trunk Group
as the Category. Select Network to report on Network Trunk
Groups.

� Peripheral. This option allows you to report on Peripheral Agents,
Peripheral Services, Peripheral Skill Groups, or Peripheral Trunk
Groups.

� Array. Select Array to report on Service Arrays. A Service Array is
a collection of peripheral services across VRUs that share a common
network trunk group.

� By Peripheral. This option is available only if you choose Agent as
the Category. It allows you to report on each agent currently logged
into one or more selected peripherals.

� By Skill Group. This option is available only if you choose Agent
as the Category. It allows you to report on each agent currently
logged into one or more selected skill groups.

� By Team. This option is available only if you choose Agent as the
Category. It allows you to display information about each agent in
one or more selected agent teams.

 See also: For more information on call center entities such as Network Trunk
Groups and Service Arrays, see Chapter 1, “Overview.”

Specify the Business Entity. A business entity is a subset of the ICR
enterprise that contains its own scripts, enterprise services, enterprise
skill groups, enterprise agent groups, and schedules.
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A business entity may represent a division within a large corporation or
a single customer within a service bureau. By default, the ICR enterprise
consists of only one business entity. If you enable partitioning, you can
define multiple business entities.

If you have only one entry under Select Business Entity, you need not
make a selection. Otherwise, select a business entity from the list.

 4.3.2. Date and Time
For historical reports, choose the type of date and time you want to use
in the report:

Absolute Dates
Absolute dates allow you to enter an exact period of time with From and
To dates and times. Choose this option if you want the report to display
data from a specific time period (for example, from January 18, 1999 to
January 21, 1999).

The default From and To dates and times are from the present date at
12:00 AM (midnight) to 11:59 PM. These defaults provide data up to the
present time.
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If you select Absolute Dates, click the down arrow in the From and To
boxes to display a calendar:

Double-click on a day in the calendar to select it. You can also click on
the left and right arrows in the calendar to display different months.

To enter times, highlight the time values and use the up and down
arrows to adjust them. Time is shown in 24-hour format. For example,
8:00 is 8:00 A.M. and 17:00 is 5:00 P.M.

If you leave the To time field set to 23:59, the report displays data up to
the current time. (Optionally, you can type dates and times directly into
the From and To boxes.)

Relative Dates
Relative dates allow you to select a predefined period of time for the
report relative to today’s date. Choose this option if, for example, you
want the report to display data for the previous day, last week, or the
current month. For example, if you choose Relative, you can choose an
option such as “Last Week” as a Date Time. This would provide data for
the last full week (that is, Sunday through Saturday).

If you select Relative Dates, click the down arrow in the From box to
display a drop-down list of relative date ranges:

Choose options such as Today, This Week, or Yesterday. Enter From
and To times by highlighting the values and using the up and down
arrows to adjust the times. If you leave the To time field set to 23:59, the
report will display data up to the current time. (Optionally, you can type
the dates and times directly into the From and To boxes.)
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The Relative options include:

� Today. Provides data for the current day and the time period
entered. (The 00:00 to 23:59 defaults provide data from midnight of
the current day up to the current time.)

� Yesterday. Provides data for the previous day and the time period
entered. (The 00:00 to 23:59 defaults provide data for the full day
(that is, midnight to 11:59 P.M.).

� This Week. Provides data for the current week beginning on Sunday
and ending on the current day. You can specify a From time for the
first day in the week (Sunday) and a To time for the current day.
(The 00:00 to 23:59 defaults provide data from midnight on Sunday
to the current day and time.)

� Last Week. Provides data for the last full week (Sunday through
Saturday). For example, if today is Sunday, the last full week would
be the previous Sunday through Saturday. You can specify a From
time for Sunday and a To time for Saturday. For example, you might
only want to include data from 8:00 A.M. on Sunday to 5:00 P.M.
on Saturday. (The 00:00 to 23:59 defaults provide data from
midnight on Sunday to Saturday at 11:59 P.M.)

� This Month. Provides data from the first of the month up to the
current day. For example, if today’s date is Feb. 22, data for this
month would be Feb. 1 to Feb. 22. You can specify a From time for
the first day in the month and a To time for the current day. (The
00:00 to 23:59 defaults provide data from midnight on the first day
of the month to the current day and time.)

� Last Month. Provides data for the last full month. For example, if
the current date is Feb. 8., then the last full month of data would be
Jan 1. to Jan 31. You can specify a From time for the first day of the
month and a To time for the last day. (The 00:00 to 23:59 defaults
provide data from midnight on the first day of the month to the last
day at 11:59 P.M.)

� This Year. Provides data for this year from 1 Jan. to the current day.
You can specify a From time for the first day in the year and a To
time for the current day. (The 00:00 to 23:59 defaults provide data
from midnight of the first day to the current day and time.)

� Last Year. Provides data for the last full year. For example, if the
current month is April 1997, the last full year would be Jan. 1, 1996
to Dec. 31, 1996. (The 00:00 to 23:59 defaults provide data from
midnight on the first day of the year to the last day at 11:59 P.M.)
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Advantages of Using Relative Dates

The Relative Dates option provides a unique advantage over entering
specific dates and times. When you use relative dates, you do not have to
edit the report definition to change the report dates and make them
current. Every time you bring up the report, you get data for the
specified period of time relative to the present date.

For example, if you created a report and specified “Last Week” as the
relative date, you could open the report on any day and automatically see
data for last week. You could have other reports that displayed data for
yesterday or for the last month. By using reports with different relative
dates, you can see daily activity as well as activity on a weekly,
monthly, or even yearly basis.

Show Date and Time Option

Click the “Show a date and time…” check box to display the date and
time range as a label in the report.

Hourly Boundaries
When you indicate an hourly boundary such as 10:00 in a historical
report, you get data for the 9:30 to 10:00 half-hour summary interval,
not for the 10:00 to 10:30 interval. Also, the ICR central database
provides half-hour summary data only for complete intervals. Half-hour
summary data for the 10:00 to 10:30 half-hour interval is not available
until 10:30.

 4.3.3. Items
A selection list on the left side of Items tab displays specific names
based on the options you chose for Category and Scope. The header of
the selection list indicates the type of items in the list. The following
example shows an example of a Peripheral Skill Groups selection list:

Choose the specific names of the services, skill groups, peripherals,
trunk groups, etc., that are going to be the subject of the report. This list
is obtained from the ICR central database. It shows the items as they are
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defined in the ICR system. You can scroll down in the list to view
additional items.

You have several options for selecting items from this list:

� To select a single item, click on it.

� To select more items, press the CTRL key and click on the items.

� To select a range of items, click on the first item in the range. Press
SHIFT and click on the last item in the range.

� To select (or deselect) all items in the list, click the Select All
button.

 4.3.4. Templates
The Templates tab contains the predefined real-time and historical
templates and any templates you created with the ICR Custom Screen
Builder. The templates you select here specify the type of report and the
types of data you want to view. For example, if you selected a peripheral
service as a report item, you could select the
“persvc01_queue_delay_status” template to view the call queue status
for that peripheral service.

Click on a template name in the list to select it. If necessary, use the
scroll bar to view additional templates. To select multiple templates
from one list, hold the CTRL key as you click on each template.

If you select a single template, such as a real-time graph, the report will
contain one real-time graph component. If you select multiple
templates, for example, two real-time graphs and a historical grid, the
report will contain all three components.

Reports can have up to ten components. In other words, you can select
up to ten templates to use in a single report. This allows you to mix and
match real-time and historical templates to create a report that displays
exactly the data you want to view.
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The template lists provide the following information about each
template:

� Template name. The name of the template. Each template uses a
naming convention that includes a directory (for example, persvc,
routes, trkgrp), a number, and a brief descriptive title. This is a
GEOTEL naming convention. If you create your own templates using
the ICR Custom Screen Builder, be sure to use a different naming
convention. Otherwise, you may risk overwriting one of the GEOTEL

predefined report templates.

� Description. A description of the purpose of the template, including
the display style (for example, graph, pie chart, or grid) and the
types of data the template displays.

 4.3.5. Launching Templates
To launch the templates, click OK. An untitled report window appears
and the Template Launcher is closed.

Typically, you launch templates after you make your final selections in
the Templates tab. However, you can launch the templates from within
any of the other Template Launcher tabs. For example, if you needed to
go back to change your Item selections, you could click OK from within
the Items tab to launch the templates.

The following example shows the Template Launcher set up for
launching two real-time templates and a historical template:

To close the Template Launcher without launching the templates, click
Cancel.
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4.4.  Working with Reports
When a report first appears on the screen, it is untitled. To keep the
report, you need to save it as a report definition file. This section
describes several common tasks you perform when working with
reports:

� Saving report definitions

� Working with multiple-component reports

� Using shuffle mode

� Printing reports

� Opening reports you have saved

� Displaying reports at startup

� Modifying report definitions

� Deleting report definitions

 4.4.1. Saving Report Definitions
Once you save a report definition, you can open it at any time by using
the File→Open command. Reports are saved as report definition files
with .CMB extensions.

À To save report definitions:

1. Choose File→Save, or click the Save button. The Save Report
Definition dialog box appears:

Notice that the Save Report Definition dialog box defaults to the
appropriate directory for the report. For example, if you create a
report on a peripheral service, the Report Definition dialog box
defaults to the persvc directory. The persvc directory is reserved for
storing only reports on peripheral services. Similarly, other \custom
subdirectories on the AW exist to hold certain types of reports. See
Table 7 for a list of these subdirectories.

2. Type a file name. The .CMB extension is retained.

3. Click OK. The report definition is saved.
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If you have already saved the file, you can choose File→Save As to save
the report definition to a new file with a new name. The File→Save As
option also displays the Save Report Definition dialog box.

 Note: Saved reports do not show up in the Template Launcher list of
templates. You must open report definitions by using the File→Open
command or clicking the Open button.

Table 7:  Default ICR Subdirectories

Subdirectory Report Category

agteam Agent Teams

agtper Agents by Peripheral

agtskg Agents by Skill Group

apgate Application Gateways

caltyp Call Types

entagt Enterprise Agents1

entskg Enterprise Skill Groups

entsvc Enterprise Services

nettrk Network Trunk Groups

peragt Peripheral Agents

periph Peripherals

perskg Peripheral Skill Groups

persvc Peripheral Services

routes Routes

rtecli Routing Clients

schimp Schedules

trkgrp Peripheral Trunk Groups

When you save a report definition, the saved version includes the
following:

� The specific data elements (that is, the specific services, skill
groups, etc.) displayed in the report.

� Relative or absolute dates and times for historical data.

                                                     
1 Not currently implemented.
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� Any thresholds you have defined.

� Any drill-downs you have defined.

� The names of the templates used in the report. The templates
themselves are not saved in the report. However, references to the
templates are saved. Any subsequent modifications to the templates
used by the report are reflected in the report.

The current data values are not stored in the report.

 See also: For information on saving just report data, see “Exporting Report Data,”
later in this chapter.

 4.4.2. Single- and Multiple-Component Reports
Each template you select in the Template Launcher becomes a
component in the report. A report with a single component is
straightforward. You generate a single-component report by using one
template. Therefore, the report definition file references only one
template.

For example, you might generate a report for several peripheral services
using a single Calls Offered template. In this report, you might enter
Last Week as a Relative date option. You could save this report and
display it at any time. Each time you displayed the report, you would be
able to see the number of calls offered over the last week for each
peripheral service. The following report provides an example:

Single-component reports have standard window features and can be
resized, moved, minimized, and maximized.
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You might want to create a more complex report that uses more than one
template. For example, if you launch two real-time templates and a
historical template, the report contains three components. You save the
report definition in the same way you save a single-component report
definition. However, the multiple-component report definition
references three templates instead of one. You can use up to ten
templates to create a single report.

Multiple-component reports are useful in displaying different types of
data in the same report. Real-time components display current data and
historical components display data based on a range of dates and times
that you enter.

The following example shows a report that has four components:

This example is one report, not four different reports. You can
distinguish the difference by looking at the title bars of each component.
A report component displays a template name (for example,
persvc02_calls_status). A report window displays a .CMB title in its title
bar. This report example is shown in Shuffle Mode, which is a display
mode that allows you to move and resize report components on the
screen.

A multiple-component report can be enclosed in one window or
expanded by clicking on the Maximize and Minimize buttons.
Expanding the report removes the window border and report title bar. In
addition, three options in the Window menu place a window around a
multiple-component report:  Tile, Layer, and Cascade. These options are
used in arranging reports on the Monitor ICR screen.
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 See also: For more information on working with more than one report on the
screen, see “Working with Several Reports,” later in this chapter.

Multiple-component reports can be useful in displaying different types
of data in a single report. Note, however, that each component can
display only one type of data (that is, real-time or historical). This is
because a single template can retrieve data from only one source:  the
local database or the central database. A single template cannot retrieve
data from both databases.

A report created with several templates, on the other hand, can display
data from both the local and central databases.

 4.4.3. Shuffle Mode
When you have a report that contains more than one component, you
need a way to move and resize the components within the report
window. Shuffle mode allows you to lay out and resize report
components on the screen. The following example shows how a report
with two components first appears after it is created through the
Template Launcher. When a multiple-component report first appears, it
is automatically displayed in Shuffle Mode.

 Note: Shuffle Mode is not required in a single-component report.

When you lay out report components, it helps to click the Maximize
button so you have more screen area in which to work.
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À To lay out and resize report components:

1. Select Edit→Shuffle Mode.

2. Drag the graph, chart, and text objects and resize them. (Sometimes
a grid style report is too long to display all the data it contains. In
this case, you can use the scroll bar on the right side of the grid
window to view more data.)

3. Click inside the Title box and enter text for a title. (You can also
resize the Title window if necessary.) The title you type has nothing
to do with the report definition file name. You enter a separate file
name when you save the report.

4. When you are satisfied with the appearance of the report, choose
Edit→Shuffle Mode from the Monitor ICR menu to deselect Shuffle
Mode. The following example shows a completed two-component
report:

This is the final presentation mode. Title bars and window frames do
not appear in this mode. To move and resize the components again,
reselect Shuffle Mode.
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 4.4.4. Working with Several Reports
Often, you will have more than one report displayed on the screen. You
can move between reports by clicking on a window to make it active.
The following example shows a Monitor ICR screen with three reports
displayed (one of the reports, fourcmp.cmb, is a multiple-component
report).

You can also use the options of the Window menu to move between
report windows and arrange reports on the screen.

The Windows menu provides the following options for working with
more than one report on the screen:

� Tile Horizontal. Arranges all currently open windows within
Monitor ICR horizontally on the screen. The windows are sized
evenly and fit within the Monitor ICR screen without overlapping.

� Tile Vertical. Arranges all currently open windows within Monitor
ICR vertically on the screen. The windows are sized evenly and fit
within the Monitor ICR screen without overlapping.
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� Layer. Stacks all windows within Monitor ICR on top of each other.

� Cascade. Arranges all windows within Monitor ICR so that they
overlap, but each is still partially visible.

� 1, 2, 3.... Lets you quickly change to a different report window.

The other options of the Window menu are described in the on-line help
system.

 4.4.5. Status Bar
If you click on a bar in a graph style report, a message appears at the
bottom left corner of the Monitor ICR window describing what the bar
represents and its current numerical value. For example:

You can use this feature to get a precise reading of a value in the graph
or to differentiate the bars if you have trouble distinguishing their colors.

 4.4.6. Retrieving Historical Data
Although Monitor ICR automatically updates real-time data while you
are viewing a report, it does not automatically update the historical
half-hour data that is displayed. While a historical report is displayed,
you can click the Retrieve button to update the report with new half-hour
data that has been collected by the ICR.

For example, if you had a historical report displayed on the screen and
you left your desk for an hour or so, you would need to click the
Retrieve button when you returned in order to display the latest
half-hour data. Monitor ICR retrieves the latest half-hour data from the
ICR central database and updates the data displayed in the report.

 4.4.7. Pausing the Screen Refresh
You can pause the real-time refreshing of the Monitor ICR screen. The
Pause button allows you to prevent real-time reports from being
continually refreshed while you are working in Monitor ICR. This
feature is useful in several ways. For example, say you are viewing a
real-time graph and you notice that an unusual number of calls are being
offered to a particular service. You might want to “freeze” the real-time
graph in its current state in order to print it, or you might want to simply
keep the graph displayed the way it is while you further investigate the
condition.
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You might also want to pause screen refreshing while you are working
with the Definition Editor, the Threshold Editor, or the DrillDown
Editor. This ensures that the function you are working with (for
example, the Definition Editor) is not interrupted by the real-time
refreshing of the screen.

To pause the real-time refreshing of the screen, click the Pause button in
the Monitor ICR tool bar. To enable the real-time refreshing of the
screen, click the Resume button.

 See also: For more information on the Threshold Editor and the DrillDown Editor,
see Chapter 4, “Setting Thresholds and Drill-Downs.”

4.5.  Reconnecting to the Central Database
If the Admin Workstation loses its connection to the ICR central
database or the Distributor AW’s local database, a dialog box appears on
the screen to inform you that the connection has been lost. If this
happens, choose File→Reconnect to reestablish the Admin
Workstation’s connection to the ICR central or Distributor AW local
database. At all other times, the Reconnect option is not available.

The Admin Workstation can lose its connection to the central or local
database if there are problems with the network or with the central
controller CallRouter or Logger. The Reconnect option allows you to
quickly connect to the databases without having to restart Monitor ICR.

4.6.  Printer Setup
Before you print reports with Monitor ICR, check to see which printer
you are using. You may want to use a special printer for Monitor ICR
reports such as a high-resolution or color printer.

In addition, you should set up the printer (through Monitor ICR) to use
landscape paper orientation rather than portrait orientation. Although
you can use portrait paper orientation to print reports, reports with
several columns of data may not fit properly on the pages.

When you use landscape printing, Monitor ICR repeats titles and dates
on each page and inserts page breaks where appropriate. Often, several
pages are required to print lengthy, grid-style historical reports.
Graph-style reports typically require only one page; however, you
should still use landscape orientation to print graphs. This ensures that
even wide graphs print properly. In general, landscape paper orientation
provides a more consistent and neater format than portrait orientation.

 Note: Once you make these changes to the printer setup, they are in effect for
every report generated in Monitor ICR (until you change the settings
again).
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À To specify the report printer:

1. Choose File→Printer Setup. The Printer Setup dialog box appears.

2. Click on a printer to use for reports and perform one of the
following steps:

� Click on OK to save the printer settings and close the Printer
Setup dialog box.

� Click the Setup button to specify landscape printing for reports.

À To set up reports for landscape printing:

1. In the Page Setup tab, select the Landscape option:

2. Click OK to save your changes and dismiss the Document Properties
dialog box.

3. Click OK again to close the Printer Setup dialog box.

You can also use the Document Properties window to choose form type,
color, or black and white printing, and number of copies. To get more
information on printing options, click the Help button in the Document
Properties box.
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4.7.  Printing Reports
You can print reports that are displayed on the Monitor ICR screen.
First, display the report and make it the active (current) window. Then
choose File→Print from the Monitor ICR menu or click the Print button
in the toolbar. The report is sent to the printer. A dialog box appears to
inform you that the report is printing.

 Note: Print reports using landscape paper orientation to ensure that all data and
graphic elements fit properly on the pages. See the previous section,
“Printer Setup,” for information on setting up reports for landscape
printing.

You can also print reports that you have not yet saved. For example,
when you create a report, it remains untitled until you save it as a report
definition file. You might have one or more untitled report windows
displayed on the screen. To print an untitled report, make it the active
window and choose File→Print.

 4.7.1. Printing Multiple-Component Reports
When you print a multiple-component report, Monitor ICR selects one
report component at a time and sends it to the printer. You can see the
order in which the components will print by displaying the report and
choosing Edit→Definition to view the report definition. The order of
printing follows the top down order of the templates selected in the
report definition.

To print reports with multiple components, follow the same procedure as
in the previous section, “Printing Reports.” A new printing dialog box
appears for each report component sent to the printer. Monitor ICR runs
through each component in the report until the entire report is printed.

4.8.  Opening Saved Reports
After you have saved a report definition, you can invoke it at any time
by choosing the Open command from the File menu or by clicking on
the Open button.

 Note: You do not launch saved reports through the Template Launcher.
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À To open a report:

1. In the Monitor ICR window, choose File→Open, or click the Open
button. The Select Report Definition dialog box appears.

Only report definition files appear in the Select Report Definition
dialog box. You do not see the templates, although they are also
stored in these directories. (To open templates, use the ICR Custom
Screen Builder.)

2. In the Folders (or Directories) list, double-click the directory where
you saved the report.

By default, reports are saved in subdirectories under icr\aw\custom.
The specific subdirectory depends on the data that is included in the
report. See Table 7, earlier in this chapter, for a list of the custom
subdirectories and their contents.

3. Choose the file name (for example, MYREPORT.CMB) from the
list on the left side of the dialog box.

4. Click OK. The report appears in the Monitor ICR window.

4.9.  File Association
The most common way to open report definition files is to click the
Open button from within Monitor ICR and then choose a report file from
the Select Report Definition dialog box. However, you might want to
quickly open a specific report without having to start Monitor ICR and
go through the menu selections. It might be easier to simply double-click
on a report definition file name from within NT Explorer to start
Monitor ICR and open the report, especially when Monitor ICR is not
yet running.

File association makes it possible to associate a file’s file name
extension with an application. For example, once you associate the
.CMB extension with the Monitor ICR application, you can double-click
any .CMB report file from within Windows NT Explorer to start
Monitor ICR and open the report. Once Monitor ICR is started you can
double-click on other .CMB files to open those reports. Additional
reports are opened in the currently active Monitor ICR application.
Monitor ICR is not started again.
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À To apply file association through NT Explorer:

1. Start the Windows NT Explorer program.

2. Change to the ICR’s \custom directory.

3. Open one of the custom subdirectories (for example, persvc), and
select (highlight) a .CMB report definition.

4. Press SHIFT and click the right mouse button. A pop-up menu
appears.

5. Choose Open With. The Open With dialog box appears with a list of
standard Windows NT executables.

6. Click Other. A secondary Open With dialog box appears, prompting
you to look in a directory for a specific executable to apply.

7. Change to the \icr\bin directory.

8. Within the \icr\bin directory, find “monitor.exe.”

9. Select monitor.exe and click Open. You are returned to the Open
With dialog box.

10. Check the option, “Always use this program to open this type of
file.”

11. Click OK to associate .CMB files with Monitor ICR. You can now
open reports by double-clicking on .CMB file names.

4.10.  Saving Your Workspace
To maintain continuity between Monitor ICR sessions, you might
choose to save your workspace automatically when you exit. This means
that the state of your workspace at the end of the session will be restored
when you next start Monitor ICR.

You can also set up Monitor ICR to always give you the same initial
workspace. For example, you might want to see a certain Calls Offered
pie chart each time you start Monitor ICR. To do this, you set up your
workspace once and save it manually. Monitor ICR displays the same
initial workspace until you change it again.

 Note: Only reports that have been saved can be displayed at startup.

À To automatically save your workspace when you exit:

Choose Option→Save Settings on Exit from the main menu.

À To manually save your workspace:

1. Set up your workspace. For example, you might open one or more
reports and arrange them on the screen.

2. When you are satisfied with the appearance of the screen, choose
Options→Save Settings Now. This saves the current workspace
settings.
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Note: Before you exit from Monitor ICR, make sure that
Options→Save Settings on Exit is deselected. Otherwise, the
settings you have saved will be overwritten by the settings in
place when you exit.

To test the settings, choose File→Exit to end the current Monitor ICR
session. Double-click on the Monitor ICR icon to restart the application.

You can easily change the start-up display if you want to return to
default mode or if you want to display different reports.

À To return to default display at startup:

1. Start Monitor ICR.

2. Use the File→Close command to close any open reports. (You can
also close the template launcher window if it is displayed.)

3. Choose Options→Save Settings Now.

4. Make sure that Options→Save Settings on Exit is deselected.

4.11.  Modifying Report Definitions
You can edit report definitions to choose additional items to include in
the report, to change dates and times, or to select different templates to
use in the report.

The fields of the Definition Editor match those of the Template
Launcher. However, in the Definition Editor you are not allowed to
change the Category or Scope of a report. The Definition Editor is not
used to launch reports, but rather to change existing reports. If you need
to change the Category and Scope of a report, use the Template
Launcher to create a new report.

 Note: If you are modifying a real-time report, you may want to click the Pause
button to pause the real-time refreshing of the screen. This ensures that
the continual refreshing does not interrupt your work with the Definition
Editor.
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À To modify a report definition:

1. With a report displayed, choose Edit→Definition. The Definition
Editor appears.

2. Make the changes you want, such as choosing different Items
(services, skill groups, etc.), or entering different dates and times.

Note: You cannot make changes to the Category and Scope of the
report. If you want to change the Category and Scope of a
report, you should generate a new report through the template
launcher.

3. Click OK to save your changes. The changes take effect
immediately. For example, if you chose another template to include
in the report, that template is launched and appears in the report.

You must save the report in order to preserve the changes you made
to the report definition.

À To save changes in the report definition:

Choose File→Save to save the changes in the same report definition file.
Optionally, you can choose File→Save As to save the report as a new
report definition file. You are required to enter a new file name.

4.12.  Deleting Report Definitions
If you want to delete a report definition, you need to know the report file
name and the directory in which it is stored. By default, reports are
stored in subdirectories under the \custom directory. The specific
subdirectory depends on the data elements included in the report. See
Table 7, earlier in this chapter, for more information on ICR custom
subdirectories.

 Warning: Be sure that you want to delete the report definition file. The DEL
command is irreversible.
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À To delete a report definition:

1. Invoke the DOS Command Prompt from the Windows NT Program
Manager.

2. Change to the directory that contains the report definition. For
example:

cd \icr\customer\aw\custom\persvc

3. Locate the file you want to delete. Report files have the suffix
.CMB. For example, to locate a file named MYREPORT.CMB,
type:

dir MYREPORT.CMB

4. Delete the file by using the DEL command with the file name. For
example, to delete the file MYREPORT.CMB, type:

del MYREPORT.CMB

4.13.  Exporting Report Data
Monitor ICR provides an option that allows you to save just the data that
appears in a report. The Export Data option lets you take data from a
Monitor ICR report and save it for use in another application such as a
spreadsheet or word processing program.

À To export report data:

1. Open a report.

2. Choose File→Export Data. The cursor changes to a cross hair.

3. Click inside the report component that contains the data you want to
save. The Save As dialog box appears:

4. Click on the Save as type field down arrow and choose a file format
from the drop-down menu.

5. Some of these file formats allow you to include column headers in
the export file. Depending on the format you choose, the headings
are saved as either part of the table definition or as an additional row
of data. See Table 8 for descriptions of the file export options.
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6. Enter a file name. (You do not have to enter an extension.) By
default, the file is stored in a custom subdirectory based on the type
of report from which you are exporting data (for example, persvc,
trkgrp, etc.).

7. Click OK to save the data.

 Table 8:  File Format Options

Format Description

CSV Comma-separated values (.CSV). .CSV with headers is also
available.

Dbase2 dBASE-II format (.DBF).

Dbase3 dBASE-III format (.DBF).

DIF Data interchange format (.DIF).

Excel Microsoft Excel format (.XLS). Excel with headers is also
available.

HTML
Table

Hypertext Markup Language (.HTM).

Powersoft
Report

Powersoft report format (.PSR).

SQL Saves a SQL CREATE TABLE statement for the table and an
INSERT INTO statement for each row. The statements are saved
into a text file with the .SQL extension. The simple file name is
used as the table name in the SQL statements.

SYLK Microsoft Multiplan format (.SLK). SYLK with headers is also
available.

Text Text file format (.TXT). Values are tab-separated and each row
ends with a carriage return. Text with headers is also available.

WKS Lotus 1-2-3 format (.WKS). WKS with headers is also available.

WK1 Lotus 1-2-3 format (.WK1). WK1 with headers is also available.

WMF Windows Metafile (.WMF).

4.14.  Setting Workstation Preferences
The Preferences dialog box allows you to set several workstation
preferences related to report background color and the real-time data
refresh rate. The Preferences dialog box also provides information on the
local and central databases and the directory in which the ICR software
is installed.
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À To change workstation preferences:

1. Choose Options→Preferences. The Preferences dialog box appears:

2. Change the workstation preferences using the following guidelines:

Note: These guidelines vary based on the type of AW.

� ICR Directory. Shows the drive and directory where the ICR
software resides.

� ICR Instance AW Directory. Displays the ICR, customer, and
Admin Workstation directories for this AW.

� Refresh Rate. Lets you set the rate in seconds at which the
Admin Workstation is updated with real-time data. This value
also affects the rate at which the Controller Time is updated. For
Standard, Network, and Limited AWs, the default value is 15
seconds; the minimum value you can enter is 10. For monitor-
only AWs, the default value and minimum value is 30 seconds.

� Background Color. Lets you set the background color of
Monitor ICR reports. You can set the red, green, and blue values
to numbers between 1 and 255. Enter the numbers directly or
highlight the values and increment them by using the up and
down arrows. After you change a value, move the cursor to
another field to see the new color in the preview box on the
right.

� Real-Time Feed Failures Before Exit. Lets you set the number
of real-time feed failures that Monitor ICR must detect before it
requests a restart. You can enter any value from 1 to 999 in this
field. The default value is 20. This value is multiplied by the
Refresh Rate. For example:
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20 * 15 = 300 seconds (or five minutes)

In the previous example, Monitor ICR would display an Event
Feed Warning dialog box if it did not receive real-time data for
five minutes. (See “Event Feed Warning,” later in this section
for instructions on what to do if the Event Feed Warning dialog
box appears.)

� Show Event Traffic-Light On Startup. Select this option to
have the Event Monitor displayed each time you start Monitor
ICR.

The Preferences dialog box also provides information on the central
database or Historical Database Server (HDS) and the Distributor AW
database. You cannot modify the information in these fields:

� Computer Name

� Historical/Central Database. The name of the server on which
the ICR Logger and Database Manager reside (for example,
GEOABCLGRA). On some Admin Workstations, this may be
the name of the Historical Database Server (HDS).

� Local Database. The name of the Distributor AW. For
monitor-only AWs, this is the name of the AW that is providing
the host AW database.

� Database Name

� Historical/Central Database. The name of the central database
(either sideA or sideB), depending on which side of the
duplexed ICR system is active. Network AWs (NICR and CICR
AWs)  may have a customer-specific prefix.

� Local Database. The name of the Distributor AW local
database (or host AW database). This name is typically awdb.
However, network AWs may have a customer-specific prefix.

� User Name

� Central Database. The user name used by the ICR. This name
is typically sa.

� Local Database. The logon ID of the Admin Workstation user
(also typically sa).

� Password

� Central Database. The logon password used by the ICR.

� Local Database. The logon password of the Admin
Workstation user.
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 4.14.1. Event Feed Warning
The Event Feed Warning dialog box appears if there is a problem with
data connectivity to either the Central Controller or the real-time
distributor Admin Workstation. Rather than allowing Monitor ICR to
continue running, in which case reports may display inaccurate real-time
data, the workstation displays the following warning message:

À If this warning appears, follow these steps:

1. Click OK in the Event Feed Warning dialog box to exit from
Monitor ICR.

2. After a short time, restart Monitor ICR.

3. In the Monitor ICR main window, check the Controller Time.

An up-to-date Controller Time indicates that the real-time feed is
active and providing real-time data to the Admin Workstation.

 See also: You can set the number of real-time failures that Monitor ICR must
detect before it requests a restart. See the Real-Time Failures Before
Exit option, earlier in this section, for more instructions.

4.15.  User Information
You can display user information by choosing User Information from
the Help menu. The User Information dialog box appears:

Click Close to dismiss the dialog box.

Download from Www.Somanuals.com. All Manuals Search And Download.



106 Reporting Basics

The User Information dialog box provides information for the ICR
central database and the Admin Workstation local database, including:

� Central database server name. The name of the server on which
the ICR Database Server (Logger) and database manager reside (for
example, GEOABCLGRA). On some AWs, this might be the name
of the Historical Database Server (HDS).

� Local database server name. The name of the local Admin
Workstation that is providing the local database. On a monitor-only
AW, this is the name of the workstation that is providing the real-
time host AW database.

� Central database name. The name of the central database (either
sideA or sideB), depending on which side of the duplexed ICR
system is active. NICR and CICR AWs may have a customer-
specific prefix.

� Local database name. The name of the Admin Workstation local
database. This name is typically awdb. NICR and CICR AWs may
have a customer-specific prefix.

� Central database user name. The user name used by the ICR
(typically sa).

� Local database user name. The logon ID of the Admin
Workstation user (typically sa).
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 5. Setting Thresholds and
Drill-Downs

You can set up reports to alert you when certain values exceed or fall
below expected levels. The Threshold Editor allows you to set
thresholds on one or more data attributes in a report. For example,
within a report you might set a threshold value of 70 percent on the
Service Level column. When the service level drops below 70 percent,
that column of the report will turn red.

You can also set up reports to allow you to launch new, related reports
from within the currently displayed report. By using the DrillDown
Editor, you can specify a report template to “drill-down” to, or launch,
from within a report.

This chapter describes how to add thresholds and drill-downs to reports.
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5.1.  Setting Thresholds in Reports
The Threshold Editor lets you set threshold alerts on certain data in a
report. A threshold alert might notify you of call centers where the delay
in queue is approaching an unacceptable level or where all agents are
currently busy. When a threshold is reached or exceeded, a red or yellow
threshold alert is displayed in the report.

In a real-time report, the threshold alert notifies you immediately of an
unacceptable condition. In a historical report, the threshold alert
highlights areas in the report that were out of an expected performance
range over a period of time.

À To set thresholds in a report:

1. Open a report definition (.CMB) file.

2. Choose Edit→Thresholds. Optionally, you can position the cursor
over a report component, hold down the right mouse button, and
choose Thresholds from the pop-up menu:

The mouse pointer changes to a cross hair (+). The report window is
maximized.

3. Click anywhere inside a report component (for example, inside a
graph or a grid). The Threshold Editor dialog box appears:

The Threshold Editor allows you to set thresholds for the data
attributes displayed in the report component (for example, Calls
Offered and Service Level). The Threshold Editor dialog box
displays the following information and options:

� Attribute. This list displays each data attribute in the report
component for which you are setting thresholds.
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� Relation. This option toggles to the >= or <= relations by
clicking on the down-arrows. These relations specify how the
data attribute will be evaluated against the threshold values. In
the Threshold Editor screen example, >= specifies that if the
daily count of Calls Offered equals or exceeds 600, then a
yellow threshold alert will appear in the report. A red threshold
alert will appear if the daily count of Calls Offered equals or
exceeds 700. The <= relation is used to trigger threshold alerts
when a value equals or falls below the threshold value.

� Threshold (yellow). This field is for the first level threshold
value. The value you place in this field will trigger a first level
yellow threshold alert. The first level warning is intended to
inform you that the value for that attribute is approaching an
unacceptable level.

� Threshold (red). This field is for the second level threshold
value. The value you place in this field will trigger the second
level red threshold alert. This alert indicates a more serious
condition.

4. Set thresholds for the data attributes by toggling the relations and
entering threshold values. You can press TAB to move from field to
field.

Note: Service Level thresholds must be entered in decimal format,
(for example, 0.80 to indicate 80 percent, 0.90 to indicate 90
percent).

5. Click Apply to apply the thresholds to the report component. The
thresholds are enabled as soon as you click on Apply.

6. Click Done when you are finished setting thresholds in the report.

The thresholds apply to all the subjects in the report component. For
example, if you had a Queue Delay Status report for three peripheral
services, and you set thresholds on the Average Delay in Queue, those
thresholds would apply to all three peripheral services in the report.

 5.1.1. Setting Thresholds in Multiple-Component Reports
If you want to set thresholds in another component of the report, click
the Next button in the Threshold Editor dialog box. The dialog box
displays the data attributes for the currently selected report component.
You can move through several report components in this manner, setting
thresholds for each as you continue. Similarly, you can return to the
previous report component by clicking on the Previous button.
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 5.1.2. Saving Threshold Settings
You must save the report in order for the threshold settings to be saved
in the report definition. If you close the report without saving it, the
threshold settings will be lost.

À To save the threshold settings:

Choose File→Save in the Monitor ICR window or click on the Save
button. The next time you open the report, the thresholds will be in place
and enabled.

5.2.  Using Drill-Downs in Reports
The DrillDown Editor lets you add another level of detail to a report.
The details are in the form of an additional report template, which you
can launch from within the current report. For example, if you are
viewing a report about an enterprise service, you might want to “drill
down” to see more data from the enterprise service’s component
peripheral services. The DrillDown Editor allows you to get this kind of
detail quickly and easily from within a report window simply by
double-clicking on a data attribute in the report.

You can also save drill-downs as separate reports. Once a drill-down
report is displayed on the screen, it can be saved like other Monitor ICR
reports. In this way, you can create a new report from within the current
report without having to return to the Template Launcher and generate
the report from scratch.

A report that is generated through the DrillDown Editor retains the date
and time options of the report from which it was launched. However, the
drill-down report does not retain the original report’s category and scope
options. If you save the drill-down as a separate report, you can change
the category, scope, and date and time options by using the Definition
Editor.

 5.2.1. Drill-Down Hierarchy
Table 9 summarizes the rules for assigning drill-downs to reports. The
hierarchy specifies which drill-down templates are available from
specific types of Monitor ICR reports. For example, from an enterprise
service real-time report, you can choose drill-downs from a list of
peripheral service real-time templates.
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Table 9:  Drill-Down Hierarchy

Type of Report (or
report component) Drill-Downs available

Base-only skill groups Peripheral skill group templates

Enterprise service Peripheral services templates

Enterprise skill group Peripheral skill group templates

Peripheral service Routes templates

Peripheral Peripheral service templates

Service array Peripheral service templates

If you are adding drill-downs to a historical report, only historical drill
down templates appear in the DrillDown Editor. Similarly, you can add
only real-time drill-downs to real-time reports.

Drill downs are not supported for the other report types.

 5.2.2. Adding Drill-Downs
You can add drill-downs to existing reports, or you can create a report,
add drill-downs, and save the report. In either case, you must save the
report in order for the drill-down assignments to be saved.

À To add drill-downs to a report:

1. Open an existing report or create a new report.

2. With the report displayed on the screen, choose Edit→DrillDown.
Optionally, you can position the cursor over a report component,
hold down the right mouse button, and choose DrillDown from the
pop-up menu:

The report window is maximized and the mouse pointer changes to a
cross hair (+).

3. Click anywhere inside a report component (for example, inside a
graph or grid). The DrillDown Editor dialog box appears:
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The DrillDown Editor dialog box lists the drill-down templates available
for the report component. Monitor ICR has rules that specify which
drill-down templates can be added to report components. Refer to
Table 9, earlier in this section, for a list of the drill-down rules.

The DrillDown Editor dialog box provides the following information:

� Title Bar 1. The first title bar identifies the report component to
which you are adding drill-downs.

� Title Bar 2. The second title bar identifies the types of drill-down
templates available for the report component. For example, an
enterprise service report component would display peripheral
service templates in the DrillDown Editor.

� Template name. The names of the templates available for drill-
down. These are the same template names that appear in the
Template Launcher. The templates that appear in this list depend on
the rules in Table 9.

� Description. Any comments that were entered when the template
was created to describe the purpose of the template.

Applying a Drill-Down Template

Be sure to choose a template from the DrillDown Editor that displays the
specific data you want to view. For example, if the report, or report
component, is a peripheral services Calls Status real-time graph, you
might want to set the drill-down template to be a Call Trend Analysis
graph. This would provide you with additional five-minute, half-hour,
and daily data for the routes associated with the peripheral service.

À To select a drill-down template:

1. With the DrillDown Editor displayed, click on a template in the list.

2. Click Apply to assign the new template to the selected report
component.

3. Click Done. The DrillDown Editor is closed and you are returned to
the report window.

You can apply one drill-down template to each report component. The
drill-downs you assign to a report component are applied to all the
elements in the component. For example, if you apply a drill-down
template to a bar graph that displays data for three peripheral services,
you can invoke a separate instance of that drill-down report for each of
the three peripheral services.

If a drill-down template is already applied to a report component, the
currently applied drill-down template is highlighted when you open the
DrillDown Editor.
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Moving Between Report Components

You can assign drill-downs to other components in the same report by
using the Next and Previous buttons within the DrillDown Editor:

To assign a drill-down to another component in the report, click the Next
button. The DrillDown Editor dialog box is refreshed. The title bar
changes to indicate the currently selected report component and a new
list of drill-down templates appears.

You can move through several report components in this manner,
assigning drill-downs for each as you continue. You can also return to
the previous report component by clicking on the Previous button.

 5.2.3. Saving Drill-Down Assignments
You must save the report in order for the drill-down capabilities to be
saved. If you close the report without saving it, the drill-down
capabilities are lost.

À To save the drill-downs:

Choose File→Save or click the Save button in the toolbar. (For new
reports, you will be prompted to enter a file name.)

 5.2.4. Invoking Drill-Downs
The drill-down assignments are embedded in the report definition file.
This means that each time you open the report, you can invoke
drill-down reports. You can invoke a drill-down for each of the data
elements in a report component. For example, if the report contains data
for three enterprise skill groups, you can invoke a separate drill-down
for each enterprise skill group.
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À To invoke drill-downs:

With the report displayed, perform one of the following steps, depending
on the type of report component:

� In a graph or chart report component, double-click on a data
attribute for a specific entity. In the following example, you could
double-click on any of the bars in the graph to invoke a drill-down
template for the specific peripheral service.

� In a grid style report component, double-click on the name of the
specific service or skill group. In the following example, you could
double-click on one of the peripheral service names.

A drill-down report window appears:

You can double-click on another data attribute or name in the
original report component to invoke another drill-down.
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Choose File→Close to close the active drill-down window.
Optionally, you can save the drill-down window as a separate report.

 5.2.5. Saving Drill-Downs as Separate Reports
Drill-down report windows can be saved just like reports generated
through the template launcher. The drill-down report, after it is saved,
has the same dates and times in its report definition as those defined in
the report from which it was launched. However, the category, scope,
and the template used are different.

Drill-down reports are saved in the appropriate subdirectories of
icr\aw\custom. For example, a peripheral services drill-down report is
saved in the persvc directory. Although it is saved as a separate report,
the drill-down remains set in the original report and can still be launched
from the original report.

À To save the drill-down as a report definition:

1. Invoke the drill-down and make it the active window.

2. Choose File→Save or click the Save button. The Save Report
Definition dialog box appears.

3. Name and save the report just as you would name and save a report
generated with the template launcher.

 See also: For more information on saving report definitions, see “Saving Report
Definitions,” in Chapter 4, “Reporting Basics.”
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 6. Scheduling Reports

As you build a collection of Monitor ICR reports, you might decide that
you’d like to have certain reports printed automatically. The Admin
Workstation has a Job Scheduler tool that allows you to schedule
Monitor ICR reports to print automatically on a regular basis, regardless
of whether Monitor ICR is running.

This chapter describes how to use the ICR Job Scheduler to schedule
reports to print automatically.

Download from Www.Somanuals.com. All Manuals Search And Download.



118 Scheduling Reports

6.1.  ICR Job Scheduler
As a supervisor, your most common use of the ICR Job Scheduler will
be to print reports at specific dates and times. For example, say that you
created a report that uses a relative date to display data. Because you
used a relative date (for example, Today or Yesterday), the report always
displays data for the relative date specified. If the report used the relative
date Yesterday, you might schedule the report to be automatically
printed each morning. You could then have a report of yesterday’s call
center activity automatically printed at the start of each day.

In a similar scenario, you could schedule a report that contains data for
Last Week to print every Monday morning at 10:00 A.M. This would
allow you to review a printed report of data for the previous week
without even starting Monitor ICR. You can use the job scheduler to
schedule jobs on a daily, weekly, or monthly basis. In each case, you can
specify the exact time that the job will run.

The job scheduler works with both historical and real-time reports. As
described in the previous examples, the job scheduler is particularly
useful in printing historical reports that use relative dates. However, you
can also print real-time reports through the job scheduler. Real-time
reports printed in this manner contain a “snapshot” of the current data.

 6.1.1. Job Scheduler Printing Requirements
Monitor ICR does not have to be running in order to print a scheduled
report. However, the AW services, as well as the ICR Print Server
process must be running. The necessary services and processes are
typically always active at the Admin Workstation. In addition, the ICR
Print Server may be started automatically when you log on to the AW.
Print Server startup options can be changed through the ICR Setup tool.

ICR Print Server

If the ICR Print Server is not running, any scheduled print jobs that
execute are saved in a queue. If you subsequently start the Print Server,
any queued jobs will then print.

À To start the Print Server:

Double-click its icon in the GEOTEL Admin Workstation group. You can
also use the Print Server to choose a specific printer on which to print
your scheduled reports.

À To choose a printer and set printing options:

1. Once the Print Server is running, double-click its program icon to
restore the ICR Print Server window.

2. Choose File→Printer Setup. A Printer Setup dialog box appears.

Print
Server
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3. Click on a printer to use for reports.

4. Optionally, you can click on the Setup button to display a Document
Properties dialog box and choose a form type to be used, the paper
orientation, and number of copies. (Click the Help button in the
Document Properties dialog box to find out more about these and
other standard Windows NT printer options.)

 Note: GEOTEL recommends that you use landscape paper orientation to print
Monitor ICR reports. See “Printer Setup” in Chapter 4, “Reporting
Basics,” for more information on landscape printing.

 6.1.2. Scheduling Reports to Print
You can schedule as many reports to print as you like. Before you
schedule print jobs, make sure that you know the correct directory and
report file names. For example, you might schedule a print job for the
QSTAT.CMB report, which is in the Admin Workstation’s
\custom\persvc directory. The ICR Job Scheduler starts its search for the
report in the \custom directory, so you need only know the specific
custom report subdirectory (for example, persvc) and the report name.

À To start the ICR Job Scheduler:

In the GEOTEL Admin Workstation group, double-click the Job
Scheduler icon. The ICR Job Scheduler window appears:

The ICR Job Scheduler displays all jobs that are currently scheduled.
Some of these jobs may be non-ICR jobs; that is, jobs that were initiated
by users and processes other than the ICR Job Scheduler.

Job
Scheduler
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The initial window displays several fields of data:

� Frequency. Specifies the frequency with which the job will be
executed. Possible entries include Every, Next, Today, Tomorrow.
These options are described later in this section.

� Day. Specifies the day or days of the week on which the job will
run. This field can also contain a number, which represents a day of
the month.

� Time. Indicates the time, in A.M. or P.M., at which the job will run.
All times are based on the Admin Workstation clock.

� Command. Provides the name of the command that will be
executed:

� PrintRpt. Prints a specified Monitor ICR report.

Other commands might also appear in the Job Scheduler, such as
jobs that were scheduled through the DOS Command Prompt by
using the “AT” command.

� Parameters. Shows the parameters to be passed to the command.
The parameters for a PrintRpt command are the directory and the
report name.

� Status. Indicates whether the job encountered problems while
executing. Possible values are OK and Error. Typically, you will not
see “Error” in this field for the PrintRpt command unless the
printrpt.exe command was not found. The printrpt.exe command is
in the Admin Workstation’s \bin directory. Other problems such as
invalid report names or invalid time and date specifications are
recorded in the ICRPRINT.LOG file.

� Log. Indicates whether information about the job is written to a log
file. You can open the ICRPRINT.LOG file within the ICR Job
Scheduler to see how jobs executed. In the event that a report fails to
print, entries in the ICRPRINT.LOG file will point to the cause of
the failure.
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À To set up the print job details:

1. In the ICR Job Scheduler window, click the New button. The Job
Details dialog box appears.

2. Enter information in this window using the following guidelines:

� Time. Enter the time that you want the job to print. Highlight the
hours and the minutes and use the up and down arrows to increment
the numbers. The time is based on a 24-hour clock. For example,
15:00 is 3:00 P.M.; 8:00 is 8:00 A.M.

� Occurs. Choose how often you want the report to print:

� Every. Executes the print job on the days indicated in the Day/Date
field. After the job executes, leave the job schedule unchanged so
that the job executes again each time the day or date occurs again.

� Next. Executes the print job once for each day indicated in the
Day/Date field. After the job executes, remove the current day or
date from the job schedule. When no more values remain for
Day/Date, remove the job from the schedule.

� Today/Tomorrow. Executes the job the next time the indicated
Time occurs (which is either later today or tomorrow). If you choose
Today/Tomorrow, the Day/Date field is ignored.

� Day/Date. Scroll through the list and choose the days (Monday
through Sunday) and dates (1 through 31) on which you want the
report to print. You can single-click on one or more items to select
and deselect them. The Day/Date option is not available when you
choose Today/Tomorrow.

� Command. Select PrintRpt.

� Parameters. Enter the directory and the report definition file name.
For example:

persvc\qstat.cmb

You can also enter a string of multiple reports to print:

persvc\qstat.cmb routes\calls.cmb perskg\trkstat.cmb
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You must enter the directory name and the file name for each report.
Also, for multiple entries, be sure to include spaces between each
directory\filename combination.

� Log. The Log check box is disabled for the PrintRpt command. All
print jobs submit log entries to the ICRPRINT.LOG file. The print
job log entries chronicle the progress of each print job executed by
the job scheduler. The ICRPRINT.LOG file is described later in this
section.

The following example shows a Job Details dialog box set up to
print a report every Monday at 8:00 A.M.

À To submit a print job schedule:

1. Click the Apply button. You are returned to the ICR Job Scheduler
window. The new entry appears in the window.

2.  (Optional.) At this point, if you decide that you do not want to
submit the print job, you can click Reset to return the ICR Job
Scheduler settings to their original state (that is, to the settings in
place when you opened the job scheduler).

3. Important. Click the Apply button in the ICR Job Scheduler
window. This submits the job in the ICR Job Scheduler.

Notice that the value in the Time field changes from 24-hour format
to A.M. or P.M. You can use this as an indicator that the job has
been successfully submitted.

The print job will execute on the specified date and time.

 6.1.3. Changing Scheduled Jobs
You can change a scheduled job at any time. For example, you might
want to print a different report, or change the frequency with which a
report is printed. You can use the Job Scheduler to change only PrintRpt
jobs. You cannot change jobs that were scheduled through the DOS AT
command.
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À To change a scheduled job:

1. In the ICR Job Scheduler window, select a job from the list of
scheduled jobs.

2. Click the Change button. The Job Details dialog box appears.

3. Change the fields as described in “Scheduling Reports to Print,”
earlier in this chapter.

4. When you are satisfied with the new job details, click Apply.

5.  (Optional.) To reset the ICR Job Scheduler settings to their original
state, click the Reset button.

6. In the ICR Job Scheduler window, click Apply to submit the
changes to the ICR Job Scheduler. The value in the Time field
changes from 24-hour format to A.M. or P.M. You can use this as an
indicator that the job has been successfully changed and submitted.

 6.1.4. Deleting Scheduled Jobs
When you no longer need to have a particular report scheduled to print,
you can remove it from the job scheduler. Print jobs scheduled using the
“Next” and “Today/Tomorrow” options are automatically deleted from
the scheduler after they have executed.

À To delete a job:

1. In the ICR Job Scheduler window, select a job from the list of
scheduled jobs.

2. Click the Delete button. A dialog box appears to check if you are
sure you want to delete the job.

3. Click OK to delete the job. The scheduled job is removed from the
list.

4.  (Optional.) If you unintentionally delete a job, click Reset. The ICR
Job Scheduler settings will return to their original state.

 6.1.5. Inspecting the Job Scheduler Log
The ICR Job Scheduler allows you to view log files for the different
types of jobs that are scheduled. The log files contain information on
how a job executed, which database connections were made, and
whether a print job has finished printing. You can use this data as a
diagnostic tool in case you have a problem printing a report.

Download from Www.Somanuals.com. All Manuals Search And Download.



124 Scheduling Reports

À To inspect a log file:

1. In the ICR Job Scheduler window, click the Inspect Log button.
A Select Log dialog box appears:

2. Select the ICRPRINT.LOG file from the list of log files and click on
OK. A standard Windows NT Notepad window appears to display
the log file.

The following example shows a sample ICRPRINT.LOG file. The
latest print job to be executed is logged at the bottom of the window.

3. Use the scroll bars to scroll through the log file.

4. Choose File→Exit to close the Notepad window.

 6.1.6. Closing the ICR Job Scheduler
To close the ICR Job Scheduler, click the Cancel button.
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 7. Available Data

The Intelligent CallRouter databases collect historical and real-time data
about agent activity and the calls being routed in the call center
enterprise. Within Monitor ICR, you can display data for agents, skill
groups, services, trunk groups, routes, and peripherals. You can also
display data for application gateways, call types, routing clients, and
workforce schedules.

The ICR can provide data for peripheral skill groups and services or it
can combine data to provide an enterprise view of agent and call
activity. Data from individual peripheral services can be combined to
produce data for an enterprise service. Similarly, data from several
peripheral skill groups can be combined to produce data for an enterprise
skill group.

This chapter provides an introduction to the most commonly used
real-time and historical ICR database tables.

 See also: For more detailed information on the data gathered by the ICR, see the
Intelligent CallRouter Database Schema Handbook. The on-line Schema
Help also provides data definitions and reference information on the ICR
database tables.
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7.1.  Skill Group Data
The ICR tracks information  about the skill groups at each peripheral. A
skill group is a collection of agents who share a common set of skills
and therefore can handle similar types of calls. A peripheral skill group
is a skill group that is associated with a specific peripheral (ACD). For
example, a single peripheral might have one skill group defined for
agents who can handle sales calls, and another skill group defined for
agents who can speak Spanish.

Peripheral skill group data are stored in the Skill_Group_Real_Time and
Skill_Group_Half_Hour tables. To arrive at daily values, the ICR sums
the Skill_Group_Half_Hour rows for each day.

 7.1.1. Skill Group Agent Data
The ICR tracks data for the agents in a skill group. Some examples of
Skill Group agent data tracked in the Skill Group tables include:

� Agents idle. The number of agents who are in the Not Ready state
(that is, logged on, not involved in a call or after-call work, and not
available to receive a call).

� Agents available. The number of agents who are in the Available
state (that is, not occupied with any call activity and ready to accept
calls).

� Agents ready. The number of agents who are logged on and are
either talking on a call or performing after-call work, but are
presumed to be ready to accept calls when done.

� Agents talking in. The number of agents talking on inbound calls.

� Agents talking out. The number of agents talking on outbound
calls.

� Agents talking other. The number of agents who are talking on
calls other than inbound and outbound calls (for example, internal
calls).

� Agents in wrap-up. The number of agents who are involved in
after-call work. After-call work includes activities such as
completing paperwork or consultation work. An agent performing
after-call work is in either the Work Ready or Work Not Ready
state.

� Agents in hold. The number of agents in the skill group who are in
the Hold state (that is, agents who have all active calls on hold and
are performing no other activity).
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� Agents reserved. The number of agents currently in the reserved
state. A reserved agent is awaiting an interflowed call and is
unavailable to receive any incoming calls. This state applies to
agents on Northern Telecom Meridian and Aspect CallCenter ACDs
only.

� Agents in busy other. The number of agents who are in the Busy
Other state (that is, busy in skill groups other than the one presently
being examined). An agent can be active in only one skill group at a
time. Therefore, while active in one skill group, the agent is
considered by the other skill groups to be in the Busy Other state.

In addition to the numbers of agents in certain states within the skill
group, the ICR tracks the time that a skill group’s agents spend in these
states.

 See also: The section “Agent State and Time Allocations,” later in this chapter,
provides more information on the types of agent state and time
allocation data tracked for skill groups.

 7.1.2. Percent Utilization
The ICR reports a percent utilization for each skill group. The percent
utilization data are taken from the Skill_Group_Real_Time table, which
contains agent time allocation data such as Handle Time, Logged On
Time, and Not Ready Time data for all agents in the skill group.

The percent utilization is computed by dividing the total time agents
spent handling calls by the total time agents were ready to handle calls.
The percent utilization is expressed as a percentage value for the
individual skill group. The formula used is as follows:

(TalkTime + WorkReadyTime + WorkNotReadyTime) /
(LoggedOnTime - NotReadyTime)

Percent utilization is measured since the end of the last five-minute or
the last half-hour interval. Consequently, percent utilization data are
stored in the skill group five-minute and half-hour tables.

 7.1.3. Call Handling
The ICR tracks categories of data related to the calls handled by each
skill group. A call is counted as handled when it is finished:

� Calls handled. The number of offered calls handled by the skill
group during an interval. A call is counted as handled when the call
is finished.

� Number of agent out calls. The number of outbound calls made by
the skill group’s agents.
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7.2.  Agent Data
With GEOTEL•Agent Reporting enabled, the ICR tracks data for the
agents within the call center enterprise. An agent is anyone who can
answer incoming phone calls. In a more precise way, a peripheral agent
is an agent who is associated with a particular peripheral (ACD, PBX) in
the call center enterprise. A peripheral agent can be a member of one or
more skill groups. (Some peripheral types limit each agent to one skill
group assignment.)

Optionally, peripheral agents can be grouped into agent teams. Agent
teams are groups of peripheral agents configured on the same peripheral.

The ICR allows you to report on three general categories of agent-level
data:  agent status, agent activity, and agent performance. You have
several options for defining the scope of agent-level reports:

� Peripheral agents. Report on selected agents from throughout the
enterprise regardless of peripheral, skill group, and agent team
assignments.

� Agent by peripheral. Report on the agents logged on to one or
more selected peripherals.

� Agent by skill group. Report on the agents logged on to one or
more specific skill groups.

� Agent team. Report on the agents within one or more agent teams.

 7.2.1. Agent Tables
Real-time agent data are stored in the Agent_Real_Time and
Agent_Skill_Group_Real_Time tables of the Distributor AW local
database. Historical agent data are stored in the following tables of the
ICR central database:

� Agent_Half_Hour

� Agent_Skill_Group_Half_Hour

� Agent_Logout

� Agent_State_Trace

Agent state reports also use data from the Termination_Call_Detail
table.
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 7.2.2. Agent Status
The ICR tracks agent status by position, skill group, and by agent name.
Specifically, the ICR records the following data on agent status in ICR
real-time and half-hour tables:

� Position. The current extension on which the agent is working.

� Agent name. The first and last name of the agent.

� Skill group. The name of the skill group to which the agent is
logged on.

� Logon date/time. The date and time that the agent logged on.

� Current state. The current state of the agent:  logged off, logged on,
ready, not ready, work ready, work not ready, talking, busy other,
reserved, calls on hold, unknown.

� Direction. The direction of the call:  inbound or outbound.

� Destination. The type of outbound call:  ACD or direct.

� Last state change. The date and time that the agent’s state last
changed.

� Reason. The reason for the agent’s last state change.

� Logon duration. The time that the agent spent logged on.

� Logout date/time. The date and time that the agent logged out.

� Event name. The event caused by the agent’s last state change.

� Call duration. Duration of the call in seconds for a private network
call. This is the time that the switch is processing the call.

� ANI. The ANI value for the call. The ANI provides the billing
phone number of the phone from which the call originated. (These
data are taken from the Termination_Call_Detail table.)

� Digits dialed. The digits dialed on an outbound call. (These data are
taken from the Termination_Call_Detail table.)

 7.2.3. Agent Activity
The ICR tracks agent activity. To arrive at daily values for agent
activity, the ICR sums the Agent_Skill_Group_Half_Hour rows for each
day.

� Agent name. The first and last name of the agent.

� Duration. The total time in seconds that the agent was logged on
during the interval.
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� Incoming calls total. The total number of inbound ACD calls
handled by the agent during the interval. This value is incremented
when the after-call work associated with the call is completed.

� Incoming calls avg. length. The average length in seconds for
incoming calls handled by the agent during the interval.

� Incoming calls percent. The percentage of all calls handled by the
agent for the period that were incoming calls.

� Outgoing calls total. The total number of completed outbound ACD
calls made by the agent during the interval. The value is incremented
when the after-call work associated with the call is completed.

� Outgoing calls average length. The average length in seconds for
outgoing calls made by the agent for the interval.

� Outgoing calls percent. The percentage of all calls handled by the
agent for the period that were outgoing calls.

� Internal calls total. The total number of internal calls initiated by
the agent during the interval. The value is incremented when the
after-call work associated with the call is completed.

� Internal calls average length. The average length in seconds for
completed internal calls made by the agent for the interval.

� Internal calls percent. The percentage of all calls handled by the
agent for the period that were internal calls.

� Callback message total. The total number of callback messages that
were processed by the agent during the interval.

� Callback message average length. The average length in seconds
for callback messages processed by the agent during the interval.

� Callback message percent. The percentage of all calls handled by
the agent for the period that were callback messages.

� % Wrapup. The percentage of time that the agent spent in wrap-up
on all calls counted as handled during the interval. An agent
performing wrap-up is either in the Work Ready or Work Not Ready
state. This value is measured against the total time the agent was
logged on during the interval.

 7.2.4. Agent Performance
The ICR tracks agent performance. To arrive at daily values, the ICR
sums the Agent_Skill_Group_Half_Hour rows for each day.

� Agent name. The first and last name of the agent.

� Abandoned calls ring. The total number of ACD calls abandoned
while ringing at an agent’s position. The value is incremented at the
time the call disconnects.

Download from Www.Somanuals.com. All Manuals Search And Download.



Agent Data 131

7. A
vailable D

ata

� Abandoned calls hold. The total number of ACD calls that were
abandoned while being held at an agent’s position. The value is
incremented at the time the call disconnects.

� Abandoned calls average. The average ring time in seconds
associated with ACD calls that were abandoned while ringing an
agent’s position.

� Abandoned calls percent. The percentage of ring time associated
with ACD calls that were abandoned while ringing at an agent’s
position. This value is measured against the total time the agent was
logged on during the interval.

� Hold calls in. The total number of completed inbound calls the
agent placed on hold. The value is incremented when the after-call
work associated with the call is completed.

� Hold calls in average. The average on hold time in seconds
associated with inbound calls the agent placed on hold.

� Hold calls in percent. The percentage of hold time associated with
inbound calls the agent placed on hold. This value is measured
against the total time the agent was logged on during the interval.

� Hold calls out. The total number of completed outbound calls the
agent placed on hold at least once. The value is incremented when
the after-call work associated with the call is completed.

� Hold calls out average. The average on hold time in seconds
associated with outbound calls the agent placed on hold.

� Hold calls out percent. The percentage of hold time associated with
outbound calls the agent placed on hold. This value is measured
against the total time the agent was logged on during the interval.

� Hold calls internal. The total number of completed internal calls
the agent placed on hold for the interval. The value is incremented
when the after-call work associated with the call is completed.

� Hold calls internal average. The average on hold time associated
with internal calls the agent placed on hold.

� Hold calls internal percent. The percentage of hold time associated
with internal calls the agent placed on hold. This value is measured
against the total time the agent was logged on during the interval.

� Assistance calls total. The total number of calls for which the agent
received supervisor assistance during the interval. The value is
incremented when the supervisor assistance call completes.

� Assistance calls average. The average time in seconds that the
agent received assistance for all supervisor-assisted calls during the
interval.
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� Assistance calls percent. The percentage of time that the agent
spent during the interval on supervisor-assisted calls. This value is
measured against the total time the agent was logged on during the
interval.

� Conference calls in. The number of incoming calls on which the
agent was in conference. Incoming calls include ACD and non-ACD
calls. The value is incremented with the agent drops off the call and
the call becomes a simple two-party call.

� Conference calls average. The average time in seconds that the
agent spent in conference with calls during the interval. This value
includes hold time associated with the conference calls.

� Conference calls percent. The percentage of time that the agent
spent during the interval on conference calls. The percentage
includes hold time associated with the conference calls. This value is
measured against the total time the agent was logged on during the
interval.

� Conference calls out. The number conference calls the agent
initiated. Initiated calls include ACD and non-ACD calls. The value
is incremented with the agent drops off the call and the call becomes
a simple two-party call.

� Conference calls out average. The average time in seconds that the
agent spent in conference on agent-initiated calls during the interval.
This value includes hold time associated with the conference calls.

� Conference calls out percent. The percentage of time that the agent
spent during the half-hour interval on agent-initiated conference
calls. This percentage includes hold time associated with the
conference calls. This value is measured against the total time the
agent was logged on during the interval.

7.3.  Agent States and Time Allocations
The ICR tracks agent states and the time spent in these states in both
Agent and Skill Group tables. The Agent_Skill_Group tables provide
data on an agent-by-agent basis for the agents in a skill group. The
Skill_Group tables provide data for the agents as a group.

To display individual agent state and time allocation statistics, use the
Agent-Level report templates. To display group agent state and time
allocation statistics, use the Skill Group report templates.

 See also: See Chapter 8, “Template Reference,” for details on the data displayed
in Agent and Skill Group reports.
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The following ICR database tables store agent state and time allocation
data:

� Agent_Skill_Group_Real_Time. Stores real-time data on the
current state of each agent in a skill group. For example, the
AgentState field provides the current state of the agent:  Logged Off,
Logged On, Ready, Not Ready, Work Not Ready, Work Ready,
Talking In, Talking Out, Talking Other, Conference.

� Agent_Skill_Group_Half_Hour. Stores historical data on the time
agents spent in any of the call handling states. For example, the
TalkInTimeToHalf field records the number of seconds that each
agent in the skill group spent talking on inbound ACD calls during
the half-hour interval (that is, the time the agent spent in the Talking
In state). This table also provides other data such as
AbandonHoldCallsToHalf, which details the number of ACD calls
that were abandoned while being held at an agent’s position.

� Skill_Group_Real_Time. Tracks the number of agents for a skill
group currently in any of several call handling states. For example,
BusyOther provides the number of agents for the skill group who are
currently busy on calls assigned to other skill groups. This table also
provides current agent time allocations for the skill group as a
whole. For example, NotReadyTimeTo5 records the total seconds
that agents in the skill group have been in the Not Ready state for
the current five-minute interval.

� Skill_Group_Five_Minute. Tracks the number of agents for the
skill group and their call handling states at the end of each five-
minute interval. For example, TalkingIn provides the number of
agents in the skill group talking on inbound calls at the end of the
five-minute interval. The Skill_Group_Five_Minute table also tracks
time allocations for the current five-minute interval. For example,
WorkNotReadyTimeTo5 provides the number of seconds agents in
the skill group were in the Work Not Ready state for the five-minute
interval.

� Skill_Group_Half_Hour. Stores historical data on the time agents
for the skill group spent in any of several call handling states. For
example, TalkingInTimeToHalf provides the number of seconds
agents in the skill group spent talking on inbound calls during the
half-hour interval. This table also provides other call counts such as
InternalCallsToHalf, which is the number of internal calls to the
skill group during the half-hour interval.

 See also: For more information on these tables, see the ICR Database Schema
Handbook or the on-line Schema Help.
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 7.3.1. ICR Agent State Terminology
The ICR tracks the following agent states. Tables 11-13, later in this
chapter, maps the ICR agent state terms to the terms used by the
peripheral vendors.

� Logged on. The number of agents who are logged on (that is, agents
who are known to the system, but may or may not be ready to
receive calls).

� Ready. The number of agents who are in the Ready state (that is,
logged on and either available to handle a call, currently talking on a
call, or involved in after-call work and presumed to be available
when done).

� Not ready. The number of agents who are in the Not Ready state
(that is, logged on, not involved in any call handling activity, but not
ready to accept calls).

� Available. The number of agents who are in the Available state (that
is, not occupied with any call activity and ready to accept calls).

� Talking in. The number of agents who are talking on inbound calls.

� Talking out. The number of agents who are talking on outbound
calls.

� Talking other. The number of agents who are talking on internal
calls (neither inbound nor outbound).

� Work ready. The number of agents who are in the Work Ready
state (that is, agents who are performing after-call work, but are
presumed to be ready to accept calls when done).

� Busy other. The number of agents who are busy working in other
skill groups (that is, in skill groups other than the one presently
being examined). For example, an agent might be talking on an
inbound call in one skill group while simultaneously logged on to
and ready to accept calls from other skill groups. The agent can be
active (talking on or handling calls) in only one skill group at a time.
Therefore, while active in one skill group, the agent is considered by
the other skill groups to be in the Busy Other state.

� Work not ready. The number of agents who are in the Work Not
Ready state (that is, agents who are involved in after-call work and
are presumed not to be ready to accept incoming calls when done).

� Reserved. The number of agents who are awaiting an interflowed or
interqueued call and are unavailable to receive any incoming calls.
This state applies to agents on Northern Meridian and Aspect
CallCenter ACDs.

� Hold. The number of agents who have all active calls on hold.
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The ICR tracks the number of agents in each state along with the time
agents spend in specific states. Table 10 shows how agent activity and
time spent in particular states are tracked by the ICR.

Table 10:  Agent States and Time Allocations

Log On
State

Ready
State Agent Time Allocation Specific State

Handle
Time

Logged
On

Ready Available Time Available

Reserved Time Reserved

Busy Other Time Busy Other

Talking Other
Time

Talking Other

Talk
Time1

Talking Out
Time

Talking Out

Talking In
Time

Talking In Handle Time

Hold Time Hold

Work Ready Time Work Ready

Work Not
Ready

Work Not Ready Time Work Not Ready

Not Ready
(Idle)

Not Ready Time Not Ready

Logged
Off

The ICR tracks the number of agents in each state in Skill Group
real-time database records. To obtain historical counts of the number of
agents in particular states, the ICR saves a snapshot of the real-time data
and stores the data in skill group five-minute records. These five-minute
summary records are stored in the ICR central database.

                                                     
1 Talk Time is the sum of Talking In Time, Talking Out Time, and Talking

Other Time.
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The ICR also tracks the total amount of time agents in a skill group
spend in specific states. For each specific state, time is recorded to track
how long agents are in the particular state. In addition, time spent in
certain states is tracked more generally in time allocation categories such
as Talk Time and Handle Time.

The following list further explains the agent time allocations shown in
Table 10.

� Available Time. The time agents spend in the Logged On, Ready,
and Available states.

� Reserved Time. The time agents spend in the Reserved state.

� Busy Other Time. The time agents spend in the Busy Other state.

� Talk Time. The time agents spend in the Talking In, Talking Out,
and Talking Other states.

� Talking Other Time. The time agents spend in the Talking Other
state. (Also counted in the general category of Talk Time.)

� Talking Out Time. The time agents spend in the Talking Out state.
(Also counted in the general category of Talk Time.)

� Talking In Time. The time agents spend in the Talking In state.
(Also counted in the general categories of Talk Time and Handle
Time.)

� Hold Time. The time agents spend in the Hold state. (Also rolled
into the general category of Handle Time.)

� Work Ready Time. The time agents spend in the Work Ready state.
(Also rolled into the general category of Handle Time.)

� Work Not Ready Time. The time agents spend in the Work Not
Ready state. (Also rolled into the general category of Handle Time.)

� Not Ready Time. The time agents spend in the Not Ready state.

� Handle Time. The time agents spend in the Talking In, Hold, Work
Ready, and Work Not Ready states. Handle time does not include
the time agents spend in the Talking Out or Talking Other states.

� Logged On Time. The time that an agent was Logged On.

 Note: Not Ready Time and Logged On Time are not explicitly displayed in
Monitor ICR reports. However, they are used in calculating other data
such as Percent Utilization of agents. See “Percent Utilization,” later in
this section, for an example of how Not Ready time and Logged On
Time are used to calculate overall agent utilization.
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 7.3.2. ICR Agent State Mapping To Peripherals
The ICR uses certain terms to describe the work states that agents move
in and out of while handling customer calls. Peripheral vendors use
slightly different terms to describe these same states.

Table 11 shows the ICR agent state terms and how they correspond to
the terms used by Aspect, Lucent, and Nortel.

 Table 11:  Agent State Terminology—Aspect, Lucent, and Nortel

GEOTEL
ICR

Aspect
CallCenter Lucent DEFINITY ECS Nortel Meridian

Logged On Signed On Logged_In1 Manned

Logged Off2 Signed Off Logged_Out1 Spare

Ready Ready All other states other than
AUX and UNKNOWN

Manned, but not in Walkaway3

Not Ready Idle AUX, UNKNOWN Walkaway

Available Avail AVAIL Wait
DNOHOLD
<ACD Ready>4

<ACD Ready>4

Talking In Talking ACD1
Talking ACD2
Talking ACT1
Talking ACT2

ACD-IN
DACD

ACD
ACD/DNOH
ACD/DNIH
ACDHOLD
ACDH/DNIH5

ACDH/DNOH5

Talking Out Talking Out1
Talking Out2

ACD-OUT N.A.

(continued)

                                                     
1 Logged_In and Logged Out are not CMS agent states.
2 Logged Off is not an agent state, but rather a necessary condition for being in

any state.
3 Agents who are in Walkaway with a call on hold are counted as Ready.
4 These states occur only if ACAA is set for the ACD DN in LD 23. (ACAA

allows new ACD calls to an agent who has an Individual DN (IDN) call on
hold).

5 Agents in these states are counted as Talking In if the ACD line was the last
line active.
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GEOTEL
ICR

Aspect
CallCenter Lucent DEFINITY ECS Nortel Meridian

Talking
Other

Talking Inside
Supervisor Line
MSG1

HELP1

AUX IN/OUT
ACW IN/OUT

DN IN
DNOUT
DNOHOLD
DNIHOLD
ACDH/DNO
ACDH/DNI
NRDY/DNO
NRDY/DNI
NRDY/DNOH
NRDY/DNIH
ACDH/DNOH2

ACDH/DNIH2

Work Ready Wrap-up ACW
DACW

Not Ready

Work Not
Ready

N.A. N.A. N.A.

Busy Other MSG3 OTHER Not Avail

Reserved RSVD N.A. RESERVE

Hold HOLD N.A. N.A.

                                                     
1 On ACDs using the Aspect Event Link, these additional states map to Talking

Other.
2 Agents in these states are counted as Talking Other if the DN line was the last

line active.
3 On ACDs that are not using the Aspect Event Link, the MSG state maps to

Busy Other.
Download from Www.Somanuals.com. All Manuals Search And Download.



Agent States and Time Allocations 139

7. A
vailable D

ata

Table 12 shows the ICR agent state terms and how they correspond to
the terms used by Rockwell and Siemens.

Table 12: Agent State Terminology—Rockwell and Siemens

GEOTEL
ICR

Rockwell
Galaxy

Rockwell
Spectrum

Siemens
HICOM 300E

Siemens Rolm
9751 CBX

Logged On Plugged N.A. Logged On Unavailable
Available
ACD In
Non-ACD Inc
Non-ACD Out
Non-ACD Int

Logged Off1 Unplugged Signed Off Logged Off Logged Off

Ready (Pugged In-Break) Any state in
which the
available console
lamp is lit.

Logged On Available

Not Ready Break Any state in
which the
available console
lamp is not lit.

Unavailable Unavailable

Available Available Available Available Available

Talking In Calls currently in
progress.

Busy with
inbound call on
ACD Line 1.

ACD Incoming ACD Incoming

Talking Out Out-Call Busy with
inbound call on
ACD Line 1.

Non-ACD
Outgoing

Non-ACD
Outgoing

Talking
Other

N.A. Busy on position
call or supervisor
assist.

Non-ACD
Incoming, Non-
ACD Internal

Non-ACD
Incoming, Non-
ACD Internal

Work Ready Call work.
Overflow call
work.

Call work and
available console
lamp lit.

Work Available/Work

(continued)

                                                     
1 Logged Off is not an agent state, but rather a necessary condition for being in

any state.
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GEOTEL
ICR

Rockwell
Galaxy

Rockwell
Spectrum

Siemens
HICOM 300E

Siemens Rolm
9751 CBX

Work Not
Ready

N.A. Call work and
available console
lamp not lit.

N.A. Unavailable/Work

Busy Oher Overflow calls
currently in
progress.
Overflow call
work.

Busy on either
an internal call
or a call for an
agent group
other than the
agent’s primary
group.

Other Other

Reserved N.A. N.A. N.A. N.A.

Hold N.A. N.A. N.A. N.A.

Table 13 shows the ICR agent state terms and how they correspond to
the terms used by Alcatel, NEC, and Ericsson.

Table 13:  Agent State Terminology—Alcatel, NEC, and Ericsson

GEOTEL
ICR Alcatel 4400 NEC NEAX 2400 Ericsson ACP100

Logged On Agent Logged On Logon Agent logged on, jacked-in

Logged Off1 Agent Logged Off Logged Off Agent logged off, jacked-out

Ready Agent Ready Logged on minus not
ready

Idle, agent ready

Not Ready Agent Not Ready Break Agent not ready

Available Idle Ready Idle

Talking In Agent Busy ACD incoming Q_CONN

Talking Out Agent Busy Non-ACD outgoing Q_OUTDIAL, A_OUTDIAL

Talking
Other

Agent Busy Non-ACD incoming,
Non-ACD internal

A_CONN, Q_CONN

(continued)

                                                     
1 Logged Off is not an agent state, but rather a necessary condition for being in

any state.
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GEOTEL
ICR Alcatel 4400 NEC NEAX 2400 Ericsson ACP100

Work Ready Agent Working
After Call/Wrap-
up

Work Agent not ready

Work Not
Ready

Agent Work Not
Ready

N.A. N.A.

Busy Other N.A. Supported (no NEC
term)

Other

Reserved N.A. Alerting N.A.

Hold Busy All on hold N.A.

7.4.  Service Data
The Intelligent CallRouter tracks data for each peripheral service in the
call center enterprise. A service is a particular type of call processing the
caller requires. For example, in a retail sales company’s call center, a
caller might have a question about an account balance. This caller might
be directed to the Customer Accounts service.

A peripheral service is a service that is tied to a specific peripheral
(ACD) in the call center enterprise. A single peripheral might have
several services defined such as Sales, Technical Support, and Customer
Accounts.

 See also: Chapter 1, “Overview” provides some examples of enterprise and
peripheral services.

Peripheral service data are stored in the Service_Real_Time and
Service_Half_Hour tables. To arrive at daily values, the ICR sums the
Service_Half_Hour rows for each day.

 7.4.1. Call Counts
The ICR tracks calls routed to and handled by each peripheral service.
Specifically, the ICR records the following data on call counts, both in
real-time and for each half-hour interval:

� Calls in progress. The total number of calls in progress at the
peripheral.

� Calls routed. The total number of calls routed to the service by the
ICR during an interval.

� Calls incoming. The total number of calls coming in to the service
from an external carrier. This includes handled, abandoned, and
currently queued calls.
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� Calls offered. The total number of calls offered to the service during
an interval. This includes both incoming and internal calls.

� Calls answered. The number of calls to the service that were
answered during an interval. A call is counted as answered when it
reaches an agent or VRU.

� Calls handled. The number of calls answered and finished for the
service during an interval.

� Outgoing calls. The total number of outgoing calls made by agents
during an interval.

� Calls held. The number of calls to the service currently queued for
longer than the service level threshold.

In handling call counts, typically you do not want to count a call as
abandoned in queue if the caller hangs up very quickly. Often in these
cases, callers hang up for reasons other than excessive queue times.
When configuring the peripheral, the System Manager can specify the
minimum amount of time a call must be in queue before it can be
considered an abandoned call. This is called the abandoned call wait
time. These “short calls” are subtracted from the count of calls offered.

 See also: For more information on configuring peripherals for abandoned call wait
time, see the Intelligent CallRouter System Manager Guide.

 7.4.2. Service Level
When a peripheral service is first configured, a service level threshold is
specified in seconds. The service level threshold is the number of
seconds set as the maximum time a caller should wait before being
connected with an agent. Calls answered within the service level
threshold are considered to have met the service level, while calls not
answered within the service level threshold are considered not to have
met the service level.

The service level is expressed as a percentage of calls that have met the
service level threshold requirement. For example, if you set a service
level threshold of 30 seconds, you want all calls to be answered within
30 seconds. Every call answered within 30 seconds improves the service
level. Every call that is not answered within 30 seconds reduces the
service level.
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As a simple example, if you had 50 calls that were answered in under 30
seconds and 80 calls that took longer than 30 seconds to answer, the ICR
would calculate the service level as follows:

50/(50+80) x 100 = Service Level %

In this example, the service level would be 38 percent.

ICR Service Level

The ICR tracks service level events to determine which calls to consider
when making its service level calculation. A service level event occurs
when:

� A call is answered within the service level threshold.

� A call is abandoned within the service level threshold.

� A call reaches the service level threshold without being answered or
abandoned.

Any call that has a service level event is treated as a service level call
offered, which means that it will be used in the service level calculation.

The ICR provides a uniform calculation across all peripherals. The ICR
service level can be calculated in any of three ways:

� Abandoned calls ignored. The number of calls answered within the
service level threshold divided by the number of calls that had a
service level event minus the number of calls that were abandoned
before exceeding the service level threshold. Calls abandoned before
the service level threshold expired are removed from this
calculation.

� Abandoned calls negatively impact service level. The number of
calls answered within the service level threshold divided by the
number of calls that had a service level event. This treats abandoned
calls as though they had exceeded the service level threshold.

� Abandoned calls positively impact service level. The number of
calls answered within the service level threshold plus the number of
calls abandoned within the threshold, all divided by the number of
calls that had a service level event. This treats abandoned calls as
though they were answered within the service level threshold.

The System Manager specifies which service level calculation to use
when the peripheral service is configured. Regardless of the ICR service
level calculation method being used, the ICR tracks the data needed to
calculate the service level using any of the three methods.

Peripheral Service Level

While the ICR calculates its own service level, it also tracks the service
level calculated by the peripheral. This service level, called the
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peripheral service level, is a proprietary service level as calculated by
the peripheral. Some peripherals support more than one type of service
level calculation. The method of service level calculation used by the
peripheral is set by the System Manager when the peripheral service is
configured.

 See also: The Intelligent CallRouter System Manager Guide provides more
detailed information on service level calculation methods and options.

 7.4.3. Queues and Delays
The ICR tracks the time calls spend queued for each peripheral service
and the number of calls queued in real-time and for each half-hour
interval. Specifically, the ICR tracks the following data for queues and
delays:

� Calls in queue. The number of calls to the service that are in queue
at the peripheral.

� Calls abandoned in queue. The number of calls queued to the
service that were abandoned during an interval. An abandoned call
is a call in which the caller hangs up before the call is answered.

� Average delay in queue. The average delay time that all calls for
the service spent in the queue during an interval.

� Average delay in queue for abandoned calls. The average delay
time of all calls abandoned in queue for the service.

� Answer wait time. The sum of the time in seconds that all calls
offered to the service during an interval had to wait before being
answered.

� Average speed of answer. The average time that all calls offered to
the service during an interval waited before being answered.

� Service level calls queue held. The number of calls to the service
that have been in queue longer than the service level threshold.

� Longest delay for an abandoned call. The longest time that a call
was in queue for the service before being abandoned.

� Longest delay queue time. The longest time that a call was in
queue for the service before being answered.

� Total delay queue time. The sum of delay time in queue for all
calls to the service during an interval.
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 7.4.4. Agent Time Allocations
The ICR tracks several data categories related to the time a peripheral
service’s agents spend handling calls. This data include:

� Handle time. The total seconds that agents for the service were in
the Talking In, Work Ready, and Work Not Ready states.

� Average handle time per call. The average handle time for calls
handled by agents for the service. Handle time includes time spent in
the Talking In, Work Ready, and Work Not Ready states.

� Talk time. The total seconds that agents for the service were in the
Talking In, Talking Out, or Talking Other states during an interval.

� Average talk time. The average talk time for calls handled by
agents for the service. Talk time includes time spent in the Talking
In, Talking Out, and Talking Other states.

� Other time. The sum of the time that agents spend in the Not Ready
and Busy Other states.

7.5.  Enterprise Data
An enterprise service is a collection of peripheral services that can span
several call centers. For example, an enterprise service called Technical
Support may include peripheral services from several geographically
dispersed call centers. All the Technical Support peripheral services are
logically combined to make up a Technical Support enterprise service.

An enterprise skill group is a collection of skill groups that can span
several call centers. Enterprise skill groups can also include peripheral
skill groups from geographically dispersed call centers. Each of the
peripheral skill groups has a common set of skills, such as the ability to
handle sales calls. These skill groups are logically combined to form an
enterprise skill group.

Enterprise service and skill group data are stored in the following tables:

� Service_Real_Time

� Service_Half_Hour

� Skill_Group_Real_Time

� Skill_Group_Half_Hour

To compile data for enterprise services and skill groups, the ICR finds
the real-time or historical records for each member peripheral service. It
then sums or averages values from the individual records to produce a
value for the enterprise service or skill group. To arrive at daily values,
the ICR sums the half-hour rows for each day.
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 7.5.1. Enterprise Calculations
The ICR can simply total some statistics to obtain enterprise-wide
values. For example, to obtain the number of agents available for an
enterprise skill group, the ICR adds the number of agents available for
each peripheral skill group that is a member of the enterprise skill group.

If a value is an average or a calculated value, such as the Average
Handle Time or Expected Delay for an enterprise service, the ICR
cannot simply sum or average the values of the member peripheral
services. For example, in order to calculate the Average Handle Time for
an enterprise service, the ICR must total the handle time for the member
peripheral services and divide it by the total number of calls handled for
the member peripheral services.

In addition, because a call is usually routed to the peripheral service that
has the minimum expected delay within an enterprise service, the
Expected Delay for an enterprise service is equal to the minimum of the
expected delays for the member peripheral services.

Figure 14 shows some examples of calculations for an enterprise
service:

�Calls in progress = sum(Calls in progress for all members)

 Average handle time = sum(Handle time for all members) /
sum(Calls handled for all members)

 Expected delay = min(Expected delay for all members)

 Service level = sum(ServiceLevelCalls for all members) / 
sum(ServiceLevelCallsOffered for all members)

Figure 14:  Enterprise Service Calculation Examples

7.6.  Trunk Group Data
The ICR tracks data for each trunk group coming in to a switch. A trunk
group is a collection of telephone lines that are associated with a single
peripheral and used for a common purpose.

Trunk group data are stored in the Trunk_Group_Real_Time and
Trunk_Group_Half_Hour tables. Trunk group data include data that are
related to trunk usage and availability, such as:

� Trunks in service. The number of trunks in the trunk group that are
functional.

� All trunks busy. The total time in seconds that the trunk group was
in a state when all trunks were in use.

� Trunks idle. The number of trunks in the trunk group that are non-
busy, or idle.
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� Calls Abandoned. The number of calls to the trunk group that were
abandoned during a current or previous half-hour interval.

� Calls in. The number of incoming calls received on the trunk group
during a current or previous half-hour interval.

� Calls out. The number of outbound calls sent on the trunk group
during a current or previous half-hour interval.

� In service time. The aggregate number of seconds that trunks in the
group were in service during a current or previous half-hour interval.

� In use inbound time. The aggregate number of seconds that trunks
in the group were used for inbound calls during a current or previous
half-hour interval.

� In use outbound time. The aggregate number of seconds that trunks
in the group were used for outbound calls during a current or
previous half-hour interval.

7.7.  Network Trunk Group Data
A peripheral (ACD, PBX, or VRU) typically divides its trunks into trunk
groups differently than the routing client. For example, the ACD might
view two T1 circuits coming into the switch as two trunk groups. The
routing client (IXC, for example) might view the same T1’s as a single
pool of 72 trunks. This type of network treatment of trunks is called a
network trunk group.

Network trunk group data are stored in the Network_Trunk_Group_
Real_Time and Network_Trunk_Group_Half_Hour tables. The types of
data you can view for network trunk groups are similar to those you can
view for trunk groups (for example, trunks idle, trunks in service, etc.).

 See also: See the previous section, “Trunk Group Data,” for more information on
the data you can view for Network Trunk Groups. Chapter 1,
“Overview,” describes how network trunk groups are used in the call
center enterprise.

7.8.  Service Array Data
The data the ICR collects for service arrays are identical to the data
collected for services. Service arrays are defined in instances where you
have similar peripheral services on multiple VRUs and the VRUs all
share the same network trunk group. By grouping the services of
multiple VRUs into a service array, you can send calls to a single target
(the service array) and let the network deliver the call to any one of the
peripheral services that make up the service array.

The members of a service array are defined in the Service Array
Member table. Data for service arrays are stored in the
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Service_Real_Time and Service_Half_Hour tables. To arrive at daily
values, the ICR sums the Service_Half_Hour rows for each day.

The ICR tracks the same types of data for service arrays as it does for
services. For service arrays, the ICR tracks the following types of data:

� Call counts

� Service levels

� Queues and delays

� Call handling states

� Time allocations

 See also: For descriptions of the specific data tracked for service arrays, see the
“Peripheral Services Data” section earlier in this chapter.

7.9.  Route Data
The data that the ICR collects for routes are very similar to the data
collected for services. A route is a value returned by a routing script that
maps to a skill target at a peripheral. A skill target at a peripheral might
be a service, skill group, an agent, or a translation route. A route can be
thought of more simply as the final destination to which a call is directed
after the ICR has made its routing decisions.

Each skill target (for example, an agent) can have one or more routes. In
addition to pointing to a specific skill target, each route is also associated
with a service. This allows the ICR to account for each call under a
service. In this sense, you can think of a service as being a collection of
routes. (This is the reason you can drill down from services to routes in
peripheral and enterprise service reports.)

Route data are stored in the Route_Real_Time and Route_Half_Hour
tables. To arrive at daily values, Monitor ICR sums the
Route_Half_Hour rows for each day.

The ICR tracks the same types of data for routes as it does for services.
For routes, the ICR tracks the following types of data:

� Call counts

� Service levels

� Queues and delays

� Agent call handling states

� Agent time allocations

 See also: For descriptions of the specific data tracked for routes, see the
“Peripheral Services Data” section earlier in this chapter.
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 7.9.1. Service Level
The ICR tracks the service level for a route based on the calculation
method that is in use for the peripheral service associated with the route.
There are three types of service level calculation methods, each of which
treat abandoned calls differently:

� Abandoned calls ignored

� Abandoned calls negatively impact service level

� Abandoned calls positively impact service level

The ICR collects the data needed to make all three calculations. Service
levels that are calculated by the peripheral itself are not available for
individual routes.

 See also: For more information on service level calculations and the treatment of
abandoned calls, see “Service Level,” in the “Peripheral Service Data”
section earlier in this chapter.

7.10.  Peripheral Data
The peripheral data category is used to report on switch-specific
hardware and software status and some types of call count and service
level data. A peripheral is a switch, such as an ACD, PBX, or VRU, that
receives calls that have been routed by the ICR.

Peripheral data are recorded only in the Peripheral_Real_Time table in
the Admin Workstation’s local database. Some typical peripheral data
categories include:

� Status. Indicates the current failure state of the peripheral.

� Online. Indicates the current on-line state of the peripheral as
determined by the Central Controller.

� Calls in progress. The total number of calls currently in progress at
the peripheral.

� Agents logged on. The number of agents currently logged on to the
peripheral.

� Calls offered. The total number of calls offered to the peripheral
during an interval. This includes both incoming and external calls.

� Service level. The percentage of incoming calls that are answered
within a specified service level threshold. (See the earlier section,
“Service Level,” for more information.)

Other types of peripheral-specific hardware and software data may also
be tracked within the Peripheral_Real_Time database tables.
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7.11.  Application Gateway Data
You can report on several types of data related to application gateways.
The GEOTEL•Gateway feature allows the ICR to interface to a host
system that is running another call center application. The ICR uses the
application gateway to query the host system and application in order to
obtain information on which to base further routing decisions.

The Application Gateway is implemented via a node in the Script Editor.
For example, you might create a routing script that contains an
Application Gateway node. For certain types of calls, the script might
follow a branch that leads to the Application Gateway node. The ICR
then queries the external application specified by the node to obtain
additional data on how to route the call. The ICR can then base any
subsequent routing decisions on the results obtained from the query.

Network ICR systems (NICRs) typically have scripts that use ICR
Gateway nodes. The ICR Gateway node is a special type of Application
Gateway. The NICR scripts uses the ICR Gateway node to communicate
with Customer ICRs (CICRs). For certain calls, the NICR script follows
a branch that leads to an ICR Gateway node. The ICR then queries the
CICR specified in the node to obtain data on how to route the call. The
NICR then bases subsequent routing decisions on the results obtained
from the query.

 See also: The Intelligent CallRouter System Manager Guide describes the Script
Editor Application and ICR Gateway nodes in more detail.

Application gateway data, including data on ICR Gateway activity, are
stored in the central database Application_Gateway_Half_Hour table.
The ICR does not track real-time data for application gateways. The
statistics you can report on for application gateways include:

� Requests. The number of requests sent to the host system during the
half-hour interval.

� Rejects. The number of query requests that were rejected by the host
system during the half-hour interval.

� Maximum delay. The longest response time, in milliseconds, for
any request to the host system during the half-hour interval.

� Average delay. The average response time, in milliseconds, for all
requests to the host system during the half-hour interval.

� Unavailable. The number of requests attempted while no host
system was available during the half-hour interval.

� Errors. The number of errors that occurred for requests to the host
system during the half-hour interval.

� Timeouts. The number of requests to the host system that timed out
during the half-hour interval.
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7.12.  Call Type Data
The ICR allows to report statistics for the call types defined in the
system. A call type is a category of incoming calls. Calls are categorized
based on dialed number (DN), caller-entered digits (CED), and calling
line ID (CLID). Each call type has a schedule that determines which
routing script or scripts are active for that call type at any time.

In Monitor ICR reports, you might want to display data such as the
number of calls of a certain call type that used default routing during a
specified interval. The ICR generates a Call_Type_Real_Time record for
each call type. These records include data such as:

� Calls routed. The number of calls of this call type that have been
routed.

� Version. The version of the script that is currently available for use.

� Master script. A name that identifies a routing script. The master
script might have several versions. A new master script record is
created whenever you save a script with a new name.

� Default routing. The number of calls of this type for which the ICR
used default routing.

� Network default routing. The number of calls of this type for
which the IXC used default routing.

� Return busy. The number of calls of this type that the ICR routed to
the Busy target.

� Return ring. The number of calls of this type that the ICR routed to
the Ring target.

7.13.  Routing Client Data
A routing client is an entity that sends routing requests to the ICR.
Typically, a routing client corresponds to a subsystem within an
interexchange carrier or to a peripheral that is performing Post-Routing.

In Monitor ICR, you can report on statistics for the different routing
clients defined in the ICR system. For example, you might want to
report on the maximum delay of route responses to the routing client for
a specified interval. The ICR generates Routing_Client_Five_Minute
records for each routing client. These data are stored in the central
database and include:

� Routing client responses. The number of route responses to the
routing client during the five-minute interval.

� Mean routing client responses. The mean time, in milliseconds, for
the route responses to the routing client during the five-minute
interval.
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� Receive in error. The number or routing requests from the routing
client that produced errors during the five-minute interval.

� Timeout calls. The number of route responses to the routing client
that timed out during the five-minute interval.

� Late calls. The number of route responses to the routing client that
exceeded the late threshold but did not time out.

� Late threshold. The time limit imposed by the routing client (for
example, IXC) for receipt of a routing response.

� Maximum delay. The maximum delay, in milliseconds, of route
responses to the routing client during the five-minute interval.

� Discarded calls. The number of routing requests from the routing
client that were discarded because of an internal constraint such as
buffering.

7.14.  Schedule Import Data
You can generate reports on staffing schedule data that has been
imported from third-party workforce management systems. The GEOTEL

Workforce Management Import System allows you to import schedules
and store them in Schedule_Import_Real_Time tables in the Admin
Workstation’s local ICR database.

The exact data that appear in Monitor ICR reports depends on the
specific workforce management system you are using with the ICR
system. In general, the data are for the current time period and appear as
imported from the external source.

 See also: For more detailed information on the data gathered by the ICR, see the
Intelligent CallRouter Database Schema Handbook. The on-line Schema
Help also provides data definitions and reference information on the ICR
database tables.
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 8. Template Reference

The ICR comes with predefined templates that simplify the process of
generating reports. The predefined templates allow you to generate a
variety of reports without having to spend time developing queries or
designing report formats. Each template displays a specific set of
real-time or historical data in a chart, graph, or grid format. You can
generate reports from single templates or combine several templates to
produce a report.

A consistent format is used across all templates to ensure that call center
data are presented in a uniform manner. You can use the templates as
they are or copy and modify them to suit your particular business needs.

The ICR Custom Screen Builder allows you to modify the predefined
templates or create new templates. In addition, because the Intelligent
CallRouter has an open database architecture, you can use other database
query and reporting tools to access the databases.

See also: For information on other database query and access tools, see Chapter 2,
“The Admin Workstation.”

This chapter describes each predefined template and provides examples
of the reports that can be generated by using the templates. Templates
are available for each call center entity in the ICR system:

� Agents

� Application gateways

� Call types

� Peripherals

� Routes

� Routing clients

� Schedules

� Services

� Service arrays

� Skill groups

� Trunk groups
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8.1.  Real-Time and Historical Templates
The real-time templates generate reports that show the current state of
the call center enterprise. Real-time reports help you to keep track of
current call center resources and react quickly to any service delays.

The real-time templates draw data from the real-time tables in the local
database of the Distributor Admin Workstation. These tables are
constantly updated by the ICR real-time client process running on the
Distributor AW. Client AWs read the real-time data from the Distributor
AW database.

Historical templates are used to produce reports on past enterprise call
center performance. You can use the historical templates to generate
reports that help you to analyze trends and gauge resources across the
call center enterprise.

In contrast to the real-time templates, which display data from the
Distributor AW local database, the historical templates draw data from
records in the ICR central database. These records are updated every
half-hour. As an alternative, AWs might draw data from an Historical
Database Server (HDS) rather than directly from the central database.
One Distributor AW can be set up at an Admin site to serve as an HDS.

You can run any of the predefined templates by using the Template
Launcher within Monitor ICR. You can also combine real-time
templates and historical templates in a single report.

The remainder of this chapter lists the predefined templates and
describes the kinds of data each template displays.

See also: For more detailed information on how the data is calculated, see the
template reference in the Monitor ICR on-line help.
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agteam01_agent_status_by_position
Description
This template generates a real-time grid report that shows the status of
each agent in an agent team by position.

Database Table

Agent_Real_Time

Data

Position. The current extension on which the agent is working.

Agent name. The first and last name of the agent.

Logged on skill group. The name of the skill group to which the agent
is currently logged on.

Logon date and time. The date and time that the agent logged on.

Current state. The current state of the agent:  Logged Off, Logged On,
Ready, Not Ready, Work Ready, Work Not Ready, Talking, Busy
Other, Reserved, Unknown, Calls on Hold.

Direction. The direction of the call on which the agent is currently
working:  In (Inbound), Out (Outbound), or Unknown.

Destination. The type of outbound call:  ACD, direct, or Unknown.

Last state change. The date and time that the agent’s state last changed.

Reason. A code received from the peripheral that indicates the reason
for the agent’s last state change.

Example
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agteam02_agent_status_by_skillgroup
Description
This template generates a real-time grid report that shows the status of
each agent team member. The report also shows which skill group the
agent is currently logged on to.

Database Table
Agent_Skill_Group_Real_Time

Data
Agent team. The name of the agent team.

Skill group. The skill group to which the agent is logged on.

Agent name. The first and last name of the agent.

Logon date and time. The date and time that the agent logged on.

Agent state. The current state of the agent:  Logged Off, Logged On,
Ready, Not Ready, Work Ready, Work Not Ready, Talking, Busy
Other, Reserved, Unknown, Calls on Hold.

Last state change. The date and time that the agent’s state last changed.

Reason. A code received from the peripheral that indicates the reason
for the agent’s last state change.

Example
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agteam03_logout_status_by_team
Description
This template generates a historical grid report that shows agent login
and logout history for one or more selected agent teams over a specified
time period.

Database Table
Agent_Logout

Data
Agent enterprise name. The last name and first initial of the agent and

the ICR name of the peripheral with which the agent is associated.

Logon duration. The number of seconds that the agent was logged on.

Logout date and time. The ICR central controller date and time when
the agent logged out.

Reason. A code received from the peripheral that indicates the reason
for the agent’s last state change.

Example
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agteam04_daily_agent_activity
Description
This template generates a historical grid report that shows daily agent
call handling activity over a specified time period. To arrive at daily
values, the ICR sums the Agent_Skill_Group_Half_Hour rows for each
day.

Database Table

Agent_Skill_Group_Half_Hour

Data

Agent team. The name of the agent team.

Agent name. The first and last name of the agent.

Duration. The total time in seconds that the agent was logged on during
the interval.

Incoming calls total. The total number of inbound ACD calls handled
by the agent during the interval. This value is incremented when the
after-call work associated with the call is completed.

Incoming calls avg. length. The average length in seconds for incoming
calls handled by the agent during the interval.

Incoming calls percent. The percentage of all calls handled by the
agent for the period that were incoming calls.

Outgoing calls total. The total number of completed outbound ACD
calls made by the agent during the interval. The value is incremented
when the after-call work associated with the call is completed.

Outgoing calls average length. The average length in seconds for
outgoing calls made by the agent for the interval.

Outgoing calls percent. The percentage of all calls handled by the agent
for the period that were outgoing calls.

Internal calls total. The total number of internal calls initiated by the
agent during the interval. The value is incremented when the
after-call work associated with the call is completed.

Internal calls average length. The average length in seconds for
completed internal calls made by the agent for the interval.

Internal calls percent. The percentage of all calls handled by the agent
for the period that were internal calls.

Callback message total. The total number of callback messages that
were processed by the agent during the interval.
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Callback message average length. The average length in seconds for
callback messages that were processed by the agent during the
interval.

Callback message percent. The percentage of all calls handled by the
agent for the period that were callback messages.

% Wrapup. The percentage of time that the agent spent in wrap-up on
all calls counted as handled during the interval. An agent performing
wrap-up is either in the Work Ready or Work Not Ready state. This
value is measured against the total time the agent was logged on
during the interval.

Example
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agteam05_agent_daily_perf
Description
This template generates a historical grid report of agent performance
over a specified time period. To arrive at daily values, the ICR sums the
Agent_Skill_Group_Half_Hour rows for each day.

Database Table
Agent_Skill_Group_Half_Hour

Data
Agent team. The name of the agent team.

Agent name. The first and last name of the agent.

Abandoned calls ring. The total number of ACD calls abandoned while
ringing at an agent’s position. The value is incremented at the time
the call disconnects.

Abandoned calls hold. The total number of ACD calls that were
abandoned while being held at an agent’s position. The value is
incremented at the time the call disconnects.

Abandoned calls average. The average ring time in seconds associated
with ACD calls that were abandoned while ringing an agent’s
position.

Abandoned calls percent. The percentage of ring time associated with
ACD calls that were abandoned while ringing at an agent’s position.
This value is measured against the total time the agent was logged
on during the interval.

Hold calls in. The total number of completed inbound calls the agent
placed on hold. The value is incremented when the after-call work
associated with the call is completed.

Hold calls in average. The average on hold time in seconds associated
with inbound calls the agent placed on hold.

Hold calls in percent. The percentage of hold time associated with
inbound calls the agent placed on hold. This value is measured
against the total time the agent was logged on during the interval.

Hold calls out. The total number of completed outbound calls the agent
placed on hold at least once. The value is incremented when the
after-call work associated with the call is completed.

Hold calls out average. The average on hold time in seconds associated
with outbound calls the agent placed on hold.
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Hold calls out percent. The percentage of hold time associated with
outbound calls the agent placed on hold. This value is measured
against the total time the agent was logged on during the interval.

Hold calls internal. The total number of completed internal calls the
agent placed on hold for the interval. The value is incremented when
the after-call work associated with the call is completed.

Hold calls internal average. The average on hold time associated with
internal calls the agent placed on hold.

Hold calls internal percent. The percentage of hold time associated
with internal calls the agent placed on hold. This value is measured
against the total time the agent was logged on during the interval.

Assistance calls total. The total number of calls for which the agent
received supervisor assistance during the interval. The value is
incremented when the supervisor assistance call completes.

Assistance calls average. The average time in seconds that the agent
received assistance for all supervisor-assisted calls during the
interval.

Assistance calls percent. The percentage of time that the agent spent
during the interval on supervisor-assisted calls. This value is
measured against the total time the agent was logged on during the
interval.

Conference calls in. The number of incoming calls on which the agent
was in conference. Incoming calls include ACD and non-ACD calls.
The value is incremented with the agent drops off the call and the
call becomes a simple two-party call.

Conference calls average. The average time in seconds that the agent
spent in conference with calls during the interval. This value
includes hold time associated with the conference calls.

Conference calls percent. The percentage of time that the agent spent
during the interval on conference calls. The percentage includes hold
time associated with the conference calls. This value is measured
against the total time the agent was logged on during the interval.

Conference calls out. The number conference calls the agent initiated.
Initiated calls include ACD and non-ACD calls. The value is
incremented with the agent drops off the call and the call becomes a
simple two-party call.
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Conference calls out average. The average time in seconds that the
agent spent in conference on agent-initiated calls during the interval.
This value includes hold time associated with the conference calls.

Conference calls out percent. The percentage of time that the agent
spent during the half-hour interval on agent-initiated conference
calls. This percentage includes hold time associated with the
conference calls. This value is measured against the total time the
agent was logged on during the interval.

Example
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agtper01_agent_status_by_position
Description
This template generates a real-time grid report that shows agent status by
position for each agent logged on to the peripheral.

Database Table

Agent_Real_Time

Data

Peripheral. The name of the peripheral selected as the scope of the
report.

Position. The current extension on which the agent is working.

Agent name. The first and last name of the agent.

Skill group. The name of the skill group to which this is logged on.

Logon date and time. The date and time that the agent logged on.

Current state. The current state of the agent:  Logged Off, Logged On,
Ready, Not Ready, Work Ready, Work Not Ready, Talking, Busy
Other, Reserved, Unknown, Calls on Hold.

Direction. The direction of the call on which the agent is currently
working:  In (Inbound), Out (Outbound), or Unknown.

Destination. The type of outbound call:  ACD, direct, or Unknown.

Last state change. The date and time that the agent’s state last changed.

Reason. A code received from the peripheral that indicates the reason
for the agent’s last state change.

Example
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agtper02_agent_status_by_skillgroup
Description
This template generates a real-time grid report that shows current status
of each agent by the skill groups defined for the peripheral.

Database Table

Agent_Skill_Group_Real_Time

Data

Peripheral. The name of the peripheral selected as the scope of the
report.

Skill group. The name of the ICR skill group.

Agent name. The first and last name of the agent.

Logon date and time. The date and time that the agent logged on.

Agent state. The current state of the agent:  Logged Off, Logged On,
Ready, Not Ready, Work Ready, Work Not Ready, Talking, Busy
Other, Reserved, Unknown, Calls on Hold.

Last state change. The date and time that the agent’s state last changed.

Reason. A code received from the peripheral that indicates the reason
for the agent’s last state change.

Example
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agtper03_logout_status_by_peripheral
Description
This template generates a historical grid report that details agent login
duration and logout activity over a specified period of time.

Database Table

Agent_Logout

Data

Peripheral. The name of the peripheral to which these agents were
associated and logged on.

Agent name. The first and last name of the agent.

Agent enterprise name. The last name and first initial of the agent and
the ICR name of the peripheral with which the agent is associated.

Logon duration. The time in seconds that the agent spent logged on
during the specified period.

Logout date and time. The date and time that the agent logged out.

Reason. A code received from the peripheral that indicates the reason
for the agent’s last state change.

Example
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agtper04_daily_agent_activity
Description
This template generates a historical grid report that details the call
handling activity of agents for a peripheral over a specified time period.
To arrive at daily values, the ICR sums the
Agent_Skill_Group_Half_Hour rows for each day.

Database Table

Agent_Skill_Group_Half_Hour

Data

Peripheral. The name of the peripheral to which these agents were
associated and logged on.

Agent name. The first and last name of the agent.

Duration. The total time in seconds that agent was logged on during the
interval.

Incoming calls total. The total number of inbound ACD calls handled
by the agent during the interval. This value is incremented when the
after-call work associated with the call is completed.

Incoming calls avg. length. The average length in seconds for incoming
calls handled by the agent during the interval.

Incoming calls percent. The percentage of all calls handled by the
agent for the period that were incoming calls.

Outgoing calls total. The total number of completed outbound ACD
calls made by the agent during the interval. The value is incremented
when the after-call work associated with the call is completed.

Outgoing calls average length. The average length in seconds for
outgoing calls made by the agent for the interval.

Outgoing calls percent. The percentage of all calls handled by the agent
for the period that were outgoing calls.

Internal calls total. The total number of internal calls initiated by the
agent during the interval. The value is incremented when the
after-call work associated with the call is completed.

Internal calls average length. The average length in seconds for
completed internal calls made by the agent for the interval.

Internal calls percent. The percentage of all calls handled by the agent
for the period that were internal calls.

Callback message total. The total number of callback messages that
were processed by the agent during the interval.
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Callback message average length. The average length in seconds for
callback messages that were processed by the agent during the
interval.

Callback message percent. The percentage of all calls handled by the
agent for the period that were callback messages.

% Wrapup. The percentage of time that the agent spent in wrap-up on
all calls counted as handled during the interval. An agent performing
wrap-up is either in the Work Ready or Work Not Ready state. This
value is measured against the total time the agent was logged on
during the interval.

Example

Download from Www.Somanuals.com. All Manuals Search And Download.



168 Template Reference

agtper05_agent_daily_perf
Description
This template generates a historical grid report that shows agent
performance by peripheral over a specified time period. To arrive at
daily values, the ICR sums the Agent_Skill_Group_Half_Hour rows for
each day.

Database Table

Agent_Skill_Group_Half_Hour

Data

Peripheral. The name of the peripheral associated with the agents.

Agent name. The first and last name of the agent.

Abandoned calls ring. The total number of ACD calls abandoned while
ringing at the agent’s position.

Abandoned calls hold. The total number of ACD calls abandoned while
being held at the agent’s position.

Abandoned calls average. The average ring time in seconds associated
with ACD calls that were abandoned while ringing at the agent’s
position.

Abandoned calls percent. The percentage of time associated with ACD
calls that were abandoned while ringing the agent’s position. This
value is measured against the total time the agent was logged on
during the interval.

Hold calls in. The total number of completed inbound calls the agent
placed on hold. The value is incremented when the after-call work
associated with the call is completed.

Hold calls in average. The average on hold time in seconds associated
with inbound calls the agent placed on hold.

Hold calls in percent. The percentage of hold time associated with
inbound calls the agent placed on hold. This value is measured
against the total time the agent was logged on during the interval.

Hold calls out. The total number of completed outbound calls the agent
placed on hold at least once. The value is incremented when the
after-call work associated with the call is completed.

Hold calls out average. The average on hold time in seconds associated
with outbound calls the agent placed on hold.

Hold calls out percent. The percentage of hold time associated with
outbound calls the agent placed on hold. This value is measured
against the total time the agent was logged on during the interval.
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Hold calls internal. The total number of completed internal calls the
agent placed on hold for the interval. The value is incremented when
the after-call work associated with the call is completed.

Hold calls internal average. The average on hold time associated with
internal calls the agent placed on hold.

Hold calls internal percent. The percentage of hold time associated
with internal calls the agent placed on hold. This value is measured
against the total time the agent was logged on during the interval.

Assistance calls total. The total number of calls for which the agent
received supervisor assistance during the interval. The value is
incremented when the supervisor assistance call completes.

Assistance calls average. The average time in seconds that the agent
received assistance for all supervisor-assisted calls during the
interval.

Assistance calls percent. The percentage of time that the agent spent
during the interval on supervisor-assisted calls. This value is
measured against the total time the agent was logged on during the
interval.

Conference calls in. The number of incoming calls on which the agent
was in conference. Incoming calls include ACD and non-ACD calls.
The value is incremented with the agent drops off the call and the
call becomes a simple two-party call.

Conference calls average. The average time in seconds that the agent
spent in conference with calls during the interval. This value
includes hold time associated with the conference calls.

Conference calls percent. The percentage of time that the agent spent
during the interval on conference calls. The percentage includes hold
time associated with the conference calls. This value is measured
against the total time the agent was logged on during the interval.

Conference calls out. The number conference calls the agent initiated.
Initiated calls include ACD and non-ACD calls. The value is
incremented with the agent drops off the call and the call becomes a
simple two-party call.

Download from Www.Somanuals.com. All Manuals Search And Download.



170 Template Reference

Conference calls out average. The average time in seconds that the
agent spent in conference on agent-initiated calls during the interval.
This value includes hold time associated with the conference calls.

Conference calls out percent. The percentage of time that the agent
spent during the half-hour interval on agent-initiated conference
calls. This percentage includes hold time associated with the
conference calls. This value is measured against the total time the
agent was logged on during the interval.

Example
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agtskg01_agent_status_by_position
Description
This template generates a real-time grid report that shows agent status in
selected skill groups by position.

Database Table

Agent_Real_Time

Data

Skill group. The name of the skill group to which the agents belong.

Position. The current extension on which the agent is working.

Agent name. The first and last name of the agent.

Skill group. The name of the skill group to which this agent is logged
on.

Logon date and time. The date and time that the agent logged in.

Current state. The current state of the agent:  Logged Off, Logged On,
Ready, Not Ready, Work Ready, Work Not Ready, Talking, Busy
Other, Reserved, Unknown, Calls on Hold.

Direction. The direction of the call on which the agent is currently
working:  In (Inbound), Out (Outbound), or Unknown.

Destination. The type of outbound call:  ACD, direct, or Unknown.

Last state change. The date and time that the agent’s state last changed.

Reason. A code received from the peripheral that indicates the reason
for the agent’s last state change.

Example
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agtskg02_agent_status_by_skillgroup
Description
This template generates a real-time grid report that details the current
status of each agent in a skill group.

Database Table

Agent_Skill_Group_Real_Time

Data

Skill group. The name of the skill group to which the agents belong.

Agent name. The first and last name of the agent.

Logon date and time. The date and time that the agent logged on.

Current state. The current state of the agent:  Logged Off, Logged On,
Ready, Not Ready, Work Ready, Work Not Ready, Talking, Busy
Other, Reserved, Unknown, Calls on Hold.

Last state change. The date and time that the agent’s state last changed.

Reason. A code received from the peripheral that indicates the reason
for the agent’s last state change.

Example
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agtskg03_logout_status_by_skillgroup
Description
This template generates a historical grid report that details logon and
logout status for the individual agents in a particular skill group.

Database Table

Agent_Logout

Data

Skill group. The name of the skill group to which these agents are
associated.

Agent name. The first and last name of the agent.

Agent enterprise name. The last name and first initial of the agent and
the peripheral with which the agent is associated.

Logon duration. The time that the agent spent logged on.

Logout date and time. The ICR central controller date and time that the
agent logged out.

Reason. A code received from the peripheral that indicates the reason
for the agent’s last state change.

Example
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agtskg04_daily_agent_activity
Description
This template generates a historical grid report that shows agent call
handling activity over a specified time period for one or more skill
groups. To arrive at daily values, the ICR sums the
Agent_Skill_Group_Half_Hour rows for each day.

Database Table

Agent_Skill_Group_Half_Hour

Data

Skill group. The name of the skill group with which these agents are
associated.

Agent name. The first and last name of the agent.

Duration. The total time in seconds that agent was logged on during the
interval.

Incoming calls total. The total number of inbound ACD calls handled
by the agent during the interval. This value is incremented when the
after-call work associated with the call is completed.

Incoming calls avg. length. The average length in seconds for incoming
calls handled by the agent during the interval.

Incoming calls percent. The percentage of all calls handled by the
agent for the period that were incoming calls.

Outgoing calls total. The total number of completed outbound ACD
calls made by the agent during the interval. The value is incremented
when the after-call work associated with the call is completed.

Outgoing calls average length. The average length in seconds for
outgoing calls made by the agent for the interval.

Outgoing calls percent. The percentage of all calls handled by the agent
for the period that were outgoing calls.

Internal calls total. The total number of internal calls initiated by the
agent during the interval. The value is incremented when the
after-call work associated with the call is completed.

Internal calls average length. The average length in seconds for
completed internal calls made by the agent for the interval.

Internal calls percent. The percentage of all calls handled by the agent
for the period that were internal calls.

Callback message total. The total number of callback messages that
were processed by the agent during the interval.
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Callback message average length. The average length in seconds for
callback messages that were processed by the agent during the
interval.

Callback message percent. The percentage of all calls handled by the
agent for the period that were callback messages.

% Wrapup. The percentage of time that the agent spent in wrap-up on
all calls counted as handled during the interval. An agent performing
wrap-up is either in the Work Ready or Work Not Ready state. This
value is measured against the total time the agent was logged on
during the interval.

Example
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agtskg05_agent_daily_perf
Description
This template generates a historical grid report that shows agent
performance over a specified time period. To arrive at daily values, the
ICR sums the Agent_Skill_Group_Half_Hour rows for each day.

Database Table
Agent_Skill_Group_Half_Hour

Data
Skill group. The name of the skill group with which these agents are

associated.

Agent name. The first and last name of the agent.

Abandoned calls ring. The total number of ACD calls abandoned while
ringing at the agent’s position.

Abandoned calls hold. The total number of ACD calls abandoned while
being held at the agent’s position.

Abandoned calls average. The average ring time in seconds associated
with ACD calls that were abandoned while ringing at the agent’s
position.

Abandoned calls percent. The percentage of time associated with ACD
calls that were abandoned while ringing the agent’s position. This
value is measured against the total time the agent was logged on
during the interval.

Hold calls in. The total number of completed inbound calls the agent
placed on hold. The value is incremented when the after-call work
associated with the call is completed.

Hold calls in average. The average on hold time in seconds associated
with inbound calls the agent placed on hold.

Hold calls in percent. The percentage of hold time associated with
inbound calls the agent placed on hold. This value is measured
against the total time the agent was logged on during the interval.

Hold calls out. The total number of completed outbound calls the agent
placed on hold at least once. The value is incremented when the
after-call work associated with the call is completed.

Hold calls out average. The average on hold time in seconds associated
with outbound calls the agent placed on hold.

Hold calls out percent. The percentage of hold time associated with
outbound calls the agent placed on hold. This value is measured
against the total time the agent was logged on during the interval.
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Hold calls internal. The total number of completed internal calls the
agent placed on hold for the interval. The value is incremented when
the after-call work associated with the call is completed.

Hold calls internal average. The average on hold time associated with
internal calls the agent placed on hold.

Hold calls internal percent. The percentage of hold time associated
with internal calls the agent placed on hold. This value is measured
against the total time the agent was logged on during the interval.

Assistance calls total. The total number of calls for which the agent
received supervisor assistance during the interval. The value is
incremented when the supervisor assistance call completes.

Assistance calls average. The average time in seconds that the agent
received assistance for all supervisor-assisted calls during the
interval.

Assistance calls percent. The percentage of time that the agent spent
during the interval on supervisor-assisted calls. This value is
measured against the total time the agent was logged on during the
interval.

Conference calls in. The number of incoming calls on which the agent
was in conference. Incoming calls include ACD and non-ACD calls.
The value is incremented with the agent drops off the call and the
call becomes a simple two-party call.

Conference calls average. The average time in seconds that the agent
spent in conference with calls during the interval. This value
includes hold time associated with the conference calls.

Conference calls percent. The percentage of time that the agent spent
during the interval on conference calls. The percentage includes hold
time associated with the conference calls. This value is measured
against the total time the agent was logged on during the interval.

Conference calls out. The number conference calls the agent initiated.
Initiated calls include ACD and non-ACD calls. The value is
incremented with the agent drops off the call and the call becomes a
simple two-party call.

Download from Www.Somanuals.com. All Manuals Search And Download.



178 Template Reference

Conference calls out average. The average time in seconds that the
agent spent in conference on agent-initiated calls during the interval.
This value includes hold time associated with the conference calls.

Conference calls out percent. The percentage of time that the agent
spent during the half-hour interval on agent-initiated conference
calls. This percentage includes hold time associated with the
conference calls. This value is measured against the total time the
agent was logged on during the interval.

Example
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apgate11_status_by_half_hour
Description
This template generates a historical, tabular report that shows the
number of requests made through an application gateway to a host
system for particular half-hour intervals. Data is also provided on
rejected requests, maximum and average request delays, and any errors
involved with application gateway requests to host systems.

Database Table

Application_Gateway_Half_Hour

Data

Requests. The number of query requests the CallRouter has sent to the
host system during the half-hour interval.

Rejects. The number of query requests that were rejected by the host
system during the half-hour interval.

Max Delay. The longest response time, in milliseconds, for any request
to the host system during the half-hour interval.

Avg Delay. The average response time, in milliseconds, for all requests
to the host system during the half-hour interval.

Unavailable. The number of requests attempted while no host system
was available during the half-hour interval.

Errors. The number of errors that occurred for requests to the host
system during the half-hour interval.

Timeouts. The number of requests to the host system that timed out
during the half-hour interval.

Example
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caltyp01_status_grid
Description
This template generates a real-time grid that shows data on call types in
the ICR system. Data shown includes the master script in effect for the
call type and the number of calls routed for the call type.

Database Table
Call_Type_Real_Time

Data
Call type. The name of the call type. A call type is a category of

incoming calls. Calls are categorized based on dialed number (DN),
caller-entered digits (CED), and calling line ID (CLID).

Master script. A name that identifies the routing script in effect for this
call type. The master script might have several versions. A new
master script record is created whenever you save a script with a
new name.

Version. The version of the script that is currently available for use.

Calls routed. The number of calls of this call type that have been routed
(either during the current half-hour interval (Since Half) or since
midnight (Today)).

Error count. The number of errors for calls of this type during the
current half-hour interval (either during the current half-hour
interval (Since Half) or since midnight (Today)).

Example
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caltyp02_count_graph
Description
This template generates a real-time, stacked bar graph that keeps a
running total of call routing statistics for call types for the current day
(since midnight).

Database Table
Call_Type_Real_Time

Data
Call Types Default Routed (Today). The number of calls of this type

for which the ICR used default routing. Measured since midnight.

Call Types Network Default Routed (Today). The number of calls of
this type for which the IXC used network default routing. Measured
since midnight.

Call Types Returning Busy (Today).The number of calls of this type
that the ICR routed to the Busy target (since midnight).

Call Types Returning Ring (Today). The number of calls of this type
that the ICR routed to the Ring target (since midnight).

Example
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entskg01_status_#_graph
Description
This template generates a real-time, stacked bar graph that shows the
number of active agents from selected enterprise skill groups who are
currently in any of four agent states.

Database Table
Skill_Group_Real_Time

Data
Agents available. The number of agents who are in the Available state

(that is, not occupied with any call activity and ready to accept
calls).

Agents idle. The number of agents who are logged on, not involved in a
call or after-call work, and are not available to receive a call.

Agents talking. The number of agents who are involved in a call
(inbound, outbound, or internal).

Agents in wrap-up. The number of agents who are involved in
after-call work. After-call work includes activities such as
completing necessary paperwork or consulting work.

Example

The total number of all agents in these four states is the number of
agents Logged On.
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entskg02_status_grid
Description
This template generates a real-time grid that shows the number of agents
from selected enterprise skill groups who are signed on, how these
agents break down numerically into nine states, and how they break
down on a percentage basis into five states. A total row at the bottom of
the grid totals or averages the data for all the enterprise skill groups
listed.

Database Table
Skill_Group_Real_Time

Data

Agents signed on. The number of agents who are currently signed on to
the enterprise skill group (that is, agents who are known to the
system but may or may not be ready to accept calls).

Agents idle. The number of agents who are logged on, not involved in a
call or after-call work, and are not available to receive a call.

Agents available. The number of agents who are in the Available state
(that is, not occupied with any call activity and ready to accept
calls).

Agents ready. The number of agents who are logged on and are either
talking on a call or performing after-call work, but are presumed to
be ready to accept calls when done.

Agents talking in. The number of agents talking on inbound calls.

Agents talking out. The number of agents talking on outbound calls.

Agents talking other. The number of agents who are talking on calls
other than inbound and outbound calls (for example, internal calls).

Agents in wrap-up. The number of agents involved in after-call work.
After-call work includes activities such as completing necessary
paperwork or consulting work.

Calls on hold. Number of calls to the skill group that are currently on
hold.

Agents in reserve. The number of agents currently in the reserve state.
A reserved agent is awaiting an interflowed call and is unavailable
to receive any incoming calls. This state applies to agents on
Northern Telecom Meridian and Aspect CallCenter ACDs only.

Agents in busy other. The number of agents who are in the Busy Other
state (that is, busy in skill groups other than the one presently being
examined). An agent can be active in only one skill group at a time.
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Therefore, while active in one skill group, the agent is considered by
the other skill groups to be in the Busy Other state.

Percent agents idle. The percentage of all agents in the enterprise skill
group who are in the Not Ready state.

Percent agents available. The percentage of all agents in the enterprise
skill group who are in the Available state.

Percent agents talking. The percentage of all agents in the enterprise
skill group who are talking on inbound, outbound, or internal calls.

Percent agents in wrap-up. The percentage of all agents in the
enterprise skill group who are involved in after-call work.

Percent agents in busy other. The percentage of all agents in the
enterprise skill group who are in the Busy Other state.

Example
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entskg03_status_%_graph
Description
This template generates a real-time graph that shows the percentage of
agents from selected enterprise skill groups who are in any of four call
handling states.

Database Table
Skill_Group_Real_Time

Data
Agents available. The percentage of all agents in the enterprise skill

group who are not occupied with any call activity and are ready to
accept calls.

Agents idle. The percentage of all agents in the enterprise skill group
who are idle (that is, logged on, not involved in a call or after-call
work, and not available to receive a call). Idle is also referred to as
Not Ready.

Agents talking. The percentage of all agents in the enterprise skill group
who are involved in a call (inbound, outbound, or internal).

Agents in wrap-up. The percentage of all agents in the enterprise skill
group who are involved in after-call work.

Example
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entskg04_status_grid_to5
Description
This template generates a rolling five-minute grid that shows the
full-time equivalent (FTE) values for agents in the enterprise skill group.
FTE is the number of full-time agents that would be required during a
period to perform the work done in that period. To calculate the FTE,
divide the number of seconds of work performed by the number of
seconds in the period. For example, if agents spent a total of 1200
seconds handling calls during a five-minute (300-second) period, the
FTE for call handling would be as follows:

1200 person seconds / 300 seconds = 4 persons

This template uses cumulative, or rolling, five-minute data derived from
the real-time data to arrive at an FTE value. Data in the grid is
continuously updated. This template also provides the percentage of
agents who are currently in any of four call handling states. A total row
totals or averages the data for all the enterprise skill groups listed.

Database Table

Skill_Group_Real_Time

Data

Full-time equivalent (FTE) logged on. The FTE value for the time
agents are logged on to the enterprise skill group. (Logged on is not
an agent state, but a necessary pre-condition for being in any state.)

FTE idle. The FTE value for the time agents are idle (Not Ready) in the
enterprise skill group (that is, agents who are logged on, not
involved in a call or after-call work, and are not available to receive
a call).

FTE available. The FTE value for the time agents are in the Available
state (that is, not occupied with any call activity and ready to accept
calls).

FTE talking. The FTE value for the time agents are involved in a call
(inbound, outbound, or internal).

FTE in wrap-up. The FTE value for the time agents are involved in
after-call work.

FTE hold. The FTE value for the time agents spent on hold during the
current five-minute interval.
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FTE reserve. The FTE value for the time agents are in the Reserved
state. The Reserved state is a state in which the agent is awaiting an
interflowed call and is unavailable to receive any incoming calls.
This state applies to agents on Northern Telecom Meridian and
Aspect CallCenter ACDs only.

FTE in busy other. The FTE value for the time agents are in the Busy
Other state (that is, busy in skill groups other than the one presently
being examined). An agent can be active in only one skill group at a
time. Therefore, while active in one skill group, the agent is
considered by the other skill groups to be in the Busy Other state.

Percent agents idle. The percentage of time that all agents in the
enterprise skill group were idle (that is, logged on, not involved in a
call or after-call work, and not available to receive a call). Idle is
also called Not Ready.

Percent agents available. The percentage of time that all agents in the
enterprise skill group were not occupied with any call activity and
were ready to accept calls.

Percent agents talking. The percentage of time that all agents in the
enterprise skill group were involved in a call (inbound, outbound, or
internal).

Percent agents in wrap-up. The percentage of time that all agents in
the enterprise skill group were involved in after-call work.

Percent agents in busy other. The percentage of time that all agents in
the enterprise skill group were in the Busy Other state.

Example
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entskg05_utilization_graph
Description
This template generates a real-time bar graph that shows a percentage
utilization of agents in the selected enterprise skill groups. Percentage
utilization is the ratio between the time agents spend handling calls and
the time agents were ready to accept calls.

Database Table

Skill_Group_Real_Time

Data

Percent utilization. The percent utilization is computed by dividing the
total time agents spent handling calls by the total time agents were
Ready. (The Ready time is calculated by subtracting the Not Ready
time from the total time that agents were Logged On.)

Example
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entskg06_halfhour_aht_grid
Description
This template generates a historical grid that shows call count and
handle time data per half-hour for selected enterprise skill groups. This
template also includes a summary row for each day of data, which
provides daily averages and totals; and a summary row for each skill
group, which provides averages and totals for individual skill groups.

Database Table

Skill_Group_Half_Hour

Data

Calls handled. The total number of calls handled to completion for the
enterprise skill group.

Agent calls out. The total number of outbound calls made by agents in
the enterprise skill group.

Average handle time. The average handle time for calls handled by
agents in the enterprise skill group. Handle time includes time that
agents spend in the Talking In, Work Ready, and Work Not Ready
states.

Average talk time. The average talk time for calls to the enterprise skill
group. Talk time includes time spent in the Talking In, Talking Out,
and Talking Other states.

Average wrap-up time. The average time that agents in the enterprise
skill group spent in after-call work.
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FTE number of agents. The FTE number of logged on agents for the
enterprise skill group. FTE (full-time equivalent) is the number of
full-time agents that would be required during a period to perform
the work done in that period. To calculate the FTE, divide the
number of seconds of work performed by the number of seconds in
the period. In this case, the work performed is the time agents spent
logged on.

See also: For information on how FTE values are calculated, see
“entskg04_status_grid_to5,” earlier in this chapter.

Example
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entskg07_daily_aht_grid
Description
This template generates a historical grid that displays call count and
handle time data on a per-day basis for selected enterprise skill groups.
This template also includes a summary row that totals or averages the
data for all skill groups listed.

Database Table

Skill_Group_Half_Hour

Data

Calls handled. The total number of calls handled to completion for all
agents in the enterprise skill group.

Agent calls out. The total number of outbound calls made by agents in
the enterprise skill group.

Average handle time. The average handle time for calls handled by
agents in the enterprise skill group. Handle time includes time spent
in the Talking In, Work Ready, and Work Not Ready states.

Average talk time. The average talk time for calls to the enterprise skill
group. Talk time includes time spent in any of the Talking states.

Average wrap-up time. The average time agents in the enterprise skill
group spent in after-call work. Agents performing after-call work are
in either the Work Ready or Work Not Ready state.

Download from Www.Somanuals.com. All Manuals Search And Download.



192 Template Reference

FTE number of agents. The FTE value for the number of logged on
agents for the enterprise skill group. FTE (full-time equivalent) is
the number of full-time agents that would be required during a
period to perform the work done in that period. To calculate the
FTE, divide the number of seconds of work performed by the
number of seconds in the period. In this case, the work performed is
the time agents spent logged on.

See also: For information on how FTE values are calculated, see
“entskg04_status_grid_to5,” earlier in this chapter.

Example
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entskg08_halfhour_perform_grid
Description
This template generates a historical grid that shows half-hour, full-time
equivalent (FTE) values for agents in selected enterprise skill groups.
FTE is the number of full-time agents that would be required during a
period to perform the work done in that period. FTE values are derived
by taking the time that agents are in a particular state during an interval
and dividing that time by the number of seconds in the interval.

See also: For more information on how FTE values are calculated, see
“entskg04_status_grid_to5” earlier in this chapter.

This template has a date summary row, which totals the data for the day;
and a skill group summary row, which totals the data for individual skill
groups in the grid.

Database Table

Skill_Group_Half_Hour

Data
Full-time equivalent (FTE) sign-on. The FTE number of agents logged

on to the enterprise skill group.

FTE idle. The FTE number of idle agents (that is, agents who were
logged on, not involved in a call or after-call work, and were not
available to receive a call). Idle is also referred to as Not Ready.

FTE available. The FTE number of agents in the Available state (that
is, not occupied with any call activity and ready to accept calls).

FTE talking. The FTE number of agents involved in calls (inbound,
outbound, or internal).
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FTE wrap-up. The FTE number of agents involved in after-call work.

FTE busy other. The FTE number of agents in the Busy Other state
(that is, busy in skill groups other than the one presently being
examined). An agent can be active in only one skill group at a time.
Therefore, while active in one skill group, the agent is considered by
the other skill groups to be in the Busy Other state.

Example
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entskg09_normalized_agt_state
Description
This template generates a stacked bar graph that shows the percentage of
time that all agents in the enterprise skill group were in specific states
during an interval. The normalized value is derived from the total time
that all agents were logged on during the interval.

Database Table

Skill_Group_Half_Hour

Data

% Available. The percentage of time that all agents were in the
Available state during the interval.

% Idle. The percentage of time that all agents were in the Idle state (that
is, Not Ready), during the interval.

% Talking. The percentage of time that all agents were in the Talking
In, Talking Out, or Talking Other states during the interval.

% Wrap-up. The percentage of time that all agents were in call wrap-up
(that is, performing after-call work) during the interval.

Example
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entsvc01_queue_delay_status
Description
This template generates a real-time bar graph that displays data on the
current status of call queues for selected enterprise services.

Database Table

Service_Real_Time

Data

Average delay in queue. The average delay for calls currently in queue
for the enterprise service.

Expected delay in queue. The predicted delay for any new call added to
the queue for the enterprise service. This is valid only if no agents
are available for the service.

Longest call in queue. The time that the longest call in queue for the
enterprise service has spent in the queue.

Average speed of answer (ASA). The average time that all calls offered
to the enterprise service during the current five-minute interval
waited before being answered.

Example
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entsvc02_calls_status
Description
This template generates a real-time, stacked bar graph that displays the
number of calls on which agents are talking and the number of calls in
queue for selected enterprise services.

Database Table
Service_Real_Time

Data
Calls talking. The number of calls to the enterprise service on which

agents are currently talking.

Calls in queue. The number of calls to the enterprise service that are in
queue at each peripheral now.

Example
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entsvc03_effect_of_aban_on_servicelevel
Description
This template generates a real-time grid that shows the effect of
abandoned calls on the service levels of selected enterprise services.
This grid also provides a summary row that totals or averages the data
for all peripheral services listed.

Database Table

Service_Real_Time

Data

Calls offered. The total number of incoming calls and internal calls sent
to the enterprise service. Calls are counted as offered as soon as they
are sent to the enterprise service.

Calls handled. The number of calls answered and finished for the
enterprise service.

Calls abandoned. The number of calls in which the caller hung up
before being connected with an agent.

Calls abandoned within service level. The number of calls to the
enterprise service that were abandoned within the ICR service level
threshold.

Service level without abandoned calls. The ICR service level for the
enterprise service without including abandoned calls in the
calculation.

See also: For more information on service level calculations, see Chapter 7,
“Available Data.”

Service level with abandoned calls. The ICR service level for the
enterprise service including abandoned calls in the calculation.

Example
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entsvc04_calls_trend_analysis
Description
This template generates a real-time grid that shows call counts and
service levels for enterprise services since the end of the last five-minute
interval, for the current half-hour interval, and since midnight. This grid
also provides a summary row that totals the call count data for all
services in the grid.

Database Table

Service_Real_Time

Data

Calls offered. The total number of incoming calls and internal calls sent
to the enterprise service during the interval. Calls are counted as
offered as soon as they are sent to the enterprise service.

Calls answered. The total number of calls to the enterprise service that
were answered during the interval. A call is counted as answered
when it reaches an agent.

Calls abandoned. The total number of calls during the interval in which
the caller hung up before being connected with an agent.

Service level. The percentage of incoming calls to the service during the
interval that were answered within a specified threshold.

Example
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entsvc05_calls_offered_half_pie
Description
This template generates a real-time pie chart that shows the distribution
of calls offered to selected enterprise services for the current half-hour
interval. The Calls Offered value (for example 18.01%) is a percentage
of the total calls offered to the enterprise services listed in the chart
legend.

Database Table

Service_Real_Time

Data

Calls offered. The percentage of the total of incoming and internal calls
sent to the enterprise services for the current half-hour interval. Calls
are counted as offered as soon as they are sent to the enterprise
service.

Example

Download from Www.Somanuals.com. All Manuals Search And Download.



Real-Time and Historical Templates 201

8. T
em

plate R
eference

entsvc06_serv_level_monitor_graph
Description
This template generates a real-time bar graph that shows service levels
for selected enterprise services since the end of the last five-minute
interval, for the current half-hour interval, and since midnight.

Database Table
Service_Real_Time

Data
Service level. The percentage of incoming calls to the enterprise service

during the interval that were answered within a specified threshold.

Example
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entsvc07_now_to5_grid
Description
This template generates a grid that provides call counts, queue status,
and service level data in real-time and for the last five minutes for
selected enterprise services. A summary row totals the values in each
column for all the enterprise services listed.

Database Table

Service_Real_Time

Data

Calls talking. The number of calls on which agents for the enterprise
service are currently talking.

Calls in queue. The number of calls to the enterprise service that are in
queue at each peripheral now.

Average delay in queue. The average delay for calls currently in queue
for the enterprise service.

Longest call in queue. The time that the longest call in queue for the
enterprise service has spent in the queue.

Calls offered. The total number of incoming calls and internal calls sent
to the enterprise service since the end of the last five-minute
interval. Calls are counted as offered as soon as they are sent to the
enterprise service.

Calls handled. The number of calls answered and finished for the
enterprise service since the end of the last five-minute interval.

Calls abandoned. The number of calls in which the caller hung up
before being connected with an agent. Measured since the end of the
last five-minute interval.

Average speed of answer (ASA). The average time that all calls offered
to the enterprise service waited before being answered. Measured
since the end of the last five-minute interval.

Average handle time (AHT). The average handle time for calls handled
by agents in the enterprise service since the end of the last
five-minute interval. Handle time includes time that agents spend in
the Talking In, Work Ready, and Work Not Ready states.

Average talk time. The average time agents for the enterprise service
spent talking on calls handled by the enterprise service since the end
of the last five-minute interval. Talk time includes time spent in the
Talking In, Talking Out, and Talking Other states.

Download from Www.Somanuals.com. All Manuals Search And Download.



Real-Time and Historical Templates 203

8. T
em

plate R
eference

Service level. The percentage of incoming calls to the enterprise service
that were answered within a specified threshold. (Shown since the
end of the last five-minute interval, for the current half-hour interval,
and since midnight.)

Example
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entsvc08_gate_realtime_status_grid
Description
This template generates a grid report that provides real-time, half-hour,
and daily status information for an enterprise service. In this report, an
enterprise service is considered to be a collection of gates. A gate is the
Rockwell Galaxy term for a peripheral service.

Database Table

Service_Real_Time

Data

Calls Offered – Real-Time, Half-Hour, Today (Nco). The number of
incoming calls or internal calls sent to a specific enterprise service
(collection of gates). In real-time data, a call is counted as offered as
soon as it is sent to a gate.

Calls in Queue (Que). The number of calls to the enterprise service that
are in queue now.

Calls Held (Hld). The number of calls to the enterprise service that are
currently queued for longer than the service level threshold.

Primary Position Manned (Ppm). The number of agents for the
enterprise service who are logged on to their primary assignment
gate (also referred to as the agent’s primary position).

Available Agents (Aav). The number of agents for the enterprise
service who are ready to accept calls and are not currently involved
in call work.

Incoming Calls (In). The number of agents who are talking on
incoming calls.

Outgoing Calls (Out). The number of agents who are talking on
outgoing calls.

After-Call Work (Cw). The number of agents who are involved in
after-call work. After-call work includes post-call activities such as
completing paperwork or consulting with associates. Agents
performing after-call work are either in the Work Ready or Work
Not Ready state.

Other Time (Othr). The sum of the time that agents spend in the Not
Ready and Busy Other states.

Average Speed of Answer (Asa). The average time that all calls offered
to the enterprise service during the current five-minute interval
waited before being answered.
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Calls Handled – Half-Hour and Today (Nch). The total number of
calls handled to completion by an enterprise service’s agents.

Calls Abandoned – Half-Hour and Today (Nca). The number of calls
in which the caller hung up before being connected with an agent.

% Abandoned – Half-Hour and Today (%Abn). The percentage of
calls in which the caller hung up before being connected with an
agent.

Cumulative Service Level – Half-Hour and Today (Csl). The
percentage of incoming calls to the enterprise service during the
interval that were answered within a specified threshold.

% ICR Routed Calls – Half-Hour and Today (%ICR) . The number
or percentage of calls that were routed by the GEOTEL Intelligent
CallRouter. The ICR tracks the number of ICR-routed calls in the
CallsRoutedHalf fields of the central and local databases.

Example
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entsvc09_svc_array_now_to5_grid
Description
This template generates a grid that provides call counts, queue status,
and service level data in real-time and for the last five minutes for
selected service arrays. A summary row totals the values in each column
for all the service arrays listed.

Database Table

Service_Real_Time

Data

Calls talking. The number of calls on which resources for the service
array are currently talking.

Calls in queue. The number of calls to the service array that are in
queue at each peripheral now.

Average delay in queue. The average delay for calls currently in queue
for the service array.

Longest call in queue. The time that the longest call in queue for the
service array has spent in the queue.

Calls offered. The total number of incoming calls and internal calls sent
to the service array since the end of the last five-minute interval.
Calls are counted as offered as soon as they are sent to the service
array.

Calls handled. The number of calls answered and finished for the
service array since the end of the last five-minute interval.

Calls abandoned. The number of calls in which the caller hung up
before being connected. Measured since the end of the last five-
minute interval.

Average speed of answer (ASA). The average time that all calls offered
to the service array waited before being answered. Measured since
the end of the last five-minute interval.

Average handle time (AHT). The average handle time for calls handled
by resources in the service array since the end of the last five-minute
interval. Handle time includes time that resources spend in the
Talking In, Work Ready, and Work Not Ready states.

Average talk time. The average time resources for the service array
spent talking on calls handled by the service array since the end of
the last five-minute interval. Talk time includes time spent in the
Talking In, Talking Out, and Talking Other states.
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Service level. The percentage of incoming calls to the service array that
were answered within a specified threshold. (Shown since the end of
the last five-minute interval, for the current half-hour interval, and
since midnight.)

Example
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entsvc11_calls_analysis_daywise
Description
This template generates a historical grid that provides daily totals on
calls and service levels for the selected enterprise services. This grid also
provides a service summary row that averages and totals the data for the
individual enterprise services in the grid.

Database Table

Service_Half_Hour

Data

Service level. The percentage of incoming calls to the enterprise service
that were answered within a specified threshold (for the day).

Average speed of answer (ASA). The average time that all calls offered
to the enterprise service waited before being answered (for the day).

Average handle time (AHT). The average handle time for calls handled
by resources in the enterprise service for the day. Handle time
includes time that resources spend in the Talking In, Work Ready,
and Work Not Ready states.

Average delay in queue. The average delay for all calls that were in
queue for the enterprise service for the day.

Calls offered. The total number of incoming calls and internal calls sent
to the enterprise service for the day. Calls are counted as offered as
soon as they are sent to the enterprise service.

Calls handled. The number of calls answered and finished for the
enterprise service for the day. (Also provided as a percentage of the
total calls offered to the enterprise service during the half-hour
interval.)

Calls abandoned. The number of calls for the day in which the caller
hung up before being connected with an agent. (Also provided as a
percentage of the total calls offered to the enterprise service during
the half-hour interval.)

Example
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entsvc12_calls_analysis_half_hour
Description
This template generates a historical grid that provides half-hour call
counts, time in seconds for ASA, AHT, and average delay in queue, and
service levels for selected enterprise services. This grid also provides a
service summary row that averages or totals the data for the individual
enterprise services listed.

Database Table

Service_Half_Hour

Data

Service level. The percentage of incoming calls to the enterprise service
that were answered within a specified threshold during a half-hour
interval.

Average speed of answer (ASA). The average time that all calls offered
to the enterprise service waited before being answered during a
half-hour interval.

Average handle time (AHT). The average handle time for calls handled
by agents in the enterprise service for a half-hour interval. Handle
time includes time that agents spend in the Talking In, Work Ready,
and Work Not Ready states.

Average delay in queue. The average delay for all calls that were in
queue for the enterprise service for the half-hour interval.

Calls offered. The total number of incoming calls and internal calls sent
to the enterprise service for the half-hour interval. Calls are counted
as offered as soon as they are sent to the enterprise service.

Calls handled. The number of calls answered and finished for the
enterprise service during the half-hour interval. (Also provided as a
percentage of the total calls offered to the enterprise service during
the half-hour interval.)
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Calls abandoned. The number of calls during the half-hour interval in
which the caller hung up before being connected with an agent.
(Also provided as a percentage of the total calls offered to the
enterprise service during the half-hour interval.)

Example
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entsvc13_calls_offered_daywise_graph
Description
This template generates a historical, overlapped bar graph that shows the
number of calls offered per day for selected enterprise services.

Database Table

Service_Half_Hour

Data

Calls offered. The total number of incoming calls and internal calls sent
to the enterprise service for the day. Calls are counted as offered as
soon as they are sent to the enterprise service.

Example
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entsvc14_calls_handled_daywise_graph
Description
This template generates a historical, overlapped bar graph that shows the
number of calls handled per day for selected enterprise services.

Database Table

Service_Half_Hour

Data

Calls handled. The total number of calls handled to completion for all
agents in the enterprise service for the day.

Example

Download from Www.Somanuals.com. All Manuals Search And Download.



Real-Time and Historical Templates 213

8. T
em

plate R
eference

entsvc15_calls_abandoned_daywise_graph
Description
This template generates a historical, overlapped bar graph that shows the
number of calls abandoned per day for selected enterprise services.

Database Table

Service_Half_Hour

Data

Calls abandoned. The number of calls for the day in which callers hung
up before being connected with an agent.

Example
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entsvc16_calls_history_daywise_graph
Description
This template generates a historical line graph that shows the daily
history of calls for a single selected enterprise service. This template is
meant to be used with a single enterprise service only.

Database Table
Service_Half_Hour

Data
Calls abandoned. The number of calls for the day in which the caller

hung up before being connected with an agent.

Calls handled. The number of calls for the day that were answered and
finished for the enterprise service.

Calls offered. The total number of incoming calls and internal calls sent
to the enterprise service for the day. Calls are counted as offered as
soon as they are sent to the enterprise service.

Example
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entsvc17_calls_offered_half_hour
Description
This template generates a historical, overlapped bar graph that shows the
half-hour distribution of calls offered for selected enterprise services.

Database Table

Service_Half_Hour

Data

Calls offered. The total number of incoming calls and internal calls sent
to the enterprise service for each half-hour interval. Calls are
counted as offered as soon as they are sent to the enterprise service.

Example
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entsvc18_gate_half_hourly_status_grid
Description
This template generates a grid report that provides half-hour status
information for an enterprise service. In this report, an enterprise service
is considered to be a collection of gates. A gate is the Rockwell Galaxy
term for a peripheral service.

Database Table

Service_Half_Hour

Skill_Group_Half_Hour

Data

Calls Offered – Half-Hour, for All Calls (NCO) . The number of
incoming calls or internal calls sent to a specific enterprise service
(collection of gates). A call is counted as offered as soon as it is sent
to a gate.

Cumulative Service Level – Half-Hour, for All Calls (CSL). The
percentage of incoming calls to the enterprise service during the
interval that were answered within a specified threshold.

% ICR Routed Calls – Half-Hour for All Calls (ICR%) . The number
or percentage of calls that were routed by the GEOTEL Intelligent
CallRouter. The ICR tracks the number of ICR-routed calls in the
CallsRoutedHalf fields of the central and local databases.

Calls Handled – Half-Hour (NCH). The total number of calls handled
to completion by an enterprise service’s agents. (Also shown as a
percentage.)

Average Speed of Answer (ASA). The average time that all calls
offered to the enterprise service waited before being answered
during the half-hour interval.

Average Talk Time (ATT). The average talk time for calls handled by
the enterprise service during the half-hour interval.

Answer Wait Time (AWT). Sum of answer wait time for all calls
offered to the enterprise service during the half-hour interval.

Average Handle Time (AHT). Average handle time for the enterprise
service for the half-hour interval. Handle time includes time agent
spend in the Talking In, Hold, Work Ready, and Work Not Ready
states.

Calls Abandoned – Half-Hour and Today (Nca). The number and
percentage of calls in which the caller hung up before being
connected with an agent.
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Average Seconds for Abandoned Calls (ASB). The average seconds of
delay time for all calls to the enterprise service that were abandoned
in queue during the half-hour interval.

Primary Position Manned (PPM). The number of agents for the
enterprise service who were logged on to their primary assignment
gate during the interval (also referred to as the agent’s primary
position).

Occupancy (OCC). Total time, in seconds, that agents for the enterprise
service were logged on during the half-hour interval.

Percentage (%) of available agents (AVI). The percentage of agents
for the enterprise service who were in the Available state at the end
of the half-hour interval.

Percentage (%) agents talking (TLK). The percentage of agents for
the enterprise service who were in the Talking In state at the end of
the half-hour interval.

After-Call Work (CW). The number of agents who were involved in
after-call work during the interval. After-call work includes post-call
activities such as completing paperwork or consulting with
associates. Agents performing after-call work are either in the Work
Ready or Work Not Ready state.

Other Time (OTH). The sum of the time that agents spent in the Not
Ready and Busy Other states for the interval.

Example
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nettrk01_status_grid
Description
This template generates a real-time grid that shows the status of trunks
in selected network trunk groups.

Database Table

Network_Trunk_Group_Real_Time

Data

Calls In Now. The number of inbound calls in progress on the network
trunk group (in real-time).

Calls Out Now. The number of outbound calls in progress on the
network trunk group (in real-time).

Trunks idle. The number of trunks in the network trunk group that are
non-busy, or idle.

Trunks in service. The number of trunks in the network trunk group
that are in service.

Example
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nettrk02_grid_last_half_hour
Description
This template generates a real-time grid that shows the status of trunks
in selected network trunk groups for the current half-hour interval.

Database Table

Network_Trunk_Group_Real_Time

Data

All Trunks Busy. The total time that all trunks in the network trunk
group were busy for the current half-hour interval.

Calls Abandoned. The number of calls to trunks in the network trunk
group that were abandoned during the current half-hour interval. An
abandoned call is a call in which the caller hangs up before the call
is answered.

Calls In. The number of inbound calls in progress on the network trunk
group during the current half-hour interval.

Calls Out. The number of outbound calls in progress on the network
trunk group during the current half-hour interval.

In Service Time. The aggregate time that trunks in the network trunk
group have been in service during the current half-hour interval.

Calls In Now. The number of inbound calls in progress on the network
trunk group (in real-time).

Calls Out Now. The number of outbound calls in progress on the
network trunk group (in real-time).

Example
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nettrk12_grid_half_hour
Description
This template generates a historical grid that shows half-hour data on the
status of trunks in selected network trunk groups.

Database Table

Network_Trunk_Group_Half_Hour

Data

All Trunks Busy. The total time that all trunks in the network trunk
group were busy for the half-hour interval.

Calls Abandoned. The number of calls to trunks in the network trunk
group that were abandoned during a half-hour interval. An
abandoned call is a call in which the caller hangs up before the call
is answered.

Calls In. The number of inbound calls in progress on the network trunk
group during a half-hour interval.

Calls Out. The number of outbound calls in progress on the network
trunk group during a half-hour interval.

Example
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peragt01_agent_status_by_position
Description
This template generates a real-time grid report that shows the status of
selected agents by position.

Database Table

Agent_Real_time

Data

Position. The current extension on which the agent is working.

Agent name. The first and last name of the agent.

Skill group. The name of the skill group to which this agent is logged
on.

Logon date and time. The date and time that the agent logged on.

Current state. The current state of the agent:  Logged Off, Logged On,
Ready, Not Ready, Work Ready, Work Not Ready, Talking, Busy
Other, Reserved, Unknown, Calls on Hold.

Direction. The direction of the call on which the agent is currently
working:  In (Inbound), Out (Outbound), or Unknown.

Destination. The type of outbound call:  ACD, direct, or Unknown.

Last state change. The date and time that the agent’s state last changed.

Reason. A code received from the peripheral that indicates the reason
for the agent’s last state change.

Example
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peragt02_agent_status_by_skillgroup
Description
This template generates a real-time grid report that details the current
status of selected agents.

Database Table

Agent_Skill_Group_Real_Time

Data

Agent name. The first and last name of the agent.

Skill group. The name of the ICR skill group to which the agent
belongs.

Logon date and time. The date and time that the agent logged on.

Current state. The current state of the agent:  Logged Off, Logged On,
Ready, Not Ready, Work Ready, Work Not Ready, Talking, Busy
Other, Reserved, Unknown, Calls on Hold.

Last state change. The date and time that the agent’s state last changed.

Reason. A code received from the peripheral that indicates the reason
for the agent’s last state change.

Example
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peragt03_logout_status_by_agent
Description
This template generates a historical grid report that shows logon and
logout status on an agent-by-agent basis.

Database Table

Agent_Logout

Data

Agent name. The first and last name of the agent.

Agent enterprise name. The last name and first initial of the agent and
the peripheral with which the agent is associated.

Logon duration. The number of seconds that the agent was logged on
for the specified interval of the report.

Logout date and time. ICR central controller date and time when the
agent logged out.

Reason. A code received from the peripheral that indicates the reason
for the agent’s last state change.

Example
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peragt04_daily_agent_activity
Description
This template generates a historical grid that shows the daily activity of
selected agents over a specified time period. To arrive at daily values,
the ICR sums the Agent_Skill_Group_Half_Hour rows for each day.

Database Table
Agent_Skill_Group_Half_Hour

Data
Agent name. The first and last name of the agent.

Duration. The total time in seconds that the agent was logged on.

Incoming calls total. The total number of inbound ACD calls handled
by the agent during the interval. This value is incremented when the
after-call work associated with the call is completed.

Incoming calls avg. length. The average length in seconds for incoming
calls handled by the agent during the interval.

Incoming calls percent. The percentage of all calls handled by the
agent for the period that were incoming calls.

Outgoing calls total. The total number of completed outbound ACD
calls made by the agent during the interval. The value is incremented
when the after-call work associated with the call is completed.

Outgoing calls average length. The average length in seconds for
outgoing calls made by the agent for the interval.

Outgoing calls percent. The percentage of all calls handled by the agent
for the period that were outgoing calls.

Internal calls total. The total number of internal calls initiated by the
agent during the interval. The value is incremented when the
after-call work associated with the call is completed.

Internal calls average length. The average length in seconds for
completed internal calls made by the agent for the interval.

Internal calls percent. The percentage of all calls handled by the agent
for the period that were internal calls.

Callback message total. The total number of callback messages that
were processed by the agent during the interval.

Callback message average length. The average length in seconds for
callback messages that were processed by the agent during the
interval.
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Callback message percent. The percentage of all calls handled by the
agent for the period that were callback messages.

% Wrapup. The percentage of time that the agent spent in wrap-up on
all calls counted as handled during the interval. An agent performing
wrap-up is either in the Work Ready or Work Not Ready state. This
value is measured against the total time the agent was logged on
during the interval.

Example
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peragt05_agent_daily_perf
Description
This template generates a historical grid report of individual agent
performance over one or more days. To arrive at daily values, the ICR
sums the Agent_Skill_Group_Half_Hour rows for each day.

Database Table
Agent_Skill_Group_Half_Hour

Data
Agent name. The first and last name of the agent.

Abandoned calls ring. The total number of ACD calls abandoned while
ringing at the agent’s position.

Abandoned calls hold. The total number of ACD calls abandoned while
being held at the agent’s position.

Abandoned calls average. The average ring time in seconds associated
with ACD calls that were abandoned while ringing at the agent’s
position.

Abandoned calls percent. The percentage of time associated with ACD
calls that were abandoned while ringing the agent’s position. This
value is measured against the total time the agent was logged on
during the interval.

Hold calls in. The total number of completed inbound calls the agent
placed on hold. The value is incremented when the after-call work
associated with the call is completed.

Hold calls in average. The average on hold time in seconds associated
with inbound calls the agent placed on hold.

Hold calls in percent. The percentage of hold time associated with
inbound calls the agent placed on hold. This value is measured
against the total time the agent was logged on during the interval.

Hold calls out. The total number of completed outbound calls the agent
placed on hold at least once. The value is incremented when the
after-call work associated with the call is completed.

Hold calls out average. The average on hold time in seconds associated
with outbound calls the agent placed on hold.

Hold calls out percent. The percentage of hold time associated with
outbound calls the agent placed on hold. This value is measured
against the total time the agent was logged on during the interval.
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Hold calls internal. The total number of completed internal calls the
agent placed on hold for the interval. The value is incremented when
the after-call work associated with the call is completed.

Hold calls internal average. The average on hold time associated with
internal calls the agent placed on hold.

Hold calls internal percent. The percentage of hold time associated
with internal calls the agent placed on hold. This value is measured
against the total time the agent was logged on during the interval.

Assistance calls total. The total number of calls for which the agent
received supervisor assistance during the interval. The value is
incremented when the supervisor assistance call completes.

Assistance calls average. The average time in seconds that the agent
received assistance for all supervisor-assisted calls during the
interval.

Assistance calls percent. The percentage of time that the agent spent
during the interval on supervisor-assisted calls. This value is
measured against the total time the agent was logged on during the
interval.

Conference calls in. The number of incoming calls on which the agent
was in conference. Incoming calls include ACD and non-ACD calls.
The value is incremented with the agent drops off the call and the
call becomes a simple two-party call.

Conference calls average. The average time in seconds that the agent
spent in conference with calls during the interval. This value
includes hold time associated with the conference calls.

Conference calls percent. The percentage of time that the agent spent
during the interval on conference calls. The percentage includes hold
time associated with the conference calls. This value is measured
against the total time the agent was logged on during the interval.

Conference calls out. The number conference calls the agent initiated.
Initiated calls include ACD and non-ACD calls. The value is
incremented with the agent drops off the call and the call becomes a
simple two-party call.
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Conference calls out average. The average time in seconds that the
agent spent in conference on agent-initiated calls during the interval.
This value includes hold time associated with the conference calls.

Conference calls out percent. The percentage of time that the agent
spent during the half-hour interval on agent-initiated conference
calls. This percentage includes hold time associated with the
conference calls. This value is measured against the total time the
agent was logged on during the interval.

Example
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peragt06_daily_agent_detail
Description
This template generates a historical grid that shows detailed agent state
and call detail data for peripheral agents.

 Note: To generate this report, you need to have Agent State Trace enabled for
agent. See the Intelligent CallRouter System Manager Guide for
guidelines on using the Agent State Trace option.

Database Tables
Agent_State_Trace

Termination_Call_Detail

Data
Agent name. The first and last name of the agent.

Event name. The event that caused the agent’s last state change.

Date time. The date and time at which the state change occurred.

Duration. Duration of the call in seconds for a private network call.
This is the time that the switch is processing the call.

Skill group. The skill groups on which the agent has been active.

Agent state. The current state of the agent:  Logged Off, Logged On,
Ready, Not Ready, Work Ready, Work Not Ready, Talking, Busy
Other, Reserved, Unknown, Calls on Hold.

Direction. The direction of the call on which the agent is currently
working:  In (Inbound), Out (Outbound), or Unknown.

Reason. Code received from the peripheral indicating the reason for the
state change.

ANI. The ANI value for the call. The ANI is a feature that provides the
billing phone number of the phone from which the call originated.

Digits dialed. Digits dialed on an outbound call.

Example
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periph01_peripheral_status_report
Description
This template generates a real-time grid that shows switch status, call
and agent status, and service levels. You can use this template with any
peripheral supported by the ICR.

Database Table
Peripheral_Real_Time

Data
Status. The current failure state of the peripheral:  0 = normal operation;

1 - 31 = failures that do not affect functionality; 32 - 63 = degraded
operation (call routing still possible); 64 - 127 = failures that prevent
call routing.

Online. The current on-line state of the peripheral as determined by the
Central Controller:  0 = off-line; 1 = on-line.

Calls in progress. The total number of calls to the peripheral that are
currently in queue or being handled at the peripheral now.

Agents logged on. The number of agents who are logged on at the end
of the five-minute interval. Logged On is a state in which agents are
known to the system, but may or may not be ready to receive calls.
Logged On is also referred to as Signed On.

Mode. The current mode of the peripheral as reported by the Peripheral
Gateway (PG):  0 = off-line; 1 = on-line.

Service level – Last Half-Hour and Today. The percentage of
incoming calls to services related to this peripheral during the
interval that were answered within a specified threshold.

Example
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periph02_galaxy_software_status
Description
This template generates a real-time grid that shows all trunks busy, calls
in progress, SWT TRMS, and DI Groups status. This template is for use
with Rockwell Galaxy ACDs only.

Database Table
Peripheral_Real_Time

Data
ATB (All Trunks Busy). The state of a trunk group when all trunks are

in use. The trunk group cannot accept any new inbound or outbound
calls in this state. The ICR tracks the amount of time during which
all trunks in a trunk group are busy.

Calls in progress. The total number of calls to the peripheral that are
currently in queue or being handled at the peripheral now.

SWT TRMS Inactive (Terminations out of sync). Galaxy-specific
data.

SWT TRMS (Terminations implemented). Galaxy-specific data.

DI Groups Inactive (Switch level out of sync). Galaxy-specific data.

DI Groups Active (Switch level implemented). Galaxy-specific data.

Example
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periph03_galaxy_hardware_status
Description
This template generates a real-time grid that shows processor, data
receive, control, and switch clock status. This template is for use with
Rockwell Galaxy ACDs only.

Database Table
Peripheral_Real_Time

Data
Processor A Fnct Status. Galaxy-specific data.

Processor B Fnct Status. Galaxy-specific data.

Inter-Prcsr Link Status. Galaxy-specific data.

Data Rcv Status. Galaxy-specific data.

Control Status. Galaxy-specific data.

Switch Clock Status. Galaxy-specific data.

Example
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perskg01_status_#_graph
Description
This template generates a real-time, stacked bar graph that shows the
number of active agents from the selected peripheral skill groups who
are currently in any of four call handling states.

Database Table
Skill_Group_Real_Time

Data
Agents available. The number of agents who are in the Available state

(that is, not occupied with any call activity and ready to accept
calls).

Agents idle. The number of agents who are in the Not Ready state (that
is, logged on, not involved in a call or after-call work, and not
available to receive a call).

Agents talking. The number of agents involved in inbound, outbound,
or internal calls (that is, Talking In, Talking Out, or Talking Other).

Agents in wrap-up. The number of agents who are involved in
after-call work. Agents performing wrap-up are either in the Work
Ready or Work Not Ready state.

Example

The total count of agents in any of these four states is the number of
agents Logged On.
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perskg02_status_grid
Description
This template generates a real-time grid that shows the number of agents
from selected peripheral skill groups who are signed on (logged on),
how these agents break down numerically into nine states, and how they
break down on a percentage basis into five states. A total row at the
bottom of the grid totals or averages the data for all the peripheral skill
groups listed.

Database Table
Skill_Group_Real_Time

Data

Agents signed on. The number of agents who are currently signed on to
the peripheral skill group (that is, agents who are known to the
system, but may or may not be ready to accept calls).

Agents idle. The number of agents who are in the Not Ready state (that
is, logged on, not involved in a call or after-call work, and not
available to receive a call).

Agents available. The number of agents who are in the Available state
(that is, not occupied with any call activity and ready to accept
calls).

Agents ready. The number of agents who are logged on and are either
talking on a call or performing after-call work, but are presumed to
be ready to accept calls when done.

Agents talking in. The number of agents talking on inbound calls.

Agents talking out. The number of agents talking on outbound calls.

Agents talking other. The number of agents who are talking on calls
other than inbound and outbound calls (for example, internal calls).

Agents in wrap-up. The number of agents who are involved in
after-call work. After-call work includes activities such as
completing paperwork or consultation work. An agent performing
after-call work is in either the Work Ready or Work Not Ready
state.

Agents in hold. The number of agents in the skill group who are in the
Hold state (that is, agents who have all active calls on hold and are
performing no other activity).
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Agents reserved. The number of agents currently in the reserved state.
A reserved agent is awaiting an interflowed call and is unavailable
to receive any incoming calls. This state applies to agents on
Northern Telecom Meridian and Aspect CallCenter ACDs only.

Agents in busy other. The number of agents who are in the Busy Other
state (that is, busy in skill groups other than the one presently being
examined). An agent can be active in only one skill group at a time.
Therefore, while active in one skill group, the agent is considered by
the other skill groups to be in the Busy Other state.

Percent agents idle. The percentage of all agents in the peripheral skill
group who are in the Not Ready state.

Percent agents available. The percentage of all agents in the peripheral
skill group who are in the Available state.

Percent agents talking. The percentage of all agents in the peripheral
skill group who are talking on inbound, outbound, or internal calls.

Percent agents in wrap-up. The percentage of all agents in the
peripheral skill group who are involved in after-call work.

Percent agents in busy other. The percentage of all agents in the skill
group who are in the Busy Other state.

Example
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perskg03_status_%_graph
Description
This template generates a real-time bar graph that shows the percentage
of agents from selected peripheral skill groups who are in any of four
call handling states.

Database Table
Skill_Group_Real_Time

Data
Agents available. The percentage of all agents in the peripheral skill

group who are not occupied with any call activity and are ready to
accept calls.

Agents idle. The percentage of all agents in the peripheral skill group
who are idle (that is, logged on, not involved in a call or after-call
work, and not available to receive a call). Idle is also referred to as
Not Ready.

Agents talking. The percentage of all agents in the peripheral skill
group who are talking on a call (inbound, outbound, or internal).

Agents in wrap-up. The percentage of all agents in the peripheral skill
group who are involved in after-call work. An agent performing
after-call work is in either the Work Ready or Work Not Ready
state.

Example
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perskg04_status_grid_to5
Description
This template generates a rolling five-minute grid that shows full-time
equivalent (FTE) values for agents in selected peripheral skill groups.
FTE is the number of full-time agents that would be required during a
period to perform the work done in that period. To calculate the FTE,
divide the number of seconds of work performed by the number of
seconds in the period. For example, if agents spent a total of 1200
seconds handling calls during a five-minute (300-second) period, the
FTE for call handling would be as follows:

1200 person seconds / 300 seconds = 4 persons

This template uses cumulative, or rolling, five-minute data derived from
the real-time data to arrive at an FTE value. Data in the grid is
continuously updated. This template also provides the percentage of
agents currently in any of four call handling states. A total row totals or
averages the data for all the peripheral skill groups listed.

Database Table

Skill_Group_Real_Time

Data

Full-time equivalent (FTE) logged on. The FTE number of currently
logged on agents in the peripheral skill group. Logged on is not an
agent state, but rather a necessary condition to being in any state.

FTE idle. The FTE number of currently idle agents in the peripheral
skill group (that is, agents who are logged on, not involved in a call
or after-call work, and are not available to receive a call.) Idle is also
called Not Ready.

FTE available. The FTE number of agents currently in the Available
state (that is, not occupied with any call activity and ready to accept
calls).

FTE talking. The FTE number of agents currently talking on a call
(inbound, outbound, or internal).

FTE in wrap-up. The FTE number of agents currently involved in
after-call work (that is, agents in the Work Ready or Work Not
Ready states).

FTE hold. The FTE value for the number of agents in the Hold state
during an interval. The Hold state is a state in which an agent has all
active calls on hold and is performing no other activity.

FTE reserved. The FTE value for the number of agents in the Reserved
state during an interval. The Reserved state is a state in which the
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agent is awaiting an interflowed call and is unavailable to receive
any incoming calls. This state applies to agents on Northern
Telecom Meridian and Aspect CallCenter ACDs only.

FTE busy other. The FTE number of agents who are in the Busy Other
state (that is, busy in skill groups other than the one presently being
examined). An agent can be active in only one skill group at a time.
Therefore, while active in one skill group, the agent is considered by
the other skill groups to be in the Busy Other state.

Percent agents idle. The percentage of time that all agents in the
peripheral skill group were in the idle state (that is, logged on, not
involved in a call or after-call work, and not available to receive a
call). Idle is also called Not Ready.

Percent agents available. The percentage of time that all agents in the
peripheral skill group were not occupied with any call activity and
were ready to accept calls.

Percent agents talking. The percentage of time that all agents in the
peripheral skill group were talking on a call (inbound, outbound, or
internal).

Percent agents in wrap-up. The percentage of time that all agents in
the peripheral skill group were involved in after-call work (that is,
time spent in the Work Ready or Work Not Ready states).

Percent agents in busy other. The percentage of time that all agents in
the skill group spent in the Busy Other state.

Example
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perskg05_utilization_graph
Description
This template generates a real-time bar graph that shows a percentage
utilization of agents in the selected peripheral skill groups. Percentage
utilization is the ratio between the time agents spend handling calls and
the time agents were logged on.

Database Table

Skill_Group_Real_Time

Data

Percent utilization. The percent utilization is computed by dividing the
total time agents spent handling calls by the total time agents were
ready. (The Ready Time is calculated by subtracting the Not Ready
Time from the total time that agents were Logged On.)

Example
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perskg06_halfhour_aht_grid
Description
This template generates a historical grid that displays call counts and
handle time data by the half-hour for selected peripheral skill groups.
This template also includes a summary row for each day of data, which
provides daily averages and totals; and a summary row for each skill
group, which provides averages and totals for the particular skill group.

Database Table

Skill_Group_Half_Hour

Data

Calls handled. The total number of calls handled to completion for the
peripheral skill group.

Agent calls out. The total number of outbound calls made by agents in
the peripheral skill group.

Average handle time. The average handle time for calls handled by
agents in the peripheral skill group. Handle time includes time that
agents spend in the Talking In, Work Ready, and Work Not Ready
states.

Average talk time. The average talk time for calls to the peripheral skill
group. Talk time includes time spent in the Talking In, Talking Out,
and Talking Other states.

Average wrap-up time. The average time agents in the peripheral skill
group spent in after-call work (that is, in the Work Ready or Work
Not Ready states).

Full-time equivalent (FTE) number of agents. The FTE number of
logged on agents for the peripheral skill group. This value is the
total time agents were logged on during the interval divided by the
total number of seconds in the interval.

See also: For more information on FTE, see “perskg04_status_grid_to5,” earlier
in this chapter.
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Example

Download from Www.Somanuals.com. All Manuals Search And Download.



242 Template Reference

perskg07_daily_aht_grid
Description
This template generates a historical grid that displays call counts and
handle time data on a per-day basis for selected peripheral skill groups.
This template also includes a summary row that totals or averages the
data for all skill groups listed.

Database Table

Skill_Group_Half_Hour

Data

Calls handled. The total number of calls handled to completion for all
agents in the peripheral skill group.

Agent calls out. The total number of outbound calls made by agents in
the peripheral skill group.

Average handle time. The average handle time for calls handled by
agents in the peripheral skill group. Handle time includes time that
agents spend in the Talking In, Work Ready, and Work Not Ready
states.

Average talk time. The average talk time for calls to the peripheral skill
group. Talk time includes time spent in the Talking In, Talking Out,
and Talking Other states.

Average wrap-up time. The average time that agents in the peripheral
skill group spent in after-call work. Agents performing after-call
work are in either the Work Ready or Work Not Ready state.
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Full-time equivalent (FTE) number of agents. The FTE number of
logged on agents for the peripheral skill group. This value is the
total time that agents were logged on during the interval divided by
the number of seconds in the interval. This provides the number of
full-time agents logged on for the interval.

See also: For more information on FTE, see “perskg04_status_grid_to5,” earlier
in this chapter.

Example
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perskg08_halfhour_perform_grid
Description
This template generates a historical grid that shows half-hour, full-time
equivalent (FTE) values for agents in selected peripheral skill groups.
FTE is the number of full-time agents that would be required during a
period to perform the work done in that period. FTE values are derived
by taking the time that agents are in a particular state during an interval
and dividing that time by the number of seconds in the interval.

See also: For more information on FTE, see “perskg04_status_grid_to5,” earlier
in this chapter.

This grid has date and skill group summary rows that total the data for
the day and the individual skill group respectively.

Database Table

Skill_Group_Half_Hour

Data

Full-time equivalent (FTE) sign-on. The FTE number agents logged
on to the peripheral skill group.

FTE idle. The FTE number of idle agents (that is, agents who were
logged on, not involved in a call or after-call work, and were not
available to receive a call). Idle is also referred to as Not Ready.

FTE available. The FTE number of agents in the Available state (that
is, not occupied with any call activity and ready to accept calls).

FTE talking. The FTE number of agents involved in calls (inbound,
outbound, or internal).

FTE wrap-up. The FTE number of agents involved in after-call work.
An agent performing after-call (wrap-up) work is in either the Work
Ready or the Work Not Ready state.

FTE hold. The FTE value for the number of agents in the Hold state
during an interval. The Hold state is a state in which an agent has all
active calls on hold and is performing no other activity.

FTE reserved. The FTE value for the number of agents in the Reserved
state during an interval. The Reserved state is state in which the
agent is awaiting an interflowed call and is unavailable to receive
any incoming calls. This state applies to agents on Northern
Telecom Meridian and Aspect CallCenter ACDs only.
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FTE busy other. The FTE number of agents who are in the Busy Other
state (that is, busy in skill groups other than the one presently being
examined). An agent can be active in only one skill group at a time.
Therefore, while active in one skill group, the agent is considered by
the other skill groups to be in the Busy Other state.

Example
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perskg09_normalized_agt_state
Description
This template generates a stacked bar graph that shows the percentage of
the time that all agents in the peripheral skill group were in specific
states during an interval. The normalized value is derived from the total
time that all agents were logged on during the interval.

Database Table

Skill_Group_Half_Hour

Data

% Available. The percentage of time that all agents were in the
Available state during the interval.

% Idle. The percentage of time that all agents were in the Idle state (that
is, Not Ready), during the interval.

% Talking. The percentage of time that all agents were in the Talking
In, Talking Out, or Talking Other states during the interval.

% Wrap-up. The percentage of time that all agents were in call wrap-up
(that is, performing after-call work) during the interval.

Example
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perskg10_forecast_agents_status_grid
Description
This template generates a real-time grid that shows the actual agents
signed on versus those forecasted. For the schedule import portion of
this report (scheduled and required agents), you need the optional
GEOTEL•Schedule Import feature.

Database Table

Skill_Group_Real_Time

Schedule_Import_Real_Time

Data
Agents logged in. The number of agents currently logged in to the

peripheral skill group.

Required agents. The forecasted value for the number of agents needed
for this peripheral skill group (value is imported from a third-party
workforce management system).

Scheduled agents. The number of agents scheduled (value is imported
from a third-party workforce management system).

Example
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persvc01_queue_delay_status
Description
This template generates a real-time bar graph that shows the current
status of call queues for selected peripheral services.

Database Table

Service_Real_Time

Data

Average delay in queue. The average delay for calls currently in queue
for the peripheral service.

Expected delay in queue. The predicted delay for any new call added to
the queue for the peripheral service. This is valid only if no agents
are available for the peripheral service.

Longest call in queue. The time that the longest call in queue for the
peripheral service has spent in the queue.

Average speed of answer (ASA). The average time that all calls offered
to the peripheral service during the current five-minute interval
waited before being answered.

Example
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persvc02_calls_status
Description
This template generates a real-time, stacked bar graph that displays the
number of calls on which agents are talking and the number of calls in
queue for selected peripheral services.

Database Table
Service_Real_Time

Data
Calls talking. The number of calls to the peripheral service on which

agents are currently talking.

Calls in queue. The number of calls to the peripheral service that are in
queue at the peripheral now.

Example
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persvc03_effect_of_aban_on_servicelevel
Description
This template generates a real-time grid that shows the effect of
abandoned calls on the service levels of selected peripheral services.
This grid also provides a summary row that totals or averages the data in
each column for all services listed in the grid.

Database Table

Service_Real_Time

Data

Calls offered. The total number of incoming calls and internal calls sent
to the peripheral service. Calls are counted as offered as soon as they
are sent to the peripheral service.

Calls handled. The number of calls answered and finished for the
peripheral service.

Calls abandoned. The number of calls in which the caller hung up
before being connected with an agent.

Calls abandoned within service level. The number of calls to the
peripheral service that were abandoned within the ICR service level
threshold.

Service level without abandoned calls. The ICR service level for the
peripheral service without including abandoned calls in the
calculation.

See also: For more information on service level calculations, see Chapter 7,
“Available Data.”

Service level with abandoned calls. The ICR service level for the
peripheral service including abandoned calls in the calculation.

Example
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persvc04_calls_trend_analysis
Description
This template generates a real-time grid that shows call counts and
service levels for selected peripheral services since the end of the last
five-minute interval, for the current half-hour interval, and since
midnight. A summary row totals the call count data for all services in the
grid.

Database Table

Service_Real_Time

Data

Calls offered. The total number of incoming calls and internal calls sent
to the peripheral service during the interval. Calls are counted as
offered as soon as they are sent to the peripheral service.

Calls answered. The total number of calls to the peripheral service that
were answered during the interval. A call is counted as answered
when it reaches an agent.

Calls abandoned. The total number of calls during the interval in which
the caller hung up before being connected with an agent.

Service level. The percentage of incoming calls to the service during the
interval that were answered within a specified threshold.

Example
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persvc05_calls_offered_half_pie
Description
This template generates a real-time pie chart that shows the distribution
of calls offered to selected peripheral services for the current half-hour
interval. The calls offered value (for example 34.09%) is a percentage of
the total calls offered to the peripheral services listed in the chart legend.

Database Table

Service_Real_Time

Data

Calls offered. The percentage of the total of incoming and internal calls
sent to the peripheral services for the current half-hour interval.
Calls are counted as offered as soon as they are sent to the peripheral
service.

Example
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persvc06_serv_level_monitor_graph
Description
This template generates a real-time bar graph that shows service levels
for selected peripheral services since the end of the last five-minute
interval, for the current half-hour interval, and since midnight.

Database Table
Service_Real_Time

Data
Service level. The percentage of incoming calls to the peripheral service

during the interval that were answered within a specified threshold.

Example
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persvc07_now_to5_grid
Description
This template generates a grid that provides call counts, queue status,
and service level data in real-time and since the end of the last
five-minute interval for selected peripheral services. A summary row
totals the values in each column for all the peripheral services listed.

Database Table

Service_Real_Time

Data

Calls talking. The number of calls on which agents for the peripheral
service are currently talking.

Calls in queue. The number of calls to the peripheral service that are in
queue at each peripheral now.

Average delay in queue. The average delay for calls currently in queue
for the peripheral service.

Longest call in queue. The time that the longest call in queue for the
peripheral service has spent in the queue.

Calls offered. The total number of incoming calls and internal calls sent
to the peripheral service since the end of the last five-minute
interval. Calls are counted as offered as soon as they are sent to the
peripheral service.

Calls handled. The number of calls answered and finished for the
peripheral service since the end of the last five-minute interval.

Calls abandoned. The number of calls since the end of the last
five-minute interval in which the caller hung up before being
connected with an agent.

Average speed of answer (ASA). The average time that all calls offered
to the peripheral service waited before being answered. Measured
since the end of the last five-minute interval

Average handle time (AHT). The average handle time for calls handled
by agents in the peripheral service since the end of the last
five-minute interval. Handle time includes time that agents spend
talking on inbound calls (Talking In) and performing after-call work
(Work Ready and Work Not Ready).
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Average talk time. The average time that agents for the peripheral
service spent talking on calls since the end of the last five-minute
interval. Talk time includes time spent in the Talking In, Talking
Out, and Talking Other states.

Service level. The percentage of incoming calls to the peripheral service
that were answered within a specified threshold (shown since the
end of the last five-minute interval, for the current half-hour interval,
and since midnight).

Example
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persvc08_gate_realtime_status_grid
Description
This template generates a grid report that provides real-time, half-hour,
and daily status information for gates. A gate is the Rockwell Galaxy
term for a service.

Database Table
Service_Real_Time

Data
Calls Offered – Real-Time, Half-Hour, Today (Nco). The number of

incoming calls or internal calls that are sent to a specific gate. In
real-time data, a call is counted as offered as soon as it is sent to the
gate.

Calls in Queue (Que). The number of calls to the gate that are in queue
now.

Calls Held (Hld). The number of calls to the gate that are currently
queued for longer than the service level threshold.

Primary Position Manned (Ppm). The number of agents for the gate
who are logged on to their primary assignment gate (also referred to
as the agent’s primary position).

Available Agents (Aav). The number of agents for the gate who are
ready to accept calls and are not currently involved in call work.

Incoming Calls (In). The number of agents who are talking on
incoming calls.

Outgoing Calls (Out). The number of agents who are talking on
outgoing calls.

After-Call Work (Cw). The number of agents who are involved in
after-call work. After-call work includes post-call activities such as
completing paperwork or consulting with associates. Agents
performing after-call work are either in the Work Ready or Work
Not Ready state.

Other Time (Othr). The sum of the time that agents spend in the Not
Ready and Busy Other states.

Average Speed of Answer (Asa). The average time that all calls offered
to the gate during the current five-minute interval waited before
being answered.

Calls Handled – Half-Hour and Today (Nch). The total number of
calls handled to completion by a gate’s agents.
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Calls Abandoned – Half-Hour and Today (Nca). The number and
percentage of calls in which the caller hung up before being
connected with an agent.

Cumulative Service Level – Half-Hour and Today (Csl). The
percentage of incoming calls to the gate during the interval that were
answered within a specified threshold.

% ICR Routed Calls – Hour and Today (%ICR). The number or
percentage of calls that were routed by the GEOTEL Intelligent
CallRouter. The ICR tracks the number of ICR-routed calls in the
CallsRoutedHalf fields of the central and local databases.

Example
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persvc09_forecast_aht_offer_grid
Description
This template generates a grid report that compares data on actual and
forecasted calls offered and average handle times. For the schedule
import portion of this report (the forecasted values), you need the
optional GEOTEL•Schedule Import feature.

Database Table

Service_Real_Time

Schedule_Import_Real_Time

Data
Calls offered last half hour. The number of incoming calls or internal

calls sent to the service during the current five-minute interval. The
actual number values are compared to the forecasted values.

Average handle time. The average handle time for calls to the service
during the current five-minute interval. Handle time includes time
agents spend in the Talking In, Hold, Work Ready, and Work Not
Ready states. The actual values are compared to the forecasted
values.

Example
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persvc11_calls_analysis_daywise
Description
This template generates a historical grid that shows daily call totals and
service levels for selected peripheral services. This grid also provides
service summary rows that total or average the data for the individual
peripheral services in the grid.

Database Table

Service_Half_Hour

Data

Service level. The percentage of incoming calls to the peripheral service
that were answered within a specified threshold (for the day).

Average speed of answer (ASA). The average time that all calls offered
to the peripheral service waited before being answered (for the day).

Average handle time (AHT). The average handle time for calls handled
by agents in the peripheral service for the day. Handle time includes
time that agents spend talking on inbound calls (Talking In) and
performing after-call work (Work Ready and Work Not Ready).

Average delay in queue. The average delay for all calls that were in
queue for the peripheral service for the day.

Calls offered. The total number of incoming calls and internal calls sent
to the peripheral service for the day. Calls are counted as offered as
soon as they are sent to the peripheral service.
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Calls handled. The number of calls answered and finished for the
peripheral service for the day. (Also provided as a percentage of the
total calls offered to the service during the half-hour interval.)

Calls abandoned. The number of calls to the peripheral service for the
day in which the caller hung up before being connected with an
agent. (Also provided as a percentage of the total calls offered to the
service during the half-hour interval.)

Example
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persvc12_calls_analysis_half_hour
Description
This template generates a historical grid that provides half-hour call
counts, time in seconds for ASA, AHT, and average delay in queue, and
service levels for selected peripheral services. This grid also provides a
service summary row that averages or totals the data for the individual
peripheral services listed.

Database Table

Service_Half_Hour

Data

Service level. The percentage of incoming calls to the peripheral service
that were answered within a specified threshold during the half-hour
interval.

Average speed of answer (ASA). The average time that all calls offered
to the peripheral service waited before being answered during the
half-hour interval.

Average handle time (AHT). The average handle time for calls handled
by agents in the peripheral service for the half-hour interval. Handle
time includes time that agents spend talking on inbound calls
(Talking In) and performing after-call work (Work Ready and Work
Not Ready).

Average delay in queue. The average delay for all calls that were in
queue for the peripheral service for the half-hour interval.

Calls offered. The total number of incoming calls and internal calls sent
to the peripheral service during the half-hour interval. Calls are
counted as offered as soon as they are sent to the peripheral service.
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Calls handled. The number of calls answered and finished for the
peripheral service during the half-hour interval. (Also provided as a
percentage of the total calls offered to the peripheral service during
the interval.)

Calls abandoned. The number of calls during the half-hour interval in
which the caller hung up before being connected with an agent.
(Also provided as a percentage of the total calls offered to the
peripheral service during the interval.)

Example
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persvc13_calls_offered_daywise_graph
Description
This template generates a historical, overlapped bar graph that shows the
number of calls offered per day for the selected peripheral services.

Database Table

Service_Half_Hour

Data

Calls offered. The total number of incoming calls and internal calls sent
to the peripheral service for the day. Calls are counted as offered as
soon as they are sent to the peripheral service.

Example
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persvc14_calls_handled_daywise_graph
Description
This template generates a historical, overlapped bar graph that shows the
number of calls handled per day for the selected peripheral services.

Database Table

Service_Half_Hour

Data

Calls handled. The total number of calls handled to completion for all
agents in the peripheral service for the day.

Example

Download from Www.Somanuals.com. All Manuals Search And Download.



Real-Time and Historical Templates 265

8. T
em

plate R
eference

persvc15_calls_abandoned_daywise_graph
Description
This template generates a historical, overlapped bar graph that shows the
number of calls abandoned per day for the selected peripheral services.

Database Table

Service_Half_Hour

Data

Calls abandoned. The number of calls for the day in which callers hung
up before being connected with an agent.

Example
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persvc16_calls_history_daywise_graph
Description
This template generates a historical line graph that shows the history of
calls for a single selected peripheral service. This template is meant to
be used with a single peripheral service only.

Database Table
Service_Half_Hour

Data
Calls abandoned. The number of calls for the day in which callers hung

up before being connected with an agent.

Calls handled. The number of calls for the day that were answered and
finished for the peripheral service.

Calls offered. The total number of incoming calls and internal calls sent
to the peripheral service for the day. Calls are counted as offered as
soon as they are sent to the peripheral service.

Example
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persvc17_calls_offered_half_hour
Description
This template generates a historical, overlapped bar graph that shows the
number of calls offered across selected peripheral services in half-hour
samples.

Database Table
Service_Half_Hour

Data
Calls offered. The total number of incoming calls and internal calls sent

to the peripheral service for each half-hour interval. Calls are
counted as offered as soon as they are sent to the peripheral service.

Example
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persvc18_gate_half_hourly_status_grid
Description
This template generates a grid report that provides half-hour status
information for an peripheral service. In this report, a peripheral service
is considered to be a gate. A gate is the Rockwell Galaxy term for a
service.

Database Table

Service_Half_Hour
Skill_Group_Half_Hour

Data

Calls Offered – Half-Hour, for All Calls (NCO) . The number of
incoming calls or internal calls sent to a specific service (collection
of gates). A call is counted as offered as soon as it is sent to a gate.

Cumulative Service Level – Half-Hour, for All Calls (CSL). The
percentage of incoming calls to the service during the interval that
were answered within a specified threshold.

% ICR Routed Calls – Half-Hour for All Calls (ICR%) . The number
or percentage of calls that were routed by the GEOTEL Intelligent
CallRouter. The ICR tracks the number of ICR-routed calls in the
CallsRoutedHalf fields of the central and local databases.

Calls Handled – Half-Hour (NCH). The total number of calls handled
to completion by a service’s agents. (Also shown as a percentage.)

Average Speed of Answer (ASA). The average time that all calls
offered to the service waited before being answered during the half-
hour interval.

Average Talk Time (ATT). The average talk time for calls handled by
the service during the half-hour interval.

Answer Wait Time (AWT). Sum of answer wait time for all calls
offered to the service during the half-hour interval.

Average Handle Time (AHT). Average handle time for the service for
the half-hour interval. Handle time includes time agent spend in the
Talking In, Hold, Work Ready, and Work Not Ready states.

Calls Abandoned – Half-Hour and Today (Nca). The number and
percentage of calls in which the caller hung up before being
connected with an agent.

Average Seconds for Abandoned Calls (ASB). The average seconds of
delay time for all calls to the service that were abandoned in queue
during the half-hour interval.
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Primary Position Manned (PPM). The number of agents for the
service who were logged on to their primary assignment gate during
the interval (also referred to as the agent’s primary position).

Occupancy (OCC). Total time, in seconds, that agents for the service
were logged on during the half-hour interval.

Percentage (%) of available agents (AVI). The percentage of agents
for the service who were in the Available state at the end of the
half-hour interval.

Percentage (%) agents talking (TLK). The percentage of agents for
the service who were in the Talking In state at the end of the
half-hour interval.

After-Call Work (CW). The number of agents who were involved in
after-call work during the interval. After-call work includes post-call
activities such as completing paperwork or consulting with
associates. Agents performing after-call work are either in the Work
Ready or Work Not Ready state.

Other Time (OTH). The sum of the time that agents spent in the Not
Ready and Busy Other states for the interval.

Example
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routes01_queue_delay_status
Description
This template generates a real-time bar graph that shows data on the
current status of call queues for the selected routes.

Database Table

Route_Real_Time

Data

Average delay in queue. The average delay for calls currently in queue
for the route.

Longest call in queue. The time that the longest call in queue for the
route has spent in the queue.

Average speed of answer (ASA). The average time that all calls offered
to the route during the current five-minute interval waited before
being answered.

Example
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routes02_calls_status
Description
This template generates a real-time bar graph that shows the number of
calls in progress versus the number of calls in queue for the selected
routes.

Database Table
Route_Real_Time

Data
Calls talking. The number of calls to the route on which agents are

currently talking.

Calls in queue. The number of calls to the route that are in queue now.

Example
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routes03_effect_of_aban_on_servicelevel
Description
This template generates a real-time grid that shows the effect of
abandoned calls on the service levels of selected routes. A summary row
totals or averages the data for all routes listed in the grid.

Database Table
Route_Real_Time

Data
Calls offered. The total number of incoming calls and internal calls sent

to the route. Calls are counted as offered as soon as they are sent to
the route.

Calls handled. The number of calls answered and finished for the route.

Calls abandoned. The number of calls in which the caller hung up
before being connected with an agent.

Calls abandoned within service level. The number of calls to the route
that were abandoned within the ICR service level threshold.

Service level without abandoned calls. The ICR service level for the
route without including abandoned calls in the calculation.

See also: For more information on service level calculations, see Chapter 7,
“Available Data.”

Service level with abandoned calls. The ICR service level for the route
including abandoned calls in the calculation.

Example
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routes04_calls_trend_analysis
Description
This template generates a real-time grid that shows call counts and
service levels for routes since the end of the last five-minute interval, for
the current half-hour interval, and since midnight. This grid also
provides a summary row that totals the call count data for all services in
the grid.

Database Table

Route_Real_Time

Data

Calls offered. The total number of incoming calls and internal calls sent
to the route during the interval. Calls are counted as offered as soon
as they are sent to the route.

Calls answered. The total number of calls to the route that were
answered during the interval. A call is counted as answered when it
reaches an agent.

Calls abandoned. The total number of calls during the interval in which
the caller hung up before being connected with an agent.

Service level. The percentage of incoming calls to the route during the
interval that were answered within a specified threshold.

Example
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routes05_calls_offered_half_pie
Description
This template generates a real-time pie chart that shows the distribution
of calls offered to selected routes for the current half-hour interval. The
calls offered value (for example 4.07%) is a percentage of the total calls
offered to the routes listed in the chart legend.

Database Table

Route_Real_Time

Data

Calls offered. The percentage of the total of incoming and internal calls
sent to the route for the current half-hour interval. Calls are counted
as offered as soon as they are sent to the route.

Example
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routes06_serv_level_monitor_graph
Description
This template generates a real-time bar graph that shows service levels
for the selected routes since the end of the last five-minute interval, for
the current half-hour interval, and since midnight.

Database Table
Route_Real_Time

Data
Service level. The percentage of incoming calls to the route during the

interval that were answered within a specified threshold.

Example
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routes07_now_to5_grid
Description
This template generates a grid that provides call counts, queue status,
and service level data in real-time and for the last five minutes for
selected routes. A summary row totals the values in each column for all
the routes listed.

Database Table

Route_Real_Time

Data

Calls talking. The number of calls on which agents for the route are
currently talking.

Calls in queue. The number of calls to the route that are in queue at
each peripheral now.

Average delay in queue. The average delay for calls currently in queue
for the route.

Longest call in queue. The time that the longest call in queue for the
route has spent in the queue.

Calls offered. The total number of incoming calls and internal calls sent
to the route since the end of the last five-minute interval. Calls are
counted as offered as soon as they are sent to the route.

Calls handled. The number of calls answered and finished for the route
since the end of the last five-minute interval. (Also provided as a
percentage of the total calls offered to the route during the half-hour
interval.)

Calls abandoned. The number of calls in which the caller hung up
before being connected with an agent. Measured since the end of the
last five-minute interval. (Also provided as a percentage of the total
calls offered to the route during the half-hour interval.)

Average speed of answer (ASA). The average time that all calls offered
to the route waited before being answered. Measured since the end
of the last five-minute interval.

Average handle time (AHT). The average handle time for calls handled
by agents for the route since the end of the last five-minute interval.
Handle time includes time that agents spend talking on inbound calls
(Talking In) and performing after call work (Work Ready and Work
Not Ready).
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Average talk time. The average time that agents for this route spent
talking on calls handled on the route since the end of the last
five-minute interval. Talk time includes time spent in the Talking In,
Talking Out, and Talking Other states.

Service level. The percentage of incoming calls to the route that were
answered within a specified threshold during the interval (shown
since the end of the last five-minute interval, for the current
half-hour interval, and since midnight).

Example
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routes11_calls_analysis_daywise
Description
This template generates a historical grid that provides daily totals on
service levels, queue status, and call counts for selected routes. A
summary row totals or averages the data for individual routes.

Database Table
Route_Half_Hour

Data
Service level. The percentage of incoming calls to the route that were

answered within a specified threshold (for the day).

Average speed of answer (ASA). The average time that all calls offered
to the route waited before being answered (for the day).

Average handle time (AHT). The average handle time for calls handled
by agents for the route (for the day). Handle time includes time that
agents spend talking on inbound calls (Talking In) and performing
after-call work (Work Ready and Work Not Ready).

Average delay in queue. The average delay for all calls that were in
queue for the route for the day.

Calls offered. The total number of incoming calls and internal calls sent
to the route for the day. Calls are counted as offered as soon as they
are sent to the route.
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Calls handled. The number of calls answered and finished for the route
during the current five-minute interval. (Also provided as a
percentage of the total calls offered to the route during the half-hour
interval.)

Calls abandoned. The number of calls during the day in which the
caller hung up before being connected with an agent. (Also provided
as a percentage of the total calls offered to the route during the half-
hour interval.)

Example
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routes12_calls_analysis_half_hour
Description
This template generates a historical grid that provides half-hour call
counts, time in seconds for ASA, AHT, and average delay in queue, and
service levels for selected routes. This grid also provides a route
summary row that averages or totals the data for individual routes listed.

Database Table

Route_Half_Hour

Data

Service level. The percentage of incoming calls to the route that were
answered within a specified threshold during the half-hour interval.

Average speed of answer (ASA). The average time that all calls offered
to the route waited before being answered during the half-hour
interval.

Average handle time (AHT). The average handle time for calls handled
by agents for the route for the half-hour interval. Handle time
includes time that agents spend talking on inbound calls (Talking In)
and performing after-call work (Work Ready and Work Not Ready).

Average delay in queue. The average delay for all calls that were in
queue for the route for the half-hour interval.

Calls offered. The total number of incoming calls and internal calls sent
to the route during the half-hour interval. Calls are counted as
offered as soon as they are sent to the route.
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Calls handled. The number of calls answered and finished for the route
during the half-hour interval. (Also provided as a percentage of the
total calls offered to the route during the half-hour interval.)

Calls abandoned. The number of calls during the half-hour interval in
which the caller hung up before being connected with an agent.
(Also provided as a percentage of the total calls offered to the route
during the half-hour interval.)

Example
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rtecli11_status_by_five_minutes
Description
This template generates a historical grid that shows data on routing
client requests and responses during the current five minute interval.

Database Table

Routing_Client_Five_Minute

Data

Responses. The number of route responses to the routing client during
the five-minute interval.

Mean responses. The mean time, in milliseconds, for the route
responses to the routing client during the five-minute interval.

Rcv in error. The number or routing requests from the routing client
that produced errors during the five-minute interval.

Timeout calls. The number of route responses to the routing client that
timed out during the five-minute interval.

Max delay. The maximum delay, in milliseconds, of route responses to
the routing client during the five-minute interval.

Late calls. The number of route responses to the routing client that
exceeded the late threshold but did not time out.

Discarded calls. The number of routing requests from the routing client
that were discarded because of an internal constraint such as
buffering.

Example
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schimp01_name_time_numbers
This template is used mainly by GEOTEL support engineers to test the
data import functions of the Workforce Management Integration System.
The exact data that appear in this Monitor ICR report depend on the
specific workforce management system you are using with the ICR
system. In general, the data are for the current time period and appear as
imported from the external source.

 Note: To use this report, you need the GEOTEL•Schedule Link option.

Database Table

Schedule_Import_Real_Time

Data

Data shown depend on the data imported through the ICR Workforce
Management Integration System.

Example
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trkgrp01_alltrunkbusy_graph
Description
This template generates a real-time bar graph that shows the number of
seconds that all trunks in the selected trunk groups have been fully busy
for the current half-hour interval.

Database Table
Trunk_Group_Real_Time

Data
All trunks busy. The total time that all trunks in the selected trunk

group were busy for the current half-hour interval.

Example
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trkgrp02_idle_inservice_status
Description
This template generates a real-time bar graph that shows the number of
trunks in selected trunk groups that are idle and the number of trunks
that are in service.

Database Table
Trunk_Group_Real_Time

Data
Trunks idle. The number of trunks in the trunk group that are non-busy,

or idle.

Trunks in service. The number of trunks in the trunk group that are in
service.

Example
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trkgrp03_trunkgroup_status_grid
Description
This template generates a real-time grid that shows the status of trunks
in selected trunk groups.

Database Table

Trunk_Group_Real_Time

Data

Trunks idle. The number of trunks in the trunk group that are non-busy,
or idle.

Trunks in service. The number of trunks in the trunk group that are in
service.

All trunks busy. The total time that all trunks in the selected trunk
group were busy for the current half-hour interval.

Example
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trkgrp11_trunkgroup_performance_grid
Description
This template generates a historical grid that shows half-hour trunk
performance data for selected trunk groups.

Database Table

Trunk_Group_Half_Hour

Data

Trunks idle. The number of trunks in the trunk group that were
non-busy, or idle, during the half-hour interval.

Trunks in service. The number of trunks in the trunk group that were in
service during the half-hour interval.

All trunks busy. The total time that all trunks in the selected trunk
group were busy during the half-hour interval.

Example
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Abandoned call

A call in which the caller hangs up before the call is answered. Calls in
which the caller hangs up almost immediately do not have to be counted
as abandoned. When configuring each peripheral, you can specify the
minimum length of an abandoned call.

About box

A dialog box that displays general information about an application. The
About box usually contains copyright and version information. In most
applications, you can invoke it from the Help menu.

ABS. See Application Bridge Server.

ACD. See Automatic Call Distributor.

ACD Simulator

A GEOTEL software module that allows you to test applications within
the ICR by simulating ACDs. The ACD Simulator runs on a PC and can
simulate up to five ACDs.

Active script

A script that is scheduled for the current date and time. At any time, zero
or one routing script is active for each call type. If more than one routing
script is scheduled for a call type during a period of time, the ICR
choose the script with the most specific schedule. When the ICR
receives a call routing request, it invokes the active script for that call
type. If that script terminates without routing the call, the ICR uses the
default route associated with the dialed number.

Admin Workstation (AW)

A personal computer used to monitor the handling of calls in the ICR
system. The Admin Workstation can also be used to modify the system
configuration or scripts.

Administrative Script

A script that the ICR executes to perform background processing. For
example, an administrative script might set persistent variables or invoke
an application gateway. Use the Script Editor to create, modify, and
schedule administrative scripts.
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Agent

Anyone who can answer incoming phone calls. A peripheral agent is an
agent who is associated with a particular peripheral (ACD, PBX) in the
call center enterprise. A peripheral agent can be a member of one or
more skill groups. (Some peripheral types limit each agent to one skill
group assignment.) Optionally, you can group peripheral agents into
agent teams.

Agent distribution

The flow of agent data from a specific peripheral to a specific
Distributor. You can separately enable and disable each agent
distribution.

Agent out call

An outbound call made by an agent.

Agent Reporting. See GEOTEL•Agent Reporting.

Agent team

A group of peripheral agents configured on the same peripheral to meet
a business need. You can have an agent team that includes agents at the
call center and agents who work at home. Although these agents are at
different locations, they are associated with a particular ACD at the call
center. Members of an agent team can also be members of one or more
skill groups.

AHT. See Average Handle Time.

All Trunks Busy (ATB)

The state of a trunk group when all trunks are in use. The trunk group
cannot accept any new inbound or outbound calls in this state. The ICR
tracks the amount of time during which all trunks in a trunk group are
busy. You can view this information in real-time or historical reports.

ANI. See Automatic Number Identification.

Announcement

A recorded verbal message played to a caller.

Answer wait time

The elapsed time from when a call is offered at the peripheral to when it
is answered. Answer wait time is the sum of delay time, queue time, and
ring time.

Answered call

A call is counted as answered when it reaches an agent or VRU. For
example, the CallsAnsweredTo5 field in the Service_Five_Minute table
counts the number of calls that reached agents or VRUs during the
five-minute interval. The calls might still be in progress when the
interval ends.
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By contrast, a call is not counted as handled until it is finished.
Therefore, the number of answered calls and handled calls during an
interval is not necessarily the same, but eventually each answered call is
counted in both categories.

Application Bridge Server (ABS)

A GEOTEL software module that allows the ICR to share the Application
Bridge interface from an Aspect ACD with other applications.

Application Gateway

A construct that allows an ICR routing script to invoke an external
application. You can configure a gateway in Configure ICR and
reference it through the Gateway node in a script. Application Gateways
are available only if you purchase the GEOTEL•Gateway product.

Area code

A three-digit prefix used to indicate the destination area for long
distance calls. Also known as Numbering Plan Area (NPA). You can use
the area code to classify calls into call types. You can also define a
region as a collection of area codes.

ASA. See Average Speed of Answer.

ATB. See All Trunks Busy.

Automatic Call Distributor (ACD)

A programmable device at a call center that routes incoming calls to
targets within that call center. After the Intelligent CallRouter
determines the target for a call, the call is sent to the ACD associated
with that target. The ACD must then complete the routing as determined
by the ICR.

Automatic Number Identification (ANI)

A feature that provides the billing phone number of the phone from
which a call originated or the phone number itself. When qualifying
calls, the ICR compares the ANI to the calling line ID value specified
for a call type. See also Calling Line ID (CLID).

Available state

The state where the agent is ready to accept calls, but is not currently
involved in call work.

Average Handle Time (AHT)

The average time it took for calls to a service or skill group to be
handled. Handle time includes talk time plus after-call work time.

Average Speed of Answer (ASA)

The average answer wait time for calls to a service or route.
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AW. See Admin Workstation.

Basic Rate Interface (BRI)

One of two levels of ISDN service. The BRI provides two bearer
channels for voice and data and one channel for signaling (commonly
expressed as 2B+D). See also Primary Rate Interface (PRI).

Boolean expression

An expression that evaluates to TRUE or FALSE; for example:
*.ExpectedDelay < 50

BRI. See Basic Rate Interface.

Business entity

A subset of the ICR enterprise that contains its own scripts, enterprise
services, enterprise skill groups, enterprise agent groups, and schedules.
A business entity may, for example, represent a division within a large
corporation or a single customer within a service bureau. You can limit
the access of individual users and user groups to specific business
entities.

By default, the ICR enterprise consists of only one business entity. If
you enable partitioning, you can define multiple business entities.

Busy label

A routing label that causes the routing client to play a busy signal to the
caller.

Call-by-call routing

A strategy by which each incoming call is processed separately to
determine the optimum destination. The decision for each call can be
based on real-time information about the state of each call center as well
as historical data. By contrast, simple allocation routing statistically
distributes calls among call centers based on historical patterns.

Call center

A single site at which incoming phone calls are received and answered.
Typically, each call center can provide several services and is staffed by
agents from one or more skill groups.

Call control variables

A set of variables used by a peripheral to hold information related to a
call. For example, an Aspect ACD defines variables A through E. When
you define a routing client you can establish how the client’s call control
variables map to ICR variables such as dialed number, caller-entered
digits, and calling line ID.

Call details

Data saved by the ICR about every call it routes and calls that terminate
at each peripheral. Route call detail describes how the ICR processed the
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call. Termination call detail describes how a call was handled at a
peripheral. See also Route Details and Termination Call Details.

Call type

A category of incoming calls. Calls are categorized based on dialed
number (DN), caller-entered digits (CED), and calling line ID (CLID).
Each call type has a schedule that determines which routing script or
scripts are active for that call type at any time. Optionally, you can
define a default call type for each routing client.

Caller-Entered Digits (CED)

Digits entered by a caller on a touch-tone phone in response to prompts.
Either a peripheral (ACD, PBX, or VRU) or the carrier network can
prompt for CEDs.

Calling Line ID (CLID)

Information about the billing telephone number from which a call
originated. The CLID value might be the entire phone number, the area
code, or the area code plus local exchange.

CallRouter

The main part of the ICR system. The CallRouter receives call routing
requests and determines the best destination for each call. It also collects
information about the entire system.

Carrier

A company that provides telecommunications circuits. Carriers include
the local telephone company and companies like AT&T, MCI, and
Sprint.

CCSS7

Common Channel Signaling System 7. The protocol used by the AT&T
signaling network. The ICR’s NIC receives routing requests from the
CCSS7 network and returns a routing label to the CCSS7 network.

CED. See Caller-Entered Digits.

Central Controller

The computer or computers running the CallRouter and the ICR
Database Manager. In addition to routing calls, the Central Controller
maintains a database of data collected by the Peripheral Gateways (PGs)
and data that the Central Controller has accumulated about the calls it
has routed.

Central database

The relational database stored on the ICR Central Controller, which
stores historical five-minute and half-hour data, call detail records, ICR
configuration data, and call routing scripts.
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Central Office (CO)

The switching office of the local telephone company. The local central
office receives calls from within the local area and either routes them
locally or passes them to an interexchange carrier (IXC). On the
receiving end, the local central office receives calls that originated in
other areas from the IXC.

A Local CO trunk connects a call center directly with the local phone
company’s central office.

Classes

A security class is a subset of the ICR configuration data. Some classes
support only Read access for all users. For other classes, you can assign
specific access levels (Read, Reference, or Maintenance) to individual
users or user groups.

The ICR supports the following classes: Call, Global, Network Interface,
Peripheral, and System.

CLID. See Calling Line ID.

Clipboard

A Windows NT system resource that holds text and graphics that have
been cut or copied from within an application. You can paste the
contents of the Clipboard into an application.

CMS

Call Management System. A reporting package used on ACDs and
PBXs made by Lucent.

CO. See Central Office.

Comment

An element within a script that documents the script or some part of it.
Comments are not executable.

Configuration data

The description of your enterprise call center system. This includes, for
example, the peripherals, agents, skill groups, services, call types, and
regions that you use. The ICR must have complete and up-to-date
configuration data in order to route calls properly.

Configuration registry

A repository of configuration data maintained by the Windows NT
operating system. All applications on a computer can access the registry
to store and retrieve configuration information. You can use the
Windows NT Registry Editor (regedt32.exe) to view or modify data in
the registry.
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Connection

The link between two nodes in a script or between a node and a routing
target set. Connections show the flow of control between objects in the
script. Within the Script Editor, a connection is represented as a line
segment.

Control menu

A standard menu that allows you to manipulate a window or dialog box.
You can invoke the control menu by clicking on the control menu box
located to the left of the title bar. You can also invoke the control menu
for the application or the current dialog box by pressing ALT+SPACEBAR.
You can invoke the control menu for a document window by pressing
ALT+HYPHEN.

CRP. See Customer Routing Point.

CSFS. See Customer Support Forwarding Service.

CTI Gateway

The ICR process that acts a server for CTI clients to communicate with
the ICR. The CTI Gateway process may run on the same computer as
the Peripheral Gateway process or on a separate computer.

Current call

The call that the ICR (or a specific script) is currently processing. The
ICR receives a routing request for a call and locates a target to which the
call can be routed.

Custom function

A function that you can define in the Script Editor. A custom function is
a shorthand for an expression. Optionally, the expression can reference
parameters that are passed to the function.

Custom Screen Builder

A client database access application that is part of the GEOTEL Admin
Workstation group of applications. The Custom Screen Builder is based
on Powersoft InfoMaker. You use the Custom Screen Builder to
change Monitor ICR predefined templates to suit a particular business
need. You can also develop your own report templates for use in
Monitor ICR.

Customer

The organization whose calls the ICR routes. A customer may have
several semi-autonomous units or business entities. Optionally, the ICR
can be partitioned so that business entities can operate independently.

In the standard configuration, the ICR routes calls for a single customer.
In a service bureau configuration, a single ICR system may service
multiple customers.
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Customer Routing Point (CRP)

AT&T’s terminology for third-party processors that accept routing
requests from the CCSS7 network. Within the Intelligent CallRouter, the
Network Interface Controller (NIC) acts as a CRP.

Customer Support Forwarding Service (CSFS)

The facility within the ICR Logger that receives events from all parts of
the ICR, filters them, and saves appropriate messages. The Data Transfer
Process (DTP) sends these messages to GeoTel Customer Support.

Database Manager

The part of the ICR system that stores information about the entire
system in the central database. The Database Manager maintains the data
that is used in reporting and making routing decisions.

Database schema

The organization of information within a database. The schema consists
of table, field, and index definitions.

DDSN. See Distributed Diagnostics and Service Network.

DDSN Transfer Protocol (DTP)

The process on the ICR Logger that connects to GeoTel Customer
Support and delivers any messages saved by the Customer Support
Forwarding Service (CSFS). The DTP is part of the Distributed
Diagnostics and Service Network (DDSN) which ensures that GeoTel
Customer Support is informed promptly of any unexpected behavior
within the ICR.

Default call type

The call type the ICR uses if a call’s qualifiers do not map to any
specific call type definition. You can specify a default call type for each
routing client and a general default.

Delay in queue

The sum of time calls spent in the queue for a route or service. Delay in
queue can also take into consideration abandoned calls. For example, the
DelayQAbandTimeToHalf is the sum of time spent in queue for all calls
to a route or service abandoned in queue during a half-hour interval.

Delay time

The time spent processing a call after it arrives at a peripheral, but
before it is either queued or presented to an agent.

Deleted field

Many tables include a Deleted field. This field marks rows that have
been deleted but that still have active dependencies. For example, if a
script references Agent X and you delete Agent X, the ICR does not
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actually delete that Agent record; it marks the agent as deleted. The
record is actually deleted when the dependency is removed.

Device Management Protocol (DMP)

The session-layer communications protocol used within the Intelligent
CallRouter. Different application level protocols might be running
beneath DMP.

Dialed Number (DN)

The number that a caller dialed to initiate a call; for example, 800-555-
1212.

Dialed Number Identification Service (DNIS)™

A string (usually four, seven, or ten characters long) indicating the
number dialed by a caller and how the call should be handled by the
ACD, PBX, or VRU. The ICR uses the DNIS and trunk group to
indicate the destination for a call.

DID . See Direct Inward Dialing/Dialed Number Identification Service.

Direct Inward Dialing/Dialed Number Identification Service
(DID/DNIS)

When a call arrives at an ACD or PBX, the carrier sends a digital code
on the trunk line. The switch can read this code to determine how it
should dispatch the call. Typically, this value is the specific number
dialed by the user. By mapping each possible code with an internal
extension, the switch can provide direct inward dialing (DID).

The ICR uses the DID/DNIS value to specify the service, skill group, or
specific agent to whom the switch should route the call. The switch
reads the value from the trunk line when the call arrives and dispatches
the call appropriately.

Distribute

To divide calls among a series of targets based on a numerical formula.
You can use a Distribute node to do this within a script. To distribute
calls on a strict percentage basis (rather than a formula basis), you can
use a Percent Allocation node.

Distributed Diagnostics and Service Network (DDSN)

The facilities that gather events within the ICR and automatically report
any unexpected behavior to GeoTel Customer Support. The DDSN
includes the Customer Support Forwarding Service (CSFS) and DDSN
Transfer Process (DTP).
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Distributor. See Real-time distributor.

DMP. See Device Management Protocol.

DN. See Dialed Number.

DNIS. See Dialed Number Identification Service.

DNIS Override label

A routing label that is sent to the routing client along with a DNIS value.
The routing client passes that DNIS value with the call to the destination
indicated by the label.

DTP. See DDSN Transfer Protocol.

Duplexed

An arrangement in which two duplicate physical devices act as a single
logical device. If one of the physical devices fails, the system continues
to run normally by using the remaining physical device. See also
Simplexed.

EAS. See Expert Agent Selection.

EMS. See Event Management Service.

Enterprise

An entire company or agency, possibly spanning many call centers.
Enterprise refers to the set of call centers served by an ICR.

Enterprise Agent. See GEOTEL•Enterprise Agent.

Enterprise name

A character-string name commonly used to identify an object in the ICR
database. An enterprise name must be unique among all objects of a
specific type. For example, each service must have an enterprise name
that is unique among all services.

An enterprise name can be up to 32 characters. The valid characters are
upper-case and lower-case letters, digits, periods (.) and underlines (_).
The first character of the name must be a letter or digit.

Enterprise service

A collection of services, typically from several call centers. While each
individual service is tied to a specific peripheral, an enterprise service
can span peripherals.

Enterprise skill group

A collection of skill groups, typically from several call centers. While
each individual skill group is tied to a specific peripheral, an enterprise
skill group can span peripherals.

Enterprise-wide call distribution

A strategy for allocating calls among several call centers or other
answering locations based on real-time information about activity at
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each location. The ICR implements enterprise-wide call distribution and
allows calls to be sent to any network-addressable location within, or
outside of, an enterprise.

Entity. See Business entity.

Event Management Service (EMS)

A software module within the Intelligent CallRouter that processes use
to report events to other processes within the system.

Event Viewer

A feature of Monitor ICR that lets you view messages (events) generated
by processes within the ICR system.

Expected delay

The ICR’s predicted delay for any new call added to a service or route
queue. The expected delay value is valid only if no agents are available
for the route or service.

Expert Agent Selection (EAS)

A mode for the Lucent Definity ECS ACD. In this mode, agents are
automatically added to pre-assigned skill groups at login. Calls can be
routed either to the agent’s physical extension or to the agent’s login ID.
In non-EAS mode, agents must manually add themselves to hunt groups
and calls can be routed only to physical extensions.

Fault-tolerant architecture

A design that allows a system to continue running after a component of
the system has failed. The ICR includes several levels of fault tolerance
that minimize time when the system is non-responsive to call routing
requests. The ICR fault-tolerant architecture eliminates single points of
failure and provides disaster protection by allowing system components
to be geographically separated.

Five-minute interval

Certain statistics within the ICR database are updated at five-minute
intervals. The first such interval for each day begins at 12:00 midnight
and ends at 12:05 A.M. The date and time at the start of the five-minute
interval is saved with the data. This allows you to look back at data from
previous five-minute intervals.

During a five-minute interval, statistics accumulate in real-time tables
(for example, Service_Real_Time). At the end of the interval, the
statistics are written to five-minute tables (for example,
Service_Five_Minute).

Foreign exchange (FX)

A trunk type that connects a call center with a central office in a remote
exchange. This allows callers in that remote exchange to directly access
the call center without using an interexchange carrier.
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Gateway. See Application Gateway and ICR Gateway.

Geographical region. See Region.

GEOTEL•Agent Reporting

An optional ICR feature that allows you to monitor real-time and
historical data about individual agents, rather than groups of agents.

GEOTEL•Enterprise Agent

An optional ICR feature that provides CTI, call distribution, and
reporting capabilities for agents that are not connected to an ACD.

GEOTEL•Enterprise CTI

An optional ICR feature that allows a Computer Telephone Interface
(CTI) connection to an external device.

GEOTEL•Gateway

An optional ICR feature that allows a routing script to invoke an
external application. The script can pass arguments to the application
and receive data in return.

GEOTEL•Gateway SQL

An optional ICR feature that allows a routing script to query data from
an external database. The script can then use the data to determine the
target for a call.

GEOTEL•Monitor ICR

A GeoTel product that allows read-only access to ICR data.

GEOTEL•Network ICR

An optional feature that allows a carrier to set up two levels of ICRs.
The first (network) level ICR receives routing requests from the carrier
network. It then either makes a simple routing decision or passes the
request on to a second (customer) level ICR for further processing.

GEOTEL•Partition

An optional ICR feature that allows you to restrict access to specific ICR
data to selected users or user groups within the enterprise. For example,
the ICR database may contain data from several different divisions
within a corporation. You can define each division as a business entity.
You may then prevent users within each division from accessing data
associated with other divisions.

GEOTEL•Schedule Link

An optional ICR feature that allows you to import and export data
between the ICR and an external force management system. You can use
imported information in routing scripts and reports.
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GEOTEL•Web View

An optional ICR feature that allows you to use a Web browser for
monitor-only access to real-time and historical ICR reports and ICR
script monitoring.

GMT . See Greenwich Mean Time.

Greenwich Mean Time (GMT)

The time zone at the meridian at Greenwich, England. This time zone is
used as an international standard.

Grid

A feature of the Script Editor that establishes a series of vertical and
horizontal lines at fixed intervals. You can use the Placement Grid
command from the View menu to view or hide the grid for a window
and adjust the grid spacing.

Grid point

Within the Script Editor, a grid point is the intersection of a vertical and
horizontal line in a grid. You can force objects to position to grid points
by choosing the Snap To Grid option from the Layout Grid command of
the View menu.

Half-hour interval

Half-hour statistics within the ICR database are updated at 30-minute
intervals. The first such interval for each day begins at 12:00 midnight
and ends at 12:30 A.M. The date and time at the start of the 30-minute
interval is saved with the data. This allows you to look back at data from
previous 30-minute intervals.

During a 30-minute interval, statistics accumulate in real-time tables (for
example, Service_Real_Time). At the end of the interval, the statistics
are written to half-hour tables (for example, Service_Half_Hour).

Handle time

The time an agent spends talking on an inbound call and performing
after-call work.

Handled calls

A call is counted as handled when the call is finished. For example, the
CallsHandledTo5 field in the Service_Five_Minute table counts the
number of calls that finished during the five-minute interval. The calls
might have been answered before the interval began.

By contrast, a call is counted as answered as soon as it reaches an agent
or VRU. Therefore, the number of handled calls and answered calls
during an interval is not necessarily the same, but eventually each
answered call is counted in both categories.
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HDS. See Historical Data Server.

Historical data

Data collected at five-minute and half-hour intervals and stored in the
ICR central database or an HDS database.

Historical Data Server (HDS)

An Admin Workstation with a special database that holds ICR historical
data. In a normal configuration, historical data is stored only in the
central database. When you use the HDS option, the historical data is
also stored on the HDS machine (which must be a real-time distributor).
Other Admin Workstations at the site can read historical data from the
HDS rather than accessing the central database.

ICP. See Intelligent Call Processing.

ICR. See Intelligent CallRouter.

ICR gateway

A construct that allows one ICR system to forward a request to another
ICR. You can configure an ICR gateway in Configure ICR and reference
in the ICR Gateway node in a routing script. Service bureaus may use
ICR gateways to implement a multi-tier architecture.

ICR Protocol (ICRP)

The communication protocol used by ICR gateways to pass a routing
request and response between two ICRs. The ICR sending the request
must be set up for remote network routing and the ICR receiving the
request must be running an ICRP Network Interface Controller.

Idle

Another name for the Not Ready state. See Not Ready state.

Incoming call

A call offered to a route or service from an external carrier. See also
Offered calls.

Index

A database construct that allows for quick access to data, sorting of
rows, and can be used to prevent the creation of duplicate data. An index
is associated with a table and contains an entry, or key, for each row in
the table. The key is composed of one or more column values from the
row. The database manager can quickly locate data by searching the
index rather than the actual rows. Similarly, the database manager can
sort the index faster than it can sort the rows. If the index is defined as
unique, no two key values can be identical.

Initialize Local Database

A tool on the Admin Workstation that copies the latest configuration
data and scripts from the central database to the local database.
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Instance

A single installation of the ICR. An instance consists of several
components (CallRouter, Logger, Peripheral Gateways, Admin
Workstations), some of which might be duplexed. An instance can be
dedicated to a single customer or, in some environments, shared among
several customers.

Integrated Services Digital Network (ISDN)

An international standard for telephone transmission. ISDN provides an
end-to-end digital network and provides a standard for out-of-band
signaling. It also provides greater bandwidth than older telephone
services. The two standard levels of ISDN are the Basic Rate Interface
(BRI) and the Primary Rate Interface (PRI).

Intelligent Call Processing (ICP)

AT&T’s name for the facility that allows third-party products such as
the Intelligent CallRouter to pre-route calls.

Intelligent CallRouter (ICR)

The GEOTEL system that implements enterprise-wide call distribution
across call centers. The ICR provides Pre-Routing, Post-Routing, and
performance monitoring capabilities.

Interactive Voice Response. See Voice Response Unit.

Interexchange Carrier (IXC)

A long-distance telephone company such as AT&T, MCI, or Sprint.

Interflow

The ability of a switch to forward calls to another location within the
switch or to another switch. Interflow between switches requires a
dedicated trunk line.

Internet Protocol (IP)

The connectionless-mode network service protocol of TCP/IP. IP
enables the entities in a network to communicate by providing IP
addresses and by numbering and sending TCP data packets over the
network. NICs, PGs, and Admin Workstations in the ICR system use IP
to communicate over a wide area network. See also Transmission
Control Protocol (TCP).

IP router. See Router (IP).

ISDN. See Integrated Services Digital Network.

IVR. See Voice Response Unit.

IXC. See Interexchange Carrier.
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Job Scheduler

A tool that allows you to set up specific commands to be executed
automatically at given dates and times. You can schedule a command to
execute once, on several specific days, or regularly on a weekly or
monthly schedule.

Key

An entry in a database index. Each key in the index corresponds to a
table row and is composed of specific column values from that row.

LAA. See Longest Available Agent.

Label

A value that the ICR returns to a routing client. The routing client maps
the label to either an announcement or a trunk group and DNIS value.
The routing client then either plays the announcement or delivers the call
to the specified trunk group along with the DNIS value.

LAN. See Local Area Network.

LEC. See Local Exchange Carrier.

Local Area Network (LAN)

The connection of several computers within a building, usually using
dedicated lines.

Local Central Office

The switching office of the local telephone company. The local central
office receives calls from within the local area and either routes them
locally or passes them to an interexchange carrier (IXC). On the
receiving end, the local central office receives calls that originated in
other areas from the IXC.

A Local CO trunk type connects a call center directly with the local
phone company’s central office.

Local database

A database on the Admin Workstation that contains information copied
from the central database. The local database also contains real-time data
on the status of the call center enterprise.

Local Exchange Carrier (LEC)

The local phone company responsible for delivering calls within a local
area.

Log file

A file used to store messages from processes within the ICR system. The
ICR process-related log files are stored in the logfiles subdirectory under
the component directory.
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Logged On

A state in which agents have made their presence known to the system,
but may or may not be ready to receive calls.

Logger

The process within the ICR that manages the central database. Each side
of a duplexed Central Controller includes a Logger. The Logger may run
on the same machine as the CallRouter process or on a separate
machine.

Logical deletion

If a table includes a Deleted field, then records deleted from the table are
not removed from the database. Instead, the Deleted field is set to Y
(yes) to indicate that the record is logically deleted. The ICR tools treat
the record as though it were deleted. After an object is logically deleted,
you can choose to physically delete it (destroy permanently).

Logical interface controller

An entity that represents a single simplexed or a pair of duplexed
physical interface controllers. A physical interface controller is either a
Network Interface Controller (NIC) or a Peripheral Gateway (PG).

Longest Available Agent™ (LAA)

The agent that has been continuously in the Available state for the
longest time. The ICR can examine services or skill groups from
different peripherals and route a call to the service or group with the
longest available agent. (This feature is not supported on Rockwell
ACDs.)

Message Delivery Service (MDS)

The facilities used by ICR nodes to communicate with each other. The
MDS plays a key role in keeping duplexed components synchronized.

Mirroring

An arrangement by which changes to one storage device are
automatically written to a similar device. For example, you can set up a
disk as a mirror of another disk so that all writes to one disk are also
automatically written to the other. This allows for recovery from media
failure. Mirrored disks are an alternative to a RAID configuration.

Monitor ICR

A tool that allows you to monitor real-time and historical activity within
your enterprise. Monitor ICR allows you to build reports from templates
or view reports you have saved previously. You can also view events
generated by ICR processes.
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Monitor mode

A Script Editor mode in which the number of routing requests that pass
through each connection of a script is shown on the screen. You can use
this mode to determine whether a script is behaving as expected.

NAA. See Next Available Agent.

Name. See Enterprise name.

NCP. See Network Control Point.

Network Control Point (NCP)

The process within the AT&T signaling network that sends routing
requests to a Customer Routing Point (CRP) such as the network
interface controller (NIC) within the Intelligent CallRouter.

Network ICR (NICR)

In a two-tier service bureau architecture, the ICR that receives route
requests from the carrier network and forward them to a Customer ICR
(CICR). A NICR usually contains only a small configuration that allows
it to directly route a subset of calls and dispatch the other requests to the
appropriate CICR. The NICR receives route responses from the CICRs
and forward them to the carrier network.

Network Interface Controller (NIC)

The computer and process within the ICR system that communicates
directly with the IXC’s signaling network. The NIC reads call routing
requests from the network and transfers them to the ICR’s Central
Controller. Subsequently, the NIC passes a routing label from the
Central Controller to the IXC signaling network.

Network trunk group

A group of trunks to which a routing client can direct calls. A peripheral
may divide its trunks into trunk groups differently than the routing client
does. Simple trunk groups describe the peripheral’s view of the trunks;
network trunk groups describe the routing client’s view of the trunks.

A network trunk group maps to one or more peripheral trunk groups.

Next Available Agent

A strategy for selecting an agent to handle a call. The strategy seeks to
maintain an equal load across skill groups or services.

NIC. See Network Interface Controller.

Node

An executable element within a script. A script consists of nodes,
connections, routing targets, and comments.

Also, a single computer within a network.
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Node Manager

A process that runs on each physical node (computer) in the ICR system
and manages other ICR processes on that system. The Node Manager is
responsible for initializing nodes and for restarting failed processes. The
Node Manager is guided by a configuration file that is stored on each
node. The file describes, among other things, which processes must be
started, and if necessary, restarted on the node.

Not Ready state

A state in which agents are logged on but are neither involved in any call
handling activity nor available to handle a call.

Numbering Plan Area (NPA). See Area code.

Object palette

A Script Editor subwindow that contains template nodes and targets.
You can drag a copy of an object from the palette into your script. You
can use the Palette command on the View menu to toggle between
viewing and hiding the object palette.

Offered call

An incoming call or internal call sent to a specific route or service. In
real-time data, a call is counted as offered as soon as it is sent to the
route or service. However, if the caller hangs up before the abandoned
call wait time has elapsed, that call is not counted as offered in the
historical (five-minute and half-hour) data. This ensures that the number
of calls offered is the same as the number answered plus the number
abandoned.

Open Database Connectivity (ODBC)

A standard application programming interface (API) that allows a single
client application to access any of several databases. Because the ICR’s
databases support ODBC, you can query them from any third-party
client tool that also supports ODBC.

Open Peripheral Interface (OPI)

The GEOTEL proprietary interface between Peripheral Gateways (PGs)
and the ICR’s Central Controller.

Partitioning. See GEOTEL•Partition.

PBX. See Private Branch Exchange.

Percent utilization

The percent utilization is computed by dividing the total time agents
spent handling calls by the total time agents were ready. (The ready time
is calculated by subtracting the Not Ready time from the total time that
agents were logged on.) The value is expressed as a percentage.
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Peripheral

A switch, such as an ACD, PBX, or VRU, that receives calls that have
been routed by the ICR.

Peripheral Gateway (PG)

The computer and process within the ICR system that communicates
directly with the ACD, PBX, or VRU at the call center. The Peripheral
Gateway reads status information from the peripheral and sends it to the
Central Controller. In a private network configuration, the Peripheral
Gateway sends routing requests to the Central Controller and receives
routing information in return.

Peripheral Interface Manager (PIM)

The GEOTEL proprietary interface between a peripheral and the
Peripheral Gateway (PG).

Peripheral service

A service that is tied to a specific peripheral (ACD, PBX, or VRU) in
the call center enterprise. Peripheral services typically identify a type of
processing that the caller requires. For example, a peripheral might have
services defined for Sales, Technical Support, or New Accounts. See
also Service.

Peripheral skill group

A skill group that is associated with a specific peripheral (ACD, PBX, or
VRU) in the call center enterprise. For example, a single peripheral
might have skill groups defined for agents who can handle technical
questions or who can speak Spanish. See also Skill group.

Peripheral target

A combination of a trunk group and a DNIS value. A peripheral target is
associated with a service, skill group, or agent at a peripheral. Each
peripheral target is also associated with a route that can be returned by a
routing script.

Note that peripheral target refers to a trunk group and DNIS value.
Skill target refers to the entity at the peripheral to which the call is
dispatched.

PG. See Peripheral Gateway.

Physical interface controller

A single Network Interface Controller (NIC) or Peripheral Gateway
(PG). A logical interface controller represents either a single physical
interface controller or a pair of duplexed physical interface controllers.
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PIM. See Peripheral Interface Manager.

Post-query label

A routing label that causes the routing client to re-enter its call routing
plan at a specific point.

Post-Routing

The GEOTEL routing concept that allows the ICR to make secondary
routing decisions after a call has been initially processed at a call center.
Post-Routing enables the ICR to process calls when an ACD, VRU, or
PBX generates a route request. The ICR executes scripts to process the
route request and return a destination address. This directs the ACD to
send the call to an agent, skill group, or service in the same call center or
at a different call center. In making a Post-Routing decision, the ICR can
use all the same information and scripts used in Pre-Routing.

Pre-Routing

The GEOTEL routing concept that enables the ICR to execute routing
decisions before a call terminates at a call center. With Pre-Routing, the
Network Interface Controller (NIC) receives the route request from the
IXC and passes the call information along to the ICR. The ICR is then
able to process the IXC route request through a call routing script, which
defines how calls should be routed. In making its Pre-Routing decisions,
the ICR uses real-time data on the status of call centers. This data is
gathered by Peripheral Gateways at different call center sites and passed
back to the ICR.

Prefix

The leading digits of a telephone number. When defining a call type,
you can specify a prefix of any length to match calling line ID values.
You can also define a region that is a collection of prefixes. If a calling
line ID value matches multiple prefixes, the longest matching prefix
prevails.

PRI. See Primary Rate Interface.

Primary Rate Interface (PRI)

One of two levels of ISDN service. In the United States, the PRI
typically provides 23 bearer channels for voice and data and one channel
for signaling information (commonly expressed as 23B+D). In Europe,
PRI typically provides 30 bearer lines (30B+D).

Private Branch Exchange (PBX)

A device located at a customer’s site that switches incoming calls to
extensions within that site. A PBX can be used to implement direct
inward dialing.
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Private network

A network made up of circuits for the exclusive use of one customer.
Private networks can be nationwide in scope. They typically serve large
corporations or government agencies.

Private network routing

A configuration in which the ACD sends routing requests to the ICR
through the Peripheral Gateway. This is a type of Post-Routing.

PSN. See Public Switched Network.

Public Switched Network (PSN)

The public telephone network. The PSN provides the capability of
interconnecting any home or office in the country with any other.

Query

The act of requesting information from a database, or the statement used
to request that information. See also Structured Query Language (SQL).

Queue time

The time a call spends queued at a peripheral waiting for an agent to
become available. Queue time occurs after delay time and before ring
time.

Queued call

A call that has arrived at a peripheral, but that is being held until an
agent or other resource becomes available to handle the call.

RAID. See Redundant Array of Inexpensive Disks.

Ready state

A state in which an agent is logged on to the system and is currently
available to handle a call, is talking on a call, or is involved in after-call
work and presumed to be available to handle another call when done.

Real-time data

Real-time information about certain entities within the ICR system is
updated continuously. Real-time data includes data accumulated since
the end of the last five-minute interval (ServiceLevelTo5, for example)
and since the last half-hour interval (ServiceLevelHalf). Real-time
records themselves do not accumulate in the database as historical
records do; each update overwrites the existing record. Real-time
records are stored in the local database on the Admin Workstation.

Real-time distributor

An Admin Workstation that receives real-time monitoring data directly
from the Central Controller. The real-time distributor then passes those
data on to other Admin Workstations at the same site. For each site,
typically two Admin Workstations are set up as distributors, but only
one is active at any time.
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Redundant Array of Inexpensive Disks (RAID)

A storage device that provides fault-tolerance through redundant
physical disks. A RAID system is an alternative to mirrored disks.

Region

A collection of prefixes for incoming telephone calls. If the leading
digits of a calling line ID value match any of the prefixes, the call is
from the region. You use a region in defining call types or branch within
a script based on the call’s region.

Registry. See Configuration registry.

Relational database

The database model used in the ICR central and local databases. The
relational database model portrays data as being stored in tables (or
relations). The associations between pieces of data are implicit in the
data themselves rather than being stored externally.

Report

The final presentation of data, titles, dates and times, and graphic
elements either printed or displayed in a Monitor ICR window. A single
report can include components generated by one or more templates. For
example, one report can contain a real-time pie chart and a historical
grid, each generated with a different template. Report definition files are
saved in the custom subdirectories under the aw directory. See also
Report definition.

Reserved field

A reserved database field contains information that might be used
internally by GEOTEL. You must not modify the contents of a reserved
field.

Reserved state

A state in which an agent is awaiting an interflowed call and is
unavailable to receive any incoming calls. This state applies to agents on
Northern Meridian ACDs only.

Ring label

A routing label that causes the routing client to play an unanswered ring
to the caller.

Ring time

The time elapsed from when a call is presented to an agent until the
agent answers it. This occurs after any delay time and queue time. This
value is stored in the Termination Call Detail table in the ICR central
database.

Some peripherals do not track ring time. For those peripherals, ring time
is included within the queue time or delay time.
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Route

A value returned by a routing script that maps to a service and a specific
target at a peripheral; that is, a service, skill group, agent, or translation
route. The ICR converts the route to a label that is returned to the routing
client. The routing client then delivers the call to a specific trunk group
with a specific DNIS. The peripheral is responsible for recognizing the
trunk group and DNIS and delivering the call to the appropriate target.

Route call details

Data about routing requests received by the ICR and how calls were
routed (that is, the route chosen for each call). This data is stored in the
Route Call Detail table in the ICR central database.

Router (IP)

A device that dispatches messages to their appropriate destinations
within or between IP networks. See also Internet Protocol (IP).

Routing client

An entity that sends routing requests to the ICR. Each logical interface
controller can be mapped to one or more routing clients. A routing client
typically corresponds to a subsystem within an interexchange carrier or
to a peripheral performing Post-Routing.

Routing script

A script that the ICR executes to find the destination for a call. A routing
script might examine information about several possible targets before
choosing the best destination. You can schedule different scripts to
execute for different types of calls and at different times and dates. Use
the Script Editor to create, modify, and schedule routing scripts.

Routing server

The ICR acts as the routing server. For example, when a caller dials your
800 number, the IXC subsystem (routing client) passes a route request to
the ICR. As the routing server, the ICR processes the route request,
determines where to route the call, and passes a routing label back to the
IXC.

Routing target

An entity to which the ICR can route a call. A routing target can be an
agent, skill group, service, enterprise skill group, or enterprise service.

Schema Help

A Windows NT help file that provides information about the
organization of data within the ICR databases.
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SCP. See Service Control Point.

Script

A defined procedure that the ICR can execute. The ICR supports two
types of scripts: routing scripts to determine where to route a call and
administrative scripts that perform background processing. A script
consists of executable nodes, connections, routing targets, and
comments.

Script Editor

A tool that lets you create, modify, view, or monitor routing scripts and
administrative scripts. A routing script is a defined procedure that is
executed by the ICR to determine how a call is routed. An administrative
script is a defined procedure that is executed as specific times to perform
background processing.

Security classes. See Classes.

Service

A particular type of processing that the caller requires. For example, in a
software company’s call center, a caller might have a question about
installing software. This caller would be directed to the Technical
Support service. A service is associated with a peripheral (and is
therefore sometimes called a peripheral service). See also Enterprise
service.

Service array

A collection of service which might be associated with different VRUs,
but are all associated with the same Peripheral Gateway (PG). You can
route calls to a service array and let the PG choose among the member
services.

Service Control Point (SCP)

A node (computer) in the IXC signaling network. The ICR connects to
an SCP within the IXC’s network.

Service level

The percentage of incoming calls that are answered within a specified
threshold. Several slightly different calculations can be used for the
service level; specifically, abandoned calls can be accounted in different
ways. The ICR keeps track of two different service levels: the
peripheral service level is the service level as calculated by the
peripheral; the ICR service level is the service level as calculated by the
ICR.

Service level event

A service level event for a call occurs when the service level time
expires while the call is in queue or the call is either answered or
abandoned before the service level time expires. When performing
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service level calculations for a time period, the ICR considers only calls
that had a service level event during that period. This ensures that each
call is counted only once and during the appropriate time period.

Service level threshold

The number of seconds you set as the maximum time a caller should
wait before being connected with an agent for a specific service. When
you set up a peripheral, you specify a default service level threshold for
all services associated with that peripheral. For example, if you set a
service level threshold of 30 seconds, you want calls to be answered
within 30 seconds. Every call answered within 30 seconds improves the
service level. Calls not answered within the 30 seconds reduce the
service level. See also Service level event.

Simplexed

An arrangement in which a physical device does not have a duplicate,
paired device. If a simplexed device fails, a part of the system might stop
functioning. See also Duplexed.

Simulator. See ACD Simulator.

Skill group

A collection of agents that share a common set of skills, such as being
able to handle customer complaints. A skill group is associated with a
peripheral. An agent can be a member of zero, one, or more skill groups
(depending on the peripheral). See also Enterprise skill group.

Skill target

A target at a peripheral to which a call can be routed. A skill target can
be a service, skill group, agent, or translation route.

Note that peripheral target refers to a trunk group and DNIS value.
Skill target refers to the entity at the peripheral to which the call is
dispatched.

Skills-based routing

A concept whereby calls are routed to agents based on the skills those
agents have. You can construct skill groups that contain agents who
share a common set of skills. You can also assign priorities to the skills
in each agent profile. For example, an agent might have a priority 1
assignment for handling calls from Spanish-speaking callers; however,
that same agent might have a priority 3 assignment for handling Sales
calls. Calls can then be routed to the skill group that has the appropriate
level of expertise to handle the call. The ICR implements skills-based
routing at the network level rather than just within a peripheral. This
allows the ICR to examine skill groups on all peripherals before
deciding where to route the call.
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SQL. See Structured Query Language.

SQL Server

The Microsoft® relational database product used for the ICR’s local and
central databases.

Status bar

The set of fields that appear, by default, at the bottom of an application’s
main window.

Structured Query Language (SQL)

A standard database query language in which you can formulate
statements that will manipulate data in a database. The statements
include SELECT, for data retrieval; UPDATE, for data modification;
DELETE, for data deletion; and INSERT, for data insertion. You can
access the ICR databases using SQL and any client tool that supports
ODBC.

System time

The time as used consistently throughout an ICR system. Although parts
of the ICR system can be in different time zones, they all use the same
clock time. The system time is typically the local time for Side A of the
ICR Central Controller.

Talk time

The total seconds that agents in a skill group are in the Talking In,
Talking Out, and Talking Other states.

Talking In state

A state in which an agent is talking on an inbound call.

Talking Other state

A state in which an agent is talking on an internal (neither inbound nor
outbound) call.

Talking Out state

A state in which an agent is talking on an outbound call.

Talking state

A state in which an agent is talking on a call. This includes the Talking
In, Talking Out, and Talking Other states.

TCP/IP. See Transmission Control Protocol/Internet Protocol.

Termination call detail

Data that contains information about how each call was handled at a
peripheral. This data includes items such as the identifiers for the agent
and the peripheral that handled the call, ring time, after-call work time,
and the identifier for the route where the call was sent. Termination call
details are stored in the central database.
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Tie line

A private trunk line that connects two ACDs or PBXs across a wide
area.

Toolbar

The row of buttons that appears, by default, at the top of a tool’s main
window. You can execute specific commands quickly by clicking a
button on the toolbar.

Translation route

A target at a Peripheral Gateway that does not map to a specific service,
skill group, or agent. When a call arrives at a translation route, the
Peripheral Gateway (PG) is responsible for determining the ultimate
target. When the ICR routes a call to a translation route, it sends a
message to the PG. This message contains the ultimate target and further
instructions for the PG. For example, the PG might be instructed to
coordinate with a host computer so that the caller’s account number is
displayed on the teleset of the agent who picks up the call.

Translation Route Wizard

An ICR tool that makes it easier to configure translation routes and their
associated targets. You can also use the Translation Route Wizard to
report on or delete translation routes.

Transmission Control Protocol (TCP)

A connection-based Internet protocol that is responsible for packaging
data into packets for transmission over the network by the IP protocol.
TCP provides a reliable flow control mechanism for data in a network.

Transmission Control Protocol/Internet Protocol (TCP/IP)

The Internet suite of protocols used to connect a world-wide
internetwork of universities, organizations, and corporations. TCP/IP is
the protocol used to communicate between the Central Controller and
devices in the Intelligent CallRouter system. TCP/IP is based primarily
on a connection-oriented transport service, the Transmission Control
Protocol (TCP); and a connectionless-mode network service, the Internet
Protocol (IP). TCP/IP provides standards for how computers and
networks with different technologies communicate with each other. See
also Transmission Control Protocol and Internet Protocol.

Trunk

A telephone line connected to a call center and used for incoming or
outgoing calls.

Trunk Group

A collection of trunks associated with a single peripheral and usually
used for a common purpose.

See also Network trunk group.
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Variable

A named object that can hold a value.

Virtual call center

An approach to enterprise-wide call center management that treats
several geographically dispersed call centers as if they were a single call
center. The virtual call center expands skills-based routing from the
ACD to the network level. See also Skills-based routing.

Voice Response Unit (VRU)

A telecommunications computer, also called an Interactive Voice
Response unit (IVR), that responds to caller entered touch-tone digits.
The VRU responds to caller entered digits in much the same way that a
conventional computer responds to keystrokes or a click of the mouse.
The VRU uses a digitized voice to read menu selections to the caller.
The caller then enters the touch-tone digits that correspond to the desired
menu selection. The caller entered digits can invoke options as varied as
looking up account balances, moving the call within or to another ACD,
or playing a pre-recorded announcement for the caller.

WAN. See Wide Area Network.

WATS. See Wide Area Telecommunications Service.

Web View. See GEOTEL•Web View.

Wide Area Network (WAN)

The connection of several computers across a wide area, normally using
telephone lines.

Wide Area Telecommunications Service (WATS)

A special service provided by an interexchange carrier that allows a
customer to use a specific trunk to make calls to specific geographic
zones or to receive calls at a specified number at a discounted price.

Work Not Ready state

A state in which an agent is involved in after-call work and is assumed
not to be ready to accept incoming calls when done.

Work Ready state

A state in which an agent is involved in after-call work and is assumed
to be ready to accept incoming calls when done.

Workspace

The state of a tool at a given time. Some tools let you save your
workspace either automatically when you exit or manually at any time.

For example, when you save workspace, the Script Editor saves the
following information:

State, size, and position of the Script Editor main window.
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Names and versions of scripts that are currently open.

Mode of each open script.

State, size, and position of each script window or icon.

Current use of grids.

State of the object palette, toolbar, and status bar.

The next time you start the Script Editor, it restores the saved state.

Wrap-up

Call-related work performed by an agent after the call is over. An agent
performing wrap-up is in either the Work Ready or Work Not Ready
state.

Zoom

To shrink or enlarge the appearance of objects on the screen.
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—Symbols—
.CMB files

extensions, 86
.CSV. See Comma-separated values

data format

—Numbers—
1, 2, 3... option, 93
800 number(s)

ICR routing of, 20

—A—
Abandoned calls

enterprise service, 198, 199, 202,
205, 208, 210, 213, 214, 216,
268

peripheral service, 268
peripheral service, 250, 251, 254,

257, 260, 262, 265, 266
route, 272, 273, 276, 279, 281
service array, 206
within service level

enterprise service, 198
peripheral service, 250
route, 272

Absolute time, 80
ACD. See Automatic Call Distributor
ACD CDN, 33
ACD DN, 33
Admin Workstation

client, 39
distributor, 39
monitor-only, 40
overview, 32–36

Administrator, 41
Agent(s)

activity, 22, 129

activity reports, 158, 166, 174, 225
distribution, 43
logout status, 157, 165, 173, 223
out calls

enterprise skill group, 189, 191
peripheral skill group, 240, 242

performance, 130
performance reports, 160, 168, 176,

227
peripheral-specific terminology, 33,

34
relation to skill groups, 25
reporting, 43, 128

enabling, 43
state mapping

Alcatel 4400, 140
Aspect CallCenter, 137
DEFINITY ECS, 137
Ericsson ACP1000, 140
NEC NEAX 2400, 140
Nortel Meridian, 137
Rockwell Galaxy, 139
Rockwell Spectrum, 139
Siemens Hicom 300E, 139
Siemens Rolm 9751 CBX, 139

state trace, 44
state trace report, 224
states, 132
status, 129
status reports, 155, 156, 163, 164,

171, 172, 221, 222
tables, 128
team, 27
time allocations, 132
tracking, 44

agteam01_agent_status_by_position,
155

agteam02_agent_status_by_skillgroup,
156

agteam03_logout_status_by_team, 157
agteam04_daily_agent_activity, 158
agteam05_agent_daily_perf, 160

Download from Www.Somanuals.com. All Manuals Search And Download.



320 Index

agtper01_agent_status_by_position,
163

agtper02_agent_status_by_skillgroup,
164

agtper03_logout_status_by_peripheral,
165

agtper04_daily_agent_activity, 166
agtper05_agent_daily_perf, 168
agtskg01_agent_status_by_position,

171
agtskg02_agent_status_by_skillgroup,

172
agtskg03_logout_status_by_skillgroup,

173
agtskg04_daily_agent_activity, 174
agtskg05_agent_daily_perf, 176
Alcatel 4400, 32

terminology, 34
Alerts (threshold), 108
All trunks busy

Galaxy software status report, 231
network trunk group, 219
trunk group, 284, 286, 287

Answered calls
enterprise service, 199
peripheral service, 251
route, 273

apgate11_status_by_half_hour, 179
Application (Aspect CallCenter), 33
Application gateway, 30

templates, 155, 156, 157, 158, 160,
163, 164, 165, 166, 168, 171,
172, 173, 174, 176, 179, 221,
222, 223, 224, 225, 227

Aspect CallCenter, 32
limitations, 35
terminology, 33

Association
file, 97

AT command (DOS), 120
Attribute field

in Threshold Editor, 108
Automatic Call Distributor (ACD)

and call center enterprise, 24
limitations, 35
types supported, 32, 33, 34

Available state
count of agents in

enterprise service, 204
enterprise skill group, 182, 183
peripheral service, 256
peripheral skill group, 233, 234

percent of agents in
enterprise skill group, 184, 185,

187

peripheral skill group, 235, 236,
238

percent of time in
enterprise skill group, 195
peripheral skill group, 246

time spent in, 136
Average

delay in queue
enterprise service, 196, 202, 208,

209
peripheral service, 248, 254, 259,

261
peripheral skill group, 247
route, 270, 276, 278, 280
service array, 206

handle time
enterprise service, 202, 208, 209
enterprise skill group, 189, 191
peripheral service, 254, 259, 261
peripheral skill group, 240, 242
route, 276, 278, 280
service array, 206

speed of answer
enterprise service, 196, 202, 204,

208, 209, 216
peripheral service, 268
peripheral service, 248, 254, 256,

259, 261
route, 270, 276, 278, 280
service array, 206

talk time
enterprise service, 202
enterprise skill group, 189, 191
peripheral service, 255
peripheral skill group, 240, 242
route, 277
service array, 206

wrap-up time
enterprise skill group, 189, 191
peripheral skill group, 240, 242

—B—
Background report color, 103
Base skill groups, 26, 32, 79
Business entities, 80
Busy other state

number of agents in
enterprise service, 204, 217
enterprise skill group, 183
peripheral service, 269
peripheral skill group, 235

percent of agents in
enterprise skill group, 184
peripheral skill group, 235
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percent of time spent in
enterprise skill group, 187
peripheral skill group, 238

time spent in, 136
peripheral service, 256

Buttons (toolbar), 72

—C—
Call

activity, 22
detail records, 40
flow, 20
internal, 21
routing script, 22
transfers, 21

Call type, 31, 180
error count, 180
templates, 180, 181

Calling Line ID (CLID), 21
Calls

held
enterprise service, 204
peripheral service, 256

in progress
Galaxy-specific report, 231

in queue
enterprise service, 197, 202, 204,

256, 258
peripheral service, 249, 254, 256
route, 271, 276
service array, 206

talking
enterprise service, 197, 202
peripheral service, 249, 254
route, 271, 276
service array, 206

Calls in progress
peripheral report, 230

Calls routed, 180
caltyp01_status_grid, 180
caltyp02_count_graph, 181
Cascade option, 93
Category options, 77
Central Controller, 74
Central database, 40–41

and historical templates, 154
CICR, 23
CLID. See Calling Line ID
Command line, 75
Comma-separated values (.CSV) data

format, 102
Components

report, 88

Computer Telephony Integration
(CTI), 21

Controller time, 52, 74
Custom

report subdirectories, 87

—D—
Data

connections, 19
exporting from reports, 101
retrieving historical, 93

Data interchange (.DIF) data format,
102

Database
access via third party tools, 41
architecture, 41
central, 40
local, 40

Dates and times
defaults for reports, 80
specifying options, 80

dBASE-II (.DBF) data format, 102
Definition Editor, 99
Delay in queue

enterprise service, 196, 202, 208,
209

expected
enterprise service, 196
peripheral service, 248

peripheral service, 248, 254, 259,
261

route, 270, 276, 278, 280
service array, 206

Deleting reports, 100
Details (adding to reports), 110
DI Groups, 231
Directories (storing reports in), 86–88
Distributor AW, 39
Document Properties dialog box, 95
DrillDown Editor, 64, 110, 111, 112
Drill-downs, 110–16

adding, 111
applying, 112
in multiple-component reports, 113
invoking, 113
invoking multiple, 112
saving as reports, 115
saving assignments, 113
template hierarchy, 110
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—E—
Enterprise

peripheral services relationship, 25,
26

defined, 23
Enterprise CTI, 19, 21
Enterprise service templates, 196–215
Enterprise skill group templates,

160–95
entskg01_status_#_graph, 182
entskg02_status_grid, 183
entskg03_status_%_graph, 185
entskg04_status_grid_to5, 186
entskg05_utilization_graph, 188
entskg06_halfhour_aht_grid, 189
entskg07_daily_aht_grid, 191
entskg08_halfhour_perform_grid, 193
entskg09_normalized_agt_state, 195
entsvc01_queue_delay_status, 196
entsvc02_calls_status, 197
entsvc03_effect_of_aban_on_

servicelevel, 198
entsvc04_calls_trend_analysis, 199
entsvc05_calls_offered_half_pie, 200
entsvc06_serv_level_monitor_graph,

201
entsvc07_now_to5_grid, 202
entsvc08_gate_realtime_status_grid,

204
entsvc09_svc_array_now_to5_grid,

206
entsvc11_calls_analysis_daywise, 208
entsvc12_calls_analysis_half_hour,

209
entsvc13_calls_offered_daywise_

graph, 211
entsvc14_calls_handled_daywise_

graph, 212
entsvc15_calls_abandoned_daywise_

graph, 213
entsvc16_calls_history_daywise_

graph, 214
entsvc17_calls_offered_half_hour, 215
entsvc18_gate_half_hourly_status_

grid, 216
Ericsson ACP1000, 32

terminology, 34
Event Feed Warning dialog box, 105
Event Viewer

button, 72
Excel data format, 102
Expected delay in queue, 62

enterprise service, 196
peripheral service, 248

peripheral skill group, 247
Export

files, storing, 101
options, 101–2
report data, 101–2

Export Data option, 101

—F—
Files

.CMB, 86
association, 97
formats of, 102
renaming, 87
saving, 86

Frame Bar option, 73
Freezing real-time screens. See Pause

button
FTE. See Full-time equivalent
Full-time equivalent (FTE), 186, 193,

237, 244
available, 186, 193, 237, 244
busy other, 194, 238, 245
idle, 193, 237, 244
idle, 186
in wrap-up, 186, 237
logged on, 237
logged on, 186
number of agents, 190, 192, 240,

242
signed on, 193, 244
talking, 186, 193, 237, 244
wrap-up, 194, 244

—G—
Galaxy terminology, 34
Galaxy-specific data, 231, 232
Gate (Rockwell Galaxy), 34
Groups (Rockwell Galaxy)

primary, secondary, and tertiary, 34

—H—
Handle time, 136

average
enterprise service, 202, 208, 209
enterprise skill group, 189, 191
peripheral service, 254, 259, 261
peripheral skill group, 240, 242
route, 276, 278, 280
service array, 206

Handled calls
enterprise service, 198, 202, 205,

208, 209, 212, 214, 216
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enterprise skill group, 189, 191
peripheral service, 268
peripheral service, 250, 254, 256,

260, 262, 264, 266
peripheral skill group, 240, 242
route, 272, 276, 279, 281
service array, 206

Help
button, 72
contents of, 74
invoking, 73

Hierarchy
drill-down, 110
service and skill group, 24

Historical
data, 40–41
templates, 46

Historical Data Server (HDS), 40
Hourly boundaries

and data intervals, 83
Hunt group (Lucent DEFINITY ECS),

33

—I—
ICR

controller time, 74
databases, 40–41
documentation, 39
integration with networks, 19
Master Help, 74

ICR Print Server, 118
ICR-routed calls

enterprise service, 205, 216
peripheral service, 257, 268

Idle (Not Ready state)
count of agents in

enterprise skill group, 182, 183
peripheral skill group, 233, 234

percent of agents in
enterprise skill group, 184, 185,

187, 235
peripheral skill group, 236, 238

percent of time in
enterprise skill group, 195
peripheral skill group, 246

Idle trunks, 218, 285, 286, 287
InfoMaker, 42
Integration of call center and IXC, 19
Intelligent CallRouter

central controller, 39
overview of, 18–23

Internal calls, 21

—J—
Job Scheduler, 118–24

fields, 119
inspecting log files, 123
starting, 119

—K—
Keyboard shortcuts, 72

—L—
Landscape printing, 94

setting up for, 95
Last

Month time option, 82
Week time option, 82
Year time option, 82

Layer option, 93
Levels

of detail (drill-down), 64
threshold, 109

Limitations of ACDs, 35
Local database real-time templates,

154
Local time, 75
Log files (inspecting), 124
Logged on state

number of agents in, 230
time spent in, 136

Longest
call in queue

enterprise service, 196, 202
peripheral service, 248, 254
peripheral skill group, 247
route, 270, 276
service array, 206

Longest Available Agent
Rockwell Galaxy, 35

Lotus 1-2-3 (.WKS) data format, 102
Lucent DEFINITY ECS, 32

terminology, 33

—M—
Management data, 23
Master Help, 74
Master script, 180
Maximize button, 56
Microsoft

Excel, 41
Internet Explorer, 47
Visual Basic, 41

Modifying a report, 99
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Monitor ICR
main window, 71
overview, 41

Multiplan data format (.SLK)., 102
Multiple

component reports, 88
example, 89
printing, 96

print jobs
scheduling, 122

—N—
NEC NEAX 2400

terminology, 34
Netscape Navigator, 47
nettrk01_status_grid, 218
nettrk02_grid_last_half_hour, 219
nettrk12_grid_half_hour, 220
Network ICR, 23
Network trunk group, 28

templates, 219, 220
Network trunk groups

templates, 218
New button, 72
NICR, 23
Nortel DMS-100, SL-100, 32
Nortel Meridian, 32
Northern Telecom Meridian, 32

limitations, 35
terminology, 33

Not ready state
time spent in, 136

—O—
Offered calls

enterprise service, 198, 199, 200,
202, 204, 208, 209, 211, 214,
215, 216, 250, 256, 258

peripheral service, 251, 252, 254,
259, 261, 263, 266, 267, 268

route, 272, 273, 274, 276, 278, 280
service array, 206

On-line help
invoking, 73

Open button, 72, 96
Open Database Connectivity (ODBC),

41
Open databases, 41
Opening reports, 96
Out calls

enterprise skill group, 189, 191
peripheral skill group, 240, 242

—P—
Pause button, 72, 93
PBX. See Private Branch Exchange
peragt01_agent_status_by_position,

221
peragt02_agent_status_by_skillgroup,

222
peragt03_logout_status_by_agent, 223
peragt04_daily_agent_activity, 224
peragt05_agent_daily_perf, 226
peragt06_daily_agent_detail, 229
Percent

agents in busy other
enterprise skill group, 184
peripheral skill group, 235

agents in wrap-up
enterprise skill group, 184, 185
peripheral skill group, 235, 238

available agents
enterprise skill group, 184, 185
peripheral skill group, 235, 236,

238
available time

enterprise skill group, 195
peripheral skill group, 246

calls abandoned
peripheral service, 262
route, 281

calls handled
route, 281

calls offered
enterprise service, 200
peripheral service, 252, 262
route, 274

idle agents
enterprise skill group, 184, 185
peripheral skill group, 235, 236,

238
idle time

enterprise skill group, 195
peripheral skill group, 246

talking agents
enterprise skill group, 184, 185
peripheral skill group, 235, 236,

238
talking time

enterprise skill group, 195
peripheral skill group, 246

time spent in busy other
enterprise skill group, 187
peripheral skill group, 238

utilization
defined, 188
enterprise skill group, 188
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peripheral skill group, 239
wrap-up time

enterprise skill group, 195
peripheral skill group, 246

periph01_peripheral_status_report, 230
periph02_galaxy_software_status, 231
periph03_galaxy_hardware_status, 232
Peripheral

ACD specifics, 32–36
agents, 27
defined, 19, 24
mode, 230
on-line state, 230
status, 230
target, 30
terminology, 32

Peripheral service
templates, 248–67

Peripheral skill group, 25
templates, 231–46

perskg01_status_#_graph, 233
perskg02_status_grid, 234
perskg03_status_%_graph, 236
perskg04_status_grid_to5, 237
perskg05_utilization_graph, 239
perskg06_halfhour_aht_grid, 240
perskg07_daily_aht_grid, 242
perskg08_halfhour_perform_grid, 244
perskg09_normalized_agt_state, 246
perskg10_forecast_agents_status_grid,

247
persvc01_queue_delay_status, 248
persvc02_calls_status, 249
persvc03_effect_of_aband_on_

servicelevel, 250
persvc04_calls_trend_analysis, 251
persvc05_calls_offered_half_pie, 252
persvc06_serv_level_monitor_graph,

253
persvc07_now_to5_grid, 254
persvc08_gate_realtime_status_grid,

256, 258
persvc11_calls_analysis_daywise, 259
persvc12_calls_analysis_half_hour,

261
persvc13_calls_offered_daywise_

graph, 263
persvc14_calls_handled_daywise_

graph, 264
persvc15_calls_abandoned_daywise_

graph, 265
persvc16_calls_history_daywise_

graph, 266
persvc17_calls_offered_half_hour, 267

persvc18_gate_half_hourly_status_
grid, 268

Post-Routing, 21–22
Preferences dialog box, 102
Pre-Routing, 21
Primary Position Manned

enterprise service, 204, 217
peripheral service, 269

Print
button, 72
job

changing, 122
deleting, 123
details, 121
interpreting log files, 124
log file, 123
multiple, 121
scheduling, 118, 119
submitting, 122

orientation, 94
Print Server

for ICR, 118
Printer

changing settings, 94
setup, 94, 95

Printer setup, 119
Printing

reports, 94–96
automatically, 117

specifying dates and times, 121
specifying file names, 121

Printrpt command, 120, 121
PRINTRPT.LOG file, 120, 122

example, 124
Private Branch Exchange (PBX), 19
PSN. See Public Switched Network
Public Switched Network (PSN), 19

—R—
Ready state

count of agents in
enterprise skill group, 183
peripheral skill group, 234

Real-time data, 40
feed

and controller time, 74
failure setting, 103

templates
overview, 46

Real-time feed, 39
Refresh rate, 103
Relations field

in Threshold Editor, 109
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Relative
date option, 88
time, 81

advantages of, 82
options, 81

Report(s), 86–101
arranging on screen, 92
changing background color, 103
components of, 88, 89
data

saving for export, 101
definition, 47, 59

deleting, 100
file contents, 87
modifying, 99
saving, 86
saving changes to, 100

examples, 44, 50–51
generation of, 75–85
layout, 56
number of components, 89
overview, 46
presentation mode, 91
printing, 96
resizing components, 91
single vs. multiple-component, 51
title box, 91
updating with data, 93
working with, 86

several, 92
Resizing report components, 90
Resume button, 72, 94
Retrieve button, 59, 72
Retrieving historical data, 93
Rockwell

Galaxy ACD, 32
Spectrum ACD, 32

Rockwell Galaxy
gate status report, 204, 216, 256,

268
hardware status report, 232
limitations, 35
software status report, 231
terminology, 34

Rockwell Spectrum
terminology, 34

Routes, 29
and peripheral targets, 30
templates, 268–81

routes01_queue_delay_status, 270
routes02_calls_status, 271
routes03_effect_of_aban_on_

servicelevel, 272
routes04_calls_trend_analysis, 273
routes05_calls_offered_half_pie, 274

routes06_serv_level_monitor_graph,
275

routes07_now_to5_grid, 276
routes11_calls_analysis_daywise, 278
routes12_calls_analysis_half_hour,

280
Routing

client, 30
label, 20, 30

and Post-Routing, 21
request, 20, 21
scripts, 22, 41
server, 21

Routing client, 21, 31
templates, 282

rtecli11_status_by_five_minutes, 282

—S—
Save

Settings
now option, 98
on exit option, 99

Workspace on Exit, 98
button, 72

Save Rows As dialog box, 101
Saving

drill-down reports, 115
reports, 86

Schedule Link, 31
Scheduled jobs

changing, 122
deleting, 123

Scheduling
print jobs, 118–22, 119

schimp01_name_time_numbers, 283
Scope options (for reports), 78
Screen refresh

enabling, 94
pausing, 93

Secondary routing decisions, 21
Select Report dialog box, 96
Service, 24

peripheral terminology, 33, 34
Service level

enterprise service, 199, 201, 203,
208, 209

peripheral service, 251, 253, 255,
257, 259, 261

route, 273, 275, 277, 278, 280
service array, 207
with abandoned calls

enterprise service, 198
peripheral service, 250
route, 272
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without abandoned calls
enterprise service, 198
peripheral service, 250
route, 272

Service Level
enterprise service, 205, 216
peripheral service, 268

Service_Half_Hour table, 50
Service_Real_Time table, 50
Setting thresholds, 107–10
Show Text option, 72
Shuffle Mode, 90
Siemens 9751 ACD, 32
Siemens Hicom 300E, 32

terminology, 34
Siemens Rolm 9751 CBX

terminology, 34
Signaling network, 19
Signed on agents

enterprise skill group, 183
peripheral skill group, 234

Single-component reports, 88
example, 88

Skill group, 24
DEFINITY ECS, 33
peripheral terminology, 33, 34

Spectrum terminology, 34
Speed of answer

average
peripheral service, 248, 254, 259,

261
route, 270, 276, 278, 280

SQL, 41
syntax data format, 102

Staffing schedule data, 31
Status bar, 59

in report windows, 93
Subdirectories

and report storage, 87
Supervisor, 41
SWT TRMS, 231
System configuration, 37
System Manager, 41

—T—
Talk time, 136

average
enterprise service, 202
enterprise skill group, 189, 191
peripheral service, 255
peripheral skill group, 240, 242
route, 277
service array, 206

Talking
count of agents

enterprise skill group, 182
peripheral skill group, 233

percent of agents
enterprise skill group, 184, 185,

187
peripheral skill group, 235, 236,

238
percent of time

enterprise skill group, 195
peripheral skill group, 246

Talking in state
count of agents in

enterprise service, 204
enterprise skill group, 183
peripheral service, 256
peripheral skill group, 234

Talking other state
count of agents in

enterprise skill group, 183
peripheral skill group, 234

Talking out state
count of agents in

enterprise service, 204
enterprise skill group, 183
peripheral service, 256
peripheral skill group, 234

Template Launcher, 53, 75–85
invoking, 76
setting up, 85
window, 76

Templates, 46
application gateway, 155, 156, 157,

158, 160, 163, 164, 165, 166,
168, 171, 172, 173, 174, 176,
179, 221, 222, 223, 224, 225,
227

call type, 180, 181
choosing, 84
enterprise

service, 196–215
skill group, 160–95

historical, 154
naming conventions, 85
network trunk group, 218, 219, 220
peripheral

service, 247–67
skill group, 216–46

real-time, 154
relationships with database, 90
route, 268–81
routing client, 282
selecting multiple, 84
trunk group, 282–87
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using multiple, 84
Terminology

Monitor ICR, 46
peripheral-specific, 32

This
Month time option, 82
Week time option, 82
Year time option, 82

Threshold Editor, 108
Threshold(s)

alerts, 61, 108, 109
and service level, 109
examples of, 61–64
in multiple-component reports, 109
saving, 110
setting

examples, 63
in reports, 108

warning examples, 63
Tile option, 92
Time

format in Monitor ICR, 81
options in Template Launcher, 81

Today time option, 81
Toolbar, 71–73, 72

display options, 73
trkgrp01_alltrunkbusy_graph, 284
trkgrp02_idle_inservice_status, 285
trkgrp03_trunkgroup_status_grid, 286
trkgrp11_trunkgroup_performance_

grid, 287
Trunk group, 27

network, 27
templates, 282–88

Trunks
idle, 285–87, 285–87
in service, 285–87, 285–87
peripheral terminology, 33, 34

Tutorial
creating reports, 49

—U—
UpdateAW process, 40
User Information

dialog box, 105

—V—
VDN. See Vector Directory Number
Vector Directory Number (VDN), 33
Voice path (maintaining), 21
Voice Response Unit (VRU), 19
VRU. See Voice Response Unit
VRU support, 32

—W—
Warnings (threshold), 109
Web View, 47
Window menu, 92
Windows NT, 37
Work not ready state

time spent in, 136
Work ready state

time spent in, 136
Workforce management systems, 31
Workspace, 98
Wrap-up state

count of agents in
enterprise service, 204, 217
enterprise skill group, 182, 183,

185
peripheral service, 256, 269
peripheral skill group, 233, 234

percent of agents in
enterprise skill group, 184, 187
peripheral skill group, 235, 236,

238
time agents spend in

enterprise skill group, 189, 191,
195

peripheral skill group, 240, 242,
246

—Y—
Yesterday time option, 82
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